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Welcome
TekScope Anywhere™ brings the power of the oscilloscope analysis environment
to the PC. Your workflow becomes more flexible because you can now perform
complex analysis tasks including timing, eye, and jitter analysis outside of the
lab. Waveform data and setups from Tektronix DPO/MSO5000B, DPO7000C, or
DPO/ MSO70000C/D/DX/SX Series oscilloscopes and waveform data from
DPO/MSO/MDO3000 and DPO/MSO/MDO4000 Series oscilloscopes can
quickly be shared among team members and remote sites, resulting in improved
efficiency.
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About TekScope Anywhere

Product description
TekScope Anywhere™ brings the power of the oscilloscope analysis environment
to the PC. Your workflow becomes more flexible because you can now perform
complex analysis tasks including timing, eye, and jitter analysis outside of the
lab. Waveform data and setups from Tektronix DPO/MSO5000B, DPO7000C, or
DPO/ MSO70000C/D/DX/SX Series oscilloscopes and waveform data from
DPO/MSO/MDO3000 and DPO/MSO/MDO4000 Series oscilloscopes can
quickly be shared among team members and remote sites, resulting in improved
efficiency.

Key features

■ Collaborate

■ TekScope Anywhere™ runs on your PC - Better time and resource
utilization; view, measure, and analyze data captured in your lab,
independent of the oscilloscope hardware

■ Composite save/recall format - More accurate and repeatable results with
composite save/recall files with both instrument setup and waveform data
from your Tektronix DPO/MSO5000,DPO7000C, or DPO/MSO70000C/
D/DX/SX series oscilloscope

■ Compatible with most common save/recall waveform files - Common
analysis tools independent of the hardware acquisition, including;
Tektronix, LeCroy, or Keysight oscilloscope formats
(.wfm, .isf, .csv, .h5, .tr0, .trc, and .bin)

■ Analyze

■ 50+ Parametric and cursors measurements - TekScope Anywhere test
results correlate with Tektronix oscilloscope

■ Jitter decomposition (option DJA required) - Conduct jitter analysis on
your PC while traveling, in the lab, or at your customer's site, and get
results that correlate with DPOJET

■ Plots with zoom support - Interactive plots with zoom functionality
enables isolation of DUT behavior spectral content and jitter

■ Plots with cursor support - Measure DUT performance including eye
height and eye width using cursors

■ Arbitrary filter support - De-embed and embed cables, fixtures, or
channel models using filters created with SDLA visualizer (SDLA
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visualizer is available as Option SDLA64 on all 64 bit DPO/MSO70000
Series Oscilloscopes).

■ Document

■ Waveform annotations - Share detailed analysis results, measurements,
anomalies and points of interest for future reference, collaboration with
suppliers, or communicating with team members

■ Reports - Easily document measurement results and configuration details
with a detailed test report

■ Custom display configuration - Group plots in multiple configurations
with stacked or overlaid waveform view

Applications

■ Compliance and characterization - Parametric measurements and jitter
analysis for high speed serial interfaces

■ Debug - Share waveforms, measurements, and configuration details among
distributed team members or suppliers to root cause the source of failures

■ Simulation - Quickly compare the results of lab measurements and
simulations using common measurements and data visualization views

Product software

About From the Help menu, click About to view application details such as the Host
ID, Firmware version, copyright and licensing information.
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TekScope Anywhere
options

TekScope Anywhere can be downloaded from www.tektronix.com, and the
features of the application are enabled by purchasing different licensing options.
The following table lists the options offered on TekScope Anywhere.

Table 1: Software license types

License type Description
Node Locked item (NL) This license is permanently assigned to a specific Hostid or

product model/serial number.
Floating License item (FL) This license can be moved between different Hostid or product

model/serial number.
Free Trial item (FT) This has the same functionality as the floating license except that

it is time limited to 14 days.

Table 2: Tekscope Anywhere Waveform analysis licensing options

Product Description
TekScopeNL-BAS TekScope Anywhere Waveform Analysis and Visualization Node

Locked License.
TekScopeFL-BAS TekScope Anywhere Waveform Analysis and Visualization

Floating License.
TekScopeFT-BAS TekScope Anywhere Waveform Analysis and Visualization Free

Trial License.

Table 3: Tekscope Anywhere Jitter analysis licensing options

Product Description
TekScopeNL-DJA DPOJET Advanced Jitter Analysis for TekScope Anywhere Node

Locked License.
DPOFL-DJA DPOJET Jitter and Eye Analysis floating license for use with

TekScope Anywhere or DPO/DSA/MSO70000C/D/DX,
DPO7000C, or DPO/MSO5000 Oscilloscopes.

DPOFT-DJA DPOJET Jitter and Eye Analysis free trial license for use with
TekScope Anywhere or DPO/DSA/MSO70000C/D/DX,
DPO7000C, or DPO/MSO5000 Oscilloscopes.

 About TekScope Anywhere
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How to purchase options (license)
Contact your local Tektronix Account Manager to purchase TekScope Anywhere
and options. After purchasing options, you will receive an email listing the
options purchased with the URL to the Tektronix Asset Management system that
will enable you to manage your licenses.

Tektronix Asset Management System (TekAMS)

You can manage your licenses using the Tektronix Asset Management System
found at http://www.tek.com/products/product-license.

The Tektronix Asset Management system provides an inventory of the license(s)
in your account. It enables you Check-out or Check-in a license and view the
history of licenses.

How to Install options (license)
To install the TekScope Anywhere option or options purchased from Tektronix,
click Help > Install Options to display the license manager.
 

 

Click the Install License button and browse to the location where the license file
is located. Select the license file and click open.
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After the successful installation is finished, the option is listed in the table.
Selecting an option from the table shows the details of the license such as license
type, checkout time, installation time, expiration time and time remaining.

 

 

Clicking the OK button will prompt for an application restart. After restarting the
TekScope Anywhere application, the option you purchased is enabled.

 About TekScope Anywhere
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View installed options

From the Help menu, click Install Options to view the options installed.
Selecting an option from the table shows the details of the license such as license
type, checkout time, installation time, expiration time and time remaining.
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How to move an option to a different host
You can return the license purchased and assign it to a different host.

Node locked license: Can be returned two times and assigned to a different host.

Floating license: Can be returned unlimited number of times and assigned to a
different host.

Free trials: Has the same capability as floating license, but expires after 14 days.

When assigning a floating license, you need to specify the host id or instrument
and the duration the feature is to be enabled on the host. After the license expires,
the feature is automatically disabled on host and the license on the TekAMS is
free to be assigned to a different host.

 About TekScope Anywhere
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In order to move the license to a different host, follow these steps:

1. Click Help > Install Options. Select the license to return and click Return
License.
 

 

2. Browse to the location where you would like to place the exit file (for
example, a network drive or a USB memory stick), and click Create Exit Key
to generate the exit file.
 

 

3. Login to your account on TekAMS (Tektronix Asset Management system)
and upload the exit file. Once the license is returned successfully, it can be
re-assigned to a different host or instrument.
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Compatibility

Measurement differences
between TekScope

Anywhere and
Oscilloscope

This section provides details about differences in measurement results or
behavior between the TekScope Anywhere application and prior oscilloscope
measurement systems. 

1. Populations per waveform for Cycle-based measurements Cycle Min and
Cycle Max may be lower by one or two in TekScope Anywhere.

■ DPOJET treats each half-cycle separately.

■ TekScope Anywhere makes a measurement only on each full cycle and
will ignore incomplete cycles at the start or end of a waveform.

2. Population per waveform for Cycle Pk-Pk will be half that of DPOJET
(possibly minus 1 or 2 due to boundary conditions).

■ DPOJET advances on a half-cycle after each measurement. So if positive
and negative half cycles are labeled {P1, N1, P2, N2, P3...}, DPOJET for
example would measure pk-pk across {P1, N1}, then across {N1, P2},
then {P2, N2}, then {N2, P3}, and so on.

■ TekScope Anywhere only makes one measurement per cycle, so {P1,
N1}, then {P2, N2}, and so on.

3. The High and Low measurements from DPOJET are named BitHigh and
BitLow in TekScope Anywhere. High-Low is named BitAmplitude for
consistency.

4. The CCPeriod measurement in TekScope Anywhere returns a different
measurement time value for each result than DPOJET's CCPeriod does.

■ This is to make the convention common with all the other CC
measurements in TekScope Anywhere.

5. In DPOJET, the Median and Fixed variants of Constant Clock Recovery
perform an internal classification of Clock versus Data. TekScope Anywhere
uses a single unified method everywhere.

6. The J2 and J9 measurements in DPOJET use a slight approximation of the
desired target BER level of 2.5e-3, whereas TekScope Anywhere uses the
exact value. This leads to a slight result variation.

7. Precision for gating measurements by time has been improved. Due to the
increase in precision, the waveform points selected as being inside the range
may now be different from other products, causing gated measurements to
return a more precise result than they did previously.

8. The reference level algorithms have been improved for consistency. In
DPOJET, different algorithms were used depending on the particular data
type behind the waveform. Now all waveforms use the same algorithm
regardless of data type. Consequently, some variance in calculated reference
levels may be seen compared to results returned by DPOJET and TekScope.
The differences are due primarily to an improvement in how the Automatic
method works. In TekScope, the MinMax method may have been chosen by

 About TekScope Anywhere
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the Automatic method while now it will choose Histogram Mode. Check the
method readout to be sure you get the expected ref level method or manually
select the specific method you would like to use.

9. The reference level algorithms between DPOJET and the base TekScope
have been unified in one place. Each product used different names for the
same algorithm, so new names were selected:

TekScope Anywhere TekScope Name DPOJET Name
Absolute Absolute Absolute
Automatic Automatic Auto
Min-Max Min-Max Min-Max
Histogram Mode Histogram Mode Low-High (Full Wfm)
Histogram Mean Histogram Mean N/A
Histogram Eye Center N/A Low-High (Eye Center)

10. Histograms in DPOJET used a left-edge-of-bin convention when identifying
bin positions, but for convergence with scope base measurements this has
been changed to a center-of-bin convention. This may lead to small results
differences for measurements that use histograms internally.

11. Measurement metadata readouts for reference levels, bit rate, pattern length,
RjDj and other items will have been accurate at the time they were calculated
but may not match the current settings until they are refreshed. To get the
most recent results, go to the measurement result table and confirm the
measurement updated. Then go back to the portion of the UI with the readout
to get the latest value. If that particular item is not in use by any
measurement, the readout will not be calculated. For example, if no
measurements are using reference levels, the readout will just say "TBD".

12. For all type II PLLs (including Standard BW, Custom BW and Explicit-
Clock PLL), DPOJET has a defect that was preventing the velocity variable
inside the PLL loop from dynamically updating. This has been fixed in
TekScope Anywhere.

13. Results for measurements using Explicit Clock Edges and Explicit PLL clock
recovery types will vary compared to DPOJET due to several improvements
to the algorithm.

14. Clock recovery is only run when a specific measurement configuration
requires it to avoid extra calculation overhead. Because of this, display units
have become a requested setting. If clock recovery was run as part of a
measurement calculation, the result will be displayed using the Unit Interval
if requested. If clock recovery was not run, the measurement until will remain
the normal display unit (typically seconds) as if Unit Interval had not been
requested.

15. Units will not be shown across any of the panels when the Loop Bandwidth
is narrow because the width is insufficient to get enough points for the
measurement. Increasing the width of the filter will propagate units
everywhere.

About TekScope Anywhere  
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Plots

Histogram plot horizontal axis scaling is wrong in some cases, typically when a
measurement result has an extremely small standard deviation. In this case, the
plot will have a few vertical bars in the center, with mostly blank space on either
side.

Save and recall

1. tr0 format - Only Synopsys and LyncxSpice formats are supported.

2. Add on plugins are required to view the MHT format of the report on Mozilla
Firefox and Google Chrome.

Session recall limitations
from Oscilloscope to
TekScope Anywhere

You can share data acquired on an oscilloscope for offline analysis with
TekScope Anywhere. There are features available on an oscilloscope that are not
supported by TekScope Anywhere. The following list provides details about the
behavior of TekScope Anywhere, when recalling a session file saved on a DPO/
DSA/MSO oscilloscope.

■ Digital Sources, Bus, Masks and Limit setting features are not supported by
TekScope Anywhere. If the session file has these features, they are ignored.

■ Hbar and Vbar cursors are not available for analysis on TekScope Anywhere.
If the session file has Hbar and Vbar cursors, they are mapped to Screen
cursors.

■ TekScope Anywhere does not support multiple zooms. If the session file has
multiple zooms, only the Zoom1 settings are recalled on TekScope
Anywhere.

■ Waveforms are recalled at zero position on TekScope Anywhere regardless
of the vertical position set on the oscilloscope.

■ Eye diagram autoscale settings are ignored on TekScope Anywhere.

General notes ■ Should the application crash on start up, removing this file may resolve the
issue:

C:\Users\<username>\AppData\Local\Tektronix\TekScope Anywhere
\PowerUpSettings.ini

■ Microsoft Remote Desktop does not support the graphics used by this
software. Alternatives like TightVNC and Team Viewer are known to work.

■ Multiple instances of TekScope Anywhere running on the same PC are not
currently supported.

■ Should the application crash when there are multiple views and if it is due to
display drivers, we recommend you to update the display driver with the
latest version provided by your PC vendor.

■ Saving an opened PDF report when append is checked shows a pop-up
prompting you to close the report. Click Save again after clicking OK.

 About TekScope Anywhere
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■ The performance of the application may be slow in a PC with lower hardware
configuration. Reduce the number of measurements or use waveform files
with lower record lengths for improved application performance.

■ The File Open dialog can be slow and unresponsive when accessing Network
Attached Storage (NAS). Map the path to a local drive and access the files.

Minimum system configuration

System requirements Intel® Pentium®4 or AMD Athlon®64 processor (2 GHz or faster)

Windows 7 SP1, Windows 8, or Windows 8.1 

4 GB of RAM, 8 GB recommended

5 GB of available hard disk space, 10 GB recommended (exact space is
dependent on the number of waveforms and their size)

1366x768 display (1920x1080 recommended)

OpenGL®2.0, 32-bit color, and 1 GB of VRAM

Internet Explorer 11 and above is recommended for viewing reports in mht
format

Adobe Reader X and above is recommended for viewing pdf files

Minimum System
Requirements for

Windows 8.1

Physical Address Extension (PAE), NX processor bit (NX), and Streaming SIMD
Extensions 2 (SSE2)

PAE gives 32-bit processors the ability to use more than 4 GB of physical
memory on capable versions of Windows, and is a prerequisite for NX.

NX helps your processor guard the PC from attacks by malicious software.

SSE2 is a standard instruction set on processors that is increasingly used by third-
party apps and drivers.

About TekScope Anywhere  
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How to Install/Uninstall Tekscope Anywhere

Install Tekscope
Anywhere

Download the Tekscope Anywhere installer from www.tektronix.com. Then,
double-click the .exe file, and follow the instructions on your screen. 
 

 

TIP. After installation, the TekScope Anywhere shortcut will be placed on the
desktop and in the Start Menu.

TIP. Sample waveforms, filter files, and pattern files are located at: C:\Users
\Public\Tektronix\TekScope Anywhere\UserData

 About TekScope Anywhere
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Uninstall Tekscope
Anywhere 1. Click on the Start button to open your Start menu.

2. When the Start menu opens click All Programs > Tektronix > TekScope
Anywhere > Uninstall TekScope Anywhere.
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3. Select Yes from the confirm box to uninstall the TekScope Anywhere
application.
 

 
 

 

 About TekScope Anywhere
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Technical support
Tektronix welcomes your comments about products and services. Contact
Tektronix through mail, telephone, or the Web site. See Contacting Tektronix for
more information.

Tektronix also welcomes your feedback. See Customer feedback for suggestions
for providing feedback to Tektronix.

Customer feedback
Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or other comments regarding the
application or oscilloscope.

Direct your feedback via email to

techsupport@tektronix.com

Or FAX at (503) 627-5695, and include the following information:

■ Description of the problem such that technical support can duplicate it.

■ If possible, save the oscilloscope and application setup files as .set or
TekScope Anywhere as a .tss.

The following items are important, but optional:

■ Your name

■ Your company

■ Software version number
■ Your mailing address

■ Your phone number

■ Your FAX number

When contacting technical support through email, please use "TekScope
Anywhere Problem" in the subject field and attach the .set and .wfm files to your
email. If there is any query related to the actual measurement results, then you
can generate a .mht report and send it. For information about how to save a
screen shot of the TekScope Anywhere application, Click here.

In the body of the mail include your suggestion or a description of the issue.
Please be as specific as possible.

Please indicate whether you would like to be contacted by Tektronix regarding
your suggestion or comments.
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Conventions
TekScope Anywhere Help uses the following conventions:

■ When steps require sequence of selections using the application interface, the
“>” delimiter marks each transition between a menu and an option. For
example, Measurement > Measurement Library.

■ The terms “TekScope Anywhere application” and “application” refer to
TekScope Anywhere. 

■ The term “select” is a generic term that applies to the methods of choosing an
option: with a mouse or with the touch screen.

You can also find the PDF of the Help at Start >All Programs >Tektronix >
TekScope Anywhere.

Related documentation
You can also find the TekScope Anywhere help document in PDF format
available at: www.tektronix.com/manuals and www.tektronix.com/software. 

 About TekScope Anywhere
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Getting started with TekScope Anywhere
This section shows you how to do the following tasks: 

1. Opening waveform, setup, session files and defining Math

2. Viewing a opened waveform, zoom view a waveform and position the 
cursors on a waveform

3. Selecting and configuring a measurement, viewing the statistical results

4. Creating two dimensional plots for a measurement, zoom view a plot and
position the cursors on a plot

Waveform files
The application provides the following sample waveforms:

■ 8GPRBS7_70mV_10M_Ch1.wfm

■ 8GPRBS7_70mV_10M_Ch3.wfm

■ 8GPRBS7_70mV_10M_SSC_Ch1.wfm

■ 8GPRBS7_70mV_10M_SSC_Ch3.wfm

■ 8GPRBS7_70mV_500K_Ch1.wfm

■ 8GPRBS7_70mV_500K_Ch3.wfm

■ 8GPRBS7_70mV_500K_SSC_Ch1.wfm

■ 8GPRBS7_70mV_500K_SSC_Ch3.wfm

The waveform files are found at C:\Users\Public\Tektronix\TekScope Anywhere
\UserData.

See also Opening files
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Opening files
This section describes the steps to open a reference waveform, setup or session
file.

Opening a reference
waveform

The waveform files acquired on an oscilloscope can be opened in the TekScope
Anywhere as reference waveform for offline analysis. This section describes how
to open a waveform file as a reference source in the TekScope Anywhere. 

To Open a reference waveform, perform these steps:

1. Click the Open button, which can be found in Main/File tab.

2. Select the type of file as Waveform in the left pane of the Open dialog box,
navigate to the location of the tutorial waveforms.

3. Select the File Type from the files of type list.

4. Select the Destination as

■ New Ref (If the waveform is to be opened as new reference waveform).
The drop-down has an option to use Ch1-4 in order to make it look like
the colors that are used in an oscilloscope.

■ Ref <no> (If the waveform is to be opened by replacing an opened
reference waveform).

5. Select the waveform file and click Open. A Reference badge (Ref <no>) is
added in the GSRB field for the new reference waveform. (See Global
Settings Readout Bar (GSRB) on page 58.)

TIP. Select multiple waveform files and click Open to open all waveforms in
sequential order.

A Reference badge (Ref <no>) is added in the GSRB field for the new reference
waveform and the waveform is opened in the application.

See also. Ref badge context menu

Opening a setup

Opening a session

Global Settings Readout Bar (GSRB) on page 58
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Opening a setup The Setup file includes all instrument settings and user configured analysis
enabling you to recreate the current setup on another compatible instrument with
newly acquired data. This section describes how to open a setup file in the
TekScope Anywhere. 

To Open a setup file, perform these steps:

1. Click the Open button, which can be found in the Main/File tab.

2. Select the type of file as Setup in the left pane of the Open dialog box,
navigate to the desired directory.

3. Select the File Type from the files of type scroll down list.

4. Select the setup file and click Open.

See also. Save the setup

Opening a session

Opening a reference waveform

Opening a session The session file contains all necessary data to restore the instrument state,
including the last acquired data. This section describes how to open a session file
in the TekScope Anywhere application. 

To Open a session, perform these steps:

1. Click the Open button, which can be found in the Main/File tab.

2. Select the type of file as Session in the left pane of the Open dialog box,
navigate to the desired directory.

3. Select the File Type from the files of type scroll down list.

4. Select the session file and click Open.

See also. Save a session

Export session from oscilloscope

Opening a setup

Opening a reference waveform

Session recall limitations from Oscilloscope to TekScope Anywhere
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Defining Math
Math waveforms are the vectors that are obtained by performing mathematical
operations between any two waveforms or on a single waveform. This section
shows you how to define a Math function (the See also links below show you
how to configure different types of Math functions). 

To define a Math, perform these steps:

1. Click the Add Math button from the Main tab. A new Math badge is added in
the GSRB field. If two sources exist prior to selecting the Add Math button, a
default Math waveform (Source 1 - Source 2) is created.

2. The associated Math settings context menu is also displayed, allowing you to
configure the Math.

See also Math settings

Basic Math

Advanced Math

FFT Math

Viewing waveforms
The Time Domain view displays all time domain waveforms (waveforms
showing the change in a signal over time). Each waveform has a waveform
handle that can be used to move the waveform vertically.

Right-clicking the handle also provides easy access for configuring the
waveform.

Figure 1: Time Domain View
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Table 4: Title bar icons – Time Domain view

Icon Description
Waveform cursors on/
off

When turned on, cursors are displayed on the
screen. You can set cursor positions and take
measurements using cursors.Screen Cursors on/off

Zoom Drag Mode When selected, you can drag the zoom box on
waveform to a different area of the waveform. In
the normal (Time Domain) view, this is a macro-
level movement. You can also move the
waveform by clicking on the zoom plot and
dragging left or right. This is a micro-level
movement.

Zoom Dragbox Mode When turned on, you can perform vertical zoom
on the waveform. Left click and drag in the Time
Domain or zoom view to mark the region on the
waveform to zoom.

Zoom Horizontal
Dragbox Mode

When turned on, you can perform horizontal
zoom on the waveform. Left click and drag to
mark the region on the waveform to zoom.

Stacked Mode On/Off Switch the display to Stacked or Overlay mode.

Window Options When clicked, the time domain view window
options context menu is displayed with the
following options:

■ Waveform Cursors
■ Screen Cursors
■ Zoom Drag Mode
■ Vertical Draw Box
■ Horizontal Draw Box
■ Stacked View

Minimize When clicked, minimizes the Time Domain View.
It can be maximized from Minimized containers
displayed at the top right of the application.

You can quickly access the time domain view settings by right-clicking on the
screen.
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Figure 2: Time domain view shortcuts

See also Opening files

Stacked/Overlay mode Overlay mode and stacked mode are the two modes to view the waveform. You
can toggle between the two modes based on the required analysis by using the
mode icon in the title bar of the Time Domain view. When the icon is
highlighted, Stacked mode is selected.

Figure 3: Mode icon - Showing Stacked selected

Getting started with TekScope Anywhere  

24  TekScope Anywhere™ Help



When the icon is not highlighted, Overlay mode is selected. Overlay mode draws
the displayed waveforms one on top of the other. The selected waveform is
drawn on top and is called the active waveform. 

Figure 4: Overlay mode

When looking at edge crossings between two data signals, overlay mode may be
preferred. As the number of waveforms grows, stacked mode is typically
preferred.

Stacked mode displays the displayed waveforms stacked above each other for
easy horizontal comparison.

Figure 5: Stacked mode
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Zoom view of the
waveform

You can zoom in to get a close-up view of the waveform. For example, in the
process of placing cursors on a waveform, zoom view can help you find the
precise waveform location to set cursors. 

When you select Main > Zoom view in TekScope Anywhere, the screen changes:
■ The upper part displays the normal view of the waveform with a zoom box

placed on it, indicating the zoomed region of the waveform.
■ The lower part displays the magnified area of the waveform.

Figure 6: Zoom view of waveform
When you turn zoom on with multiple time domain waveforms opened, the upper
part displays all waveforms. The selected waveform in drawn on top. Selecting a
source badge brings that waveform to the top. The lower part displays the
zoomed area of all the waveforms.
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Zoom box

The Zoom box specifies the area of the waveform zoomed. Drag the window to
zoom view the region of the waveform. You can also increase/decrease the height
and width of the Zoom box. Decreasing the window size increases the zoom of
the waveform. Decreasing the window size horizontally, increases the horizontal
zoom of the waveform and vertically increases the vertical zoom of the
waveform. You can perform horizontal zoom from 1x to 20 kx and vertical zoom
from 1x to 1 kx.

You can use  button to increase or decrease the zoom box area.

Zoom by draw-a-box. Your can zoom into an area of the waveform by selecting
one of the draw-a-box modes (Zoom Drawbox Mode or Zoom Horizontal
Drawbox Mode) and click-and-drag an area to zoom. The box drawn by selecting
Zoom Drawbox Mode performs vertical zoom of the waveform. Selecting Zoom
Horizontal Drawbox Mode performs Horizontal zoom of the waveform. The
zoom draw-a box icons are accessible from the title bar.

Figure 7: Zoom by draw-a-box

See also. Measurement units
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Placing cursors on a
waveform

Cursors are used to take amplitude and timing measurements between screen
locations (screen cursors) and locations on a waveform (waveform cursors).

Cursors in Time domain view

You can use cursors to read the coordinate where each cursor (line) touches the
waveform and also view the difference (Δ) between the two cursors. Use these
steps to use cursors in a window (for precise measurements, zoom the waveform
in on the area of interest):

1. Turn on the cursors using the icons on the Time Domain view title bar.

2. Select and drag cursor A to the desired part of the waveform. The cursor
readout changes to reflect the cursor position.

3. Move cursor B by dragging the readout.

4. Move the pair by dragging the delta readout.

TIP. You can quickly access cursors by right-clicking on the screen and selecting
cursors from the context menu.

 

 

When multiple time domain waveforms are opened, turning the cursor on places
the cursors on the selected waveform. Selecting a waveform badge moves cursors
to the selected waveform (the horizontal or vertical cursor position doesn't
change).
 

Getting started with TekScope Anywhere  

28  TekScope Anywhere™ Help



 

NOTE. Multiple sets of cursors is not supported in TekScope Anywhere.

See also. Cursor setup

Making measurements

Select a measurement To select a measurement, click Measurement > All Measurements >
Measurement Library.

In the Measurement Library, the Select panel contains measurements grouped by
categories using Amplitude, Time, Jitter and Eye tabs. Selecting a tab displays
the licensed measurements in that category. Clicking a measurement button
creates the measurement and adds it to both the measurement table and the
measurement results table. The active waveform is selected as the measurement
source.

Measurement table

 Getting started with TekScope Anywhere
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The measurement table is displayed at the right side of panel.

■ The table has three columns labeled Meas, Measurement and Source(s).

■ The Meas column displays the measurement identifier. Meas1, Meas2,
Measn will be the serial number for first, second and subsequent
measurements.

■ The Measurement column displays the measurement name. To change
the measurement name, double click the Measurement cell and enter a
new name. When a measurement name has been changed the hover text
will show the measurement type appended to the new name.

■ The Source(s) column displays the measurement source(s). To change
the Source, left click in the Source(s) cell of the applicable measurement
row.

■ Right-clicking on a measurement displays the menu list to Delete, Delete All,
Configure Measurement, Save Measurement Results and Measurement
Preferences.

■ Delete to delete the selected measurement.

■ Delete All to delete all measurements in the table.

■ Save Measurement Results to save the statistical results in CSV format.

■ Measurement Preferences opens the Preferences context menu.

NOTE. For convenience, the measurement table also appears in the Configure
and Plots panel.

 

 

See also. Jitter category measurements

Time category measurements

Amplitude category measurements

Eye category measurements
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Configure the
measurement

The Configure panel displays the available configurations for the measurement
that is currently selected in the measurement table. The number and type of
configuration tabs that are available depends on the selected measurement type.
The configuration options available for measurements are the following:

■ General
■ Global
■ Filters
■ Bit config
■ Clock recovery
■ Edges
■ RJDJ
■ Bit error rate (BER)
■ Spread spectrum clocking (SSC)

For information about configurations applicable for the measurements Click here.

Figure 8: Configure the measurement

View the results The Results panel displays the statistical results for all measurement in tabular
format. You can drag both rows and columns of the table to customize data
display. Right clicking on a row in the results table displays a context menu with
choices to:

■ Delete to delete the selected measurement.
■ Delete All to delete all measurements in the table.
■ Save Measurement Results to save the statistical results in CSV format.
■ Measurement Preferences opens the Preferences context menu.
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Table 5: Results table headers

Item Description
Meas Measurement number
Measurement Measurement name
Source(s) Measurement source
Mean Statistical mean value
Std Dev Statistical standard deviation value
Max Statistical maximum value
Min Statistical minimum value
p-p Statistical peak-to-peak value
Population Total number of measurement data points used for displaying the

statistics

The measurement update indicator (circle icon in the measurement column) is
displayed for a measurement when a result is updated after configuration change.
Hovering the pointer over the icon shows the last updated time.

NOTE. The numerical values displayed in the table are rounded-off decimal
values. In order to see the full calculated value, hover over the value.

See also. Viewing plots

Viewing plots
To display the Plots panel, select Measurement > All Measurements >
Measurement Library.

Plots are two dimensional displays of results, providing a deep level of
understanding of statistical displayed results. The Plots tab in the Measurement
library displays available plots for the measurement selected in the table.
Clicking a plot button selects the plot, adds it to the plots source table, and adds
the associated plot view to the display area. 

The Plots panel displays the measurement table, a plot table and a selection of
buttons for creating the types of plots available for the selected measurement.
Selecting a plot button creates a new plot based on the selected measurement
view and adds that plot to the plot table. To delete one or more plots, right click
anywhere on a row. A context menu appears, allowing you to delete the selected
plot or to delete all plots.
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Table 6: Plot type definitions

Item Description
Histogram Represents measurements sorted by value as a distribution of

measurement values versus the number of times the value occurred.
Time Trend Represents the measurement values versus the time location.
Spectrum Represents the frequency content computed using the FFT of the Time

Trend of the measurement data.
Bathtub Represents the Bit Error Rate versus the unit interval for measurements

that include RJ-DJ analysis.
Eye Diagram Represents data for the eye diagram based on the recovered clock as the

timing reference; used for mask testing.

The plot table is displayed at the right side of panel.

■ The table has four columns labeled Meas, Plot Type, Measurement, and
Source(s).

■ The Meas column is for the measurement serial number. Meas1, Meas2
will be the serial number for first and second measurement and so on.

■ The Plot Type column displays the plot name. To change the name of a
plot, Double-click in Plot Type and start typing.

■ The Measurement column displays the measurement name. To change
the measurement name, double click in the Measurement cell and simply
type in a new name.

■ The Source(s) column displays the measurement sources(s).

■ Right-clicking a plot in the Plots table displays a context menu:

■ Delete to delete the selected plot.

■ Delete All to delete all plots in the table.

 

 

You can quickly access the Plot display settings by right-clicking on the screen.
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Figure 9: Plots shortcuts

Plot window The plot view displays two dimensional plots for a measurement.

When you select a plot other than time trend, an associated plot is added to the
display area. In the image below, a Histogram plot has been added.
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When you select a Time trend plot for a measurement calculated in time, then the
plot is added to Time Domain view. The Trend badge (Time Trend) will be
added to the GSRB field.
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The plot view title bar has the following icons, allowing you to perform various
associated tasks:

Table 7: Title bar icons – Plot view

Icon Description
Waveform cursors on/
off

When turned on, the cursor lines are displayed
on the screen. You can set the cursor points and
take measurements. The cursors available for
the plot depends on plot type.

Screen Cursors on/off

Zoom Drag Mode When turned on, you can drag the zoom box on
waveform to a different part of the waveform. In
the normal (Time Domain) view, this is a macro-
level movement. In a Zoom window, you can
drag the waveform left and right, which is a
micro-level movement.

Zoom Dragbox Mode When turned on, you can perform vertical zoom
on the waveform. Left click and drag to mark the
region on the waveform to zoom.

Zoom Horizontal
Dragbox Mode

When turned on, you can perform horizontal
zoom on the waveform. Left click and drag to
mark the region on the waveform to zoom.

Plot Configuration
Options

Clicking this icon pops up the context menu
which allows plot configuration.

Window Options When clicked, the plot window options context
menu is displayed for the plot window. It has the
following window options to select and
configure:

■ Save Plot Image

■ Save Plot Data

■ Configure Plot

■ Screen Cursors
■ Waveform Cursors
■ Zoom Drag Mode
■ Vertical Draw Box
■ Horizontal Draw Box
■ Zoom Options

Display/Hide Zoom
Settings

When clicked, zoomed values are displayed.

Minimize When clicked, minimizes the Plot view. It can be
maximized from Minimized containers displayed
at the top right of the application.

Close Close the plot window.
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Zoom view of plots You can zoom in to get a close-up view of a plot. The Zoom feature is used to
examine data at various scales. When you select Main > Zoom view in the
TekScope Anywhere, the display will have two views, the main screen displays
the close-up view of the plot. The inner (smaller) screen displays the complete
plot graph and a blue marker indicating the area zoomed. You can drag the plot
area to analyze using drag mode. 

Zoom settings bar. When zoom is turned off, the settings bar displays the readout
marker values of plot X and Y. When zoom is turned on, the plot X and Y values
are displayed in the text box on the title bar. Clicking in the text box opens a UI
keypad to enter the zoom-in value.

You can perform X axis zoom from -1000Y to 1000Y and Y axis zoom from
-1000Z to 1000Z. Zoom settings bar for plots can be turned on/off from the plot
view title bar.

Figure 10: Zoom settings bar
Zoom by draw-a-box. You can initiate zoom by selecting one of the draw-a-box
modes (Zoom Drawbox Mode or Zoom Horizontal Drawbox Mode) and click-
and-drag to area within the Plot view to zoom. The box drawn by selecting Zoom
Drawbox Mode performs vertical zoom of the waveform and by selecting Zoom
Horizontal Drawbox Mode performs Horizontal zoom of the waveform. The
zoom draw-a box icons are accessible on the title bar.

Figure 11: Zoom by draw-a-box
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See also. Measurement units

Placing cursors on a plot Cursors allow you to view numerical values associated with a plot based on
cursor locations. There are two types of cursors:

■ Waveform cursors

■ Screen cursors

Cursors in plot view

You can use cursors to read the coordinate where each cursor (line) touches the
plot and also view the difference (Δ) between the two cursors. The steps to use
cursors in a plot details window are:

1. Turn on the cursor from the Plot view title bar.

2. Select and drag cursors to move it to the desired area of the plot. The cursor
readout changes to reflect the cursor position.

TIP. You can quickly access cursors by right-clicking the plot view and selecting
cursors from the context menu.

 

 

See also. Cursor setup
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Eye diagram Create an Eye diagram by clicking the Create Eye Diagram button in the Main
tab and selecting a source.

Use the following sample steps to create and configure a TIE measurement, Eye
diagram plot:

1. Click Main > Open.

2. Navigate to C:\Users\Public\Tektronix\TekScope Anywhere\UserData, select
these files and then click the Open button:

■ 8GPRBS7_70mV_500K_SSC_Ch1.wfm

■ 8GPRBS7_70mV_500K_SSC_Ch3.wfm

3. Click Main > Add Math. By default basic Math will be defined with the
equation Ref1 (8GPRBS7_70mV_500K_SSC_Ch1.wfm) - Ref2
(8GPRBS7_70mV_500K_SSC_Ch3.wfm).

4. Click Main > Create Eye Diagram. Select the Source Type as Waveforms
and select the Math1 waveform from the drop-down list.
 

 

5. Click Create Eye Diagram. By default the TIE measurement will be added
and an Eye Diagram plot will be displayed for the waveform.

6. Click Plot Configure Options from the title bar of the plot view.

a. Select Clock Recovery method as PLL - Custom BW and PLL Model as
Type II

b. Select Loop BW and set 10 MHz as bandwidth
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7. Eye Diagram plot is displayed.
 

 

TIP. Selecting the Source Type as Measurement allows you to add Eye Diagram
analysis for the selected measurement. The drop-down list displays the
measurements that support the Eye diagram plot.
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Operating basics

Overview of the application interface
After you have installed the necessary options, the TekScope Anywhere
application will launch the initial view with a default setup.

Figure 12: TekScope Anywhere (initial view)

The TekScope Anywhere application interface can be grouped into four major
areas that are used to analyze the waveform and document the results.

TekScope Anywhere™ Help 41



Figure 13: TekScope Anywhere

1. Tabbed control bar (TCB)

2. Display area (containing View windows)

3. Measurement library

4. Global settings readout bar (GSRB)

TekScope Anywhere works best when your monitor is set to TrueColor 32-bit
color depth. If the monitor is set to TrueColor 16 bit color depth, the images
might not appear correctly and the application may stop working. The available
colors depend on the monitor and the graphic card drivers installed on the PC.

If the application is displaying distorted colors, set the monitor Color Depth to
32 bit using these steps:
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1. Click Start > Control Panel. Click the Adjust screen resolution link in
Appearance and Personalization category.
 

 

2. If you have more than one monitor connected, select the monitor from the
Display drop-down list and click the Advanced Settings link.
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3. In the popup window select the Monitor tab and select True Color (32 bit)
from the Colors drop down list. The screen may blackout for few seconds
before your settings are applied. Confirm your actions to make the changes
permanent.
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Tabbed control bar
The tabbed control bar uses four tabs: Main, File, Measurement, and Help. You
can minimize or maximize the tabbed control bar by clicking a tab or by clicking
the button at the left side of the control bar.

Main tab The Main tab provides access to the most commonly used functions in the
application. 

  Open

The Open button displays the Open dialog box from which you can open
Waveform, Setup, or Session files. Select the type of file you want to open in the
left pane of the Open dialog box, navigate to the desired directory, and then select
and open the desired file(s).

Figure 14: Open dialog box – Waveform panel

  Save

Clicking the Save button allows you to save the TekScope Anywhere application
data such as a screen image, waveform, setup, report or a session.

Save: First click opens the Save As dialog box. Subsequent clicks on the Save
button saves the data based on the last saved configuration.

Save As: Displays the Save As dialog box for selecting and configuring the type
of data to save.
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Figure 15: Save context menu

  Add / Remove Waveforms

The Add/Remove Waveforms button displays a context menu that allows you to
add Reference or Math waveforms:

Waveforms On / Off: Toggle switch to turn on and off the display of the
waveforms that are opened in the application.

Create New Waveform: You can add Math and Ref waveforms using the Add
Math and Reference buttons respectively.

Figure 16: Add / Remove Waveforms context menu

  Add Math

This button allows you to create a Math configuration. Clicking this button
inserts a new Math badge in the GSRB field. If two sources exist prior to
selecting the button a default Math waveform (Source 1 - Source 2) is created.
The associated Math settings context menu is also launched to configure the
Math.

  Measure

Clicking this button displays a context menu giving you quick access to
frequently used measurements and the Measurement Library.
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Figure 17: Measure context menu

  Results View

Click this button to display the Results panel of the Measurement Library.

  Create Eye Diagram

Click the Create Eye Diagram button to create an eye diagram from any available
sources. Sources include the defined waveforms and the selected measurements
that have an Eye Diagram plot configuration.

  Zoom

The Zoom button toggles the zoom on and off in the selected view, whether that
view is the Time Domain view or a Plot view.

  Annotate

The Annotate button inserts a Screen text annotation object in the selected view.
The screen text feature allows you to annotate the graticule area. These notes are
placed at a specified x and y location within the selected view. An annotation can
be moved freely within the view in which it was created, but cannot be moved to
a different view window.

  Default Setup

This button resets the TekScope Anywhere application to the system defaults.
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File tab The File tab contains the controls for opening files, saving files, and a list of
recently accessed files. 

  Save

Click Save to save the TekScope Anywhere application data. The first time you
click the Save button, you will see the Save As dialog box. Subsequent clicks of
the Save button saves the data based on the last saved configuration.

  Save As

Click Save As to save the TekScope Anywhere application data as a named file.
Clicking this icon launches the Save As dialog box. Use this dialog box to define
the type of data file you're creating.

Figure 18: Save As dialog box

  Open

  Recent Files

This button allows you to open recently used Session, Setup files, or Waveform
files. Clicking the icon opens a context menu, where you can select and open
recently used session, setup, and waveform files from the drop down lists. The
drop down lists show recently used files of each type.
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Figure 19: Recent Files context menu

  Default Setup

This button resets the TekScope Anywhere application to the system defaults.

Measurement tab The Measurement Tab provides access to a large number of frequently used
measurements without having to browse through the Measurement Library. 

Frequently Used

 

 

Frequently Used icons provide quick access to frequently used measurements.
You can also select measurements By Category.

By Category

By Category organizes commonly used measurements by measurement
categories using Amplitude, Time, Jitter, and Eye buttons. Selecting one of these
buttons opens a context menu with the top six measurements for the associated
measurement type. The context menus also contain a More button that opens the
Measurement library to the tab containing all measurements in that category.

  Measurement Library

Click this button to open the Measurement Library to the Select tab.

  Results View
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Click this button to display the Results panel of the Measurement Library.

Help tab

  Help

Clicking this button launches the application help file.

  About

Click Help > About to view application details such as the release software
version number, application name, and copyright.

    Install Options

Options are installed using a license validation procedure required by the
TekScope Anywhere application to enable features such as measurements. When
you install the application, by default no features are available.

For details about TekScope Anywhere options Click here.

For steps to install options Click here.

Minimize views The Minimize button is available whenever one or more views have been
minimized. Clicking the button displays thumbnails with the name of minimized
items, and selecting the item maximizes the view. If a group is minimized, then it
is displayed as a group in the Minimize Tray and is restored as a group. 
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Figure 20: Minimized containers

Display area (View window)
The display area displays waveforms with a horizontal time scale in the time
domain view. Non time domain waveforms are displayed in individually named
plot views. When a plot is added, an associated plot view is added to the display
area.

You can arrange and group views.

Undock a view from the application for even more flexibility. TekScope
Anywhere supports multiple monitors. A view area can be dragged to a second
monitor or expanded across displays.

Figure 21: Time domain view
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Figure 22: Plot view

See also Window management - View window

Time domain view This view displays time domain waveforms. There are two display modes in this
view: 

■ Overlay mode draws the displayed waveforms in on top of each other.
Selecting a waveform badge causes that waveform to be drawn on top in the
Overlay mode.

■ Stacked mode shows the open waveforms stacked above each other for easy
horizontal comparison. You can toggle between the two modes based on the
required analysis.

When looking at edge crossings between two data signals, overlay mode may
be preferred. As the number of waveforms grows, stacked mode is typically
preferred.

Each waveform has a waveform handle, that can be used to move the waveform
vertically. Right-clicking the handle also provides easy access for configuring the
waveform.
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Figure 23: Time domain view – Stacked mode

Number Description
1 Window name – Time Domain View
2 Time Domain View options
3 Zoom on/off switch
4 Vertical scale
5 Horizontal scale
6 Waveform handle – Use to move the waveform vertically; right click to

access waveform settings
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Figure 24: Overlay mode

Plot view When a plot is created from a measurement, it is displayed in an appropriately
named plot view.

When you select a Time trend plot for any measurement that has a time domain
source, the plot is added to Time Domain View and a Trend badge (Time Trend)
is added to the GSRB field. If a Time Trend is used as a source in subsequent
operations the horizontal scale may be in units other than time. When the scale is
something other than time the Time Trend will be drawn in a new, appropriately
named plot view.
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Figure 25: Plot view

Number Description
1 Plot name
2 Plot view options
3 Zoom on/off botton
4 Vertical scale
5 Horizontal scale
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Measurement library overview
To view the measurement library, click Measurement > Measurement Library.
The measurement library has panels to select measurements, configure
measurements, view measurement results, and configure plots for measurements.

The title bar of the Measurement Library has an Options button on the upper-
right. The Option button opens a context menu where you can Save Results or
configure Measurement Preferences.
 

 

Select panel: This panel displays measurements grouped by categories using
Amplitude, Time, Jitter and Eye tabs. Selecting a tab displays the licensed
measurements in that category. Clicking the button for a given measurement
creates the measurement and adds it to both the measurement table and the
measurement results table.

For convenience, the measurement table also appears in the Configure and Plots
panel. Right clicking a row in the measurement table displays a context menu
with choices to:
■ Delete the selected measurement
■ Delete all the measurements
■ Save the measurements results
■ Configure the measurement preferences

When a measurement is created it is defined with default parameters using the
currently selected source. To change the source, left click in the Source(s) cell of
the applicable measurement row.

To change the measurement name, double click in the Measurement cell and
enter a new name. When a measurement name has been changed the hover text
will show the measurement type appended to the new name.

Figure 26:

See Index of all measurements on page 119
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Configure panel: This panel displays the available configuration parameters for
the measurement selected in the measurement table. The number and type of
configuration tabs that are available depends on the type of measurement you
have selected.

Figure 27:

See Measurement configuration on page 133

Results panel: This panel displays the statistical results for all measurements in a
tabular format. You can drag both rows and columns of the table to customize
data display. Right clicking a row in the results table raises a context menu with
choices to:

■ Delete the selected measurement

■ Delete all the measurements

■ Save the measurements results

■ Open the measurement preferences dialog

Figure 28:

See View statistical results on page 181

Plots panel: This panel displays the measurement table, a plot table and a
selection of buttons for creating the types of plots available for the selected
measurement. Selecting a plot button creates a new plot view based on the
selected measurement view and adds that plot to the plot table. To change the
name of a plot, double click in Plot Type and enter a custom name. To delete one
or more plots, right click anywhere on a row in the plot table.

Figure 29:

See Plot usage on page 185
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Global Settings Readout Bar (GSRB)
The GSRB, at the bottom of the TekScope Anywhere window, shows the
properties of individual waveforms, the application time stamp and the status of
the TekScope Anywhere application. 

The Global Settings Readout Bar (GSRB) has the following items:

■ Add/Remove Waveforms
■ Waveform badges
■ Status and Timestamp fields

Figure 30: Global Settings Readout Bar (GSRB)

Add / Remove waveforms The Add / Remove Waveforms button is used to create Reference (Ref), Math,
and Analog waveforms. Clicking the Add / Remove Waveforms button displays a
context menu.

Waveforms On/Off: Toggle switch to turn On or Off the display of the
waveforms that are opened in the application. A new switch is added to the menu
when a new waveform is created. In the following image, there are three Math
waveforms being displayed and one reference waveform. All the waveform
switches are on.

Create New Waveform: You can add Math and Ref waveforms using the Math
and Reference buttons respectively.

Figure 31: Add/Remove Waveforms context menu
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GSRB badges A GSRB waveform badge is a rectangular image displayed in the GSRB field.
The badge displays the applicable properties of an open waveform. Double
clicking a source badge selects the waveform and displays the configuration
context menu. Right-clicking a badge pops up a context menu for configuring or
deleting the associated waveform. A single click selects the associated waveform. 

Ref badge

When a new Reference waveform is opened, a Ref badge is added to the GSRB
field. The badge displays a default identifier (Ref <n>), sample rate, and File
name of the waveform.

Math badge

When a new Math operation is defined, a Math badge is added to the GSRB field.
The badge displays a default identifier (Math <n>), vertical scale, horizontal
scale and the definition of the math operation.

Trend badge

When a new Time trend plot is created, a Trend badge is added to the GSRB
field. The badge displays a default identifier (Trend <n>), vertical scale, the name
of the measurement being plotted and the source of the measurement.
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Status and Time stamp

The application Status and Time/Date fields are displayed in the GSRB.

TIP. Double-click on a source badge to select the waveform and open the
associated configuration context menu. Single-click on a badge to select the
waveform.

See also. Ref badge context menu

Math badge context menu

Trend (Time trend) badge context menu

Timestamp badge context menu

Windows management - View window
The display area always has one Time Domain View. While this view can be
minimized, it cannot be deleted. In addition each Plot View occupies a separate
window. Views have basic window management behavior. They can be
rearranged within the application, undocked, resized, etc. Views can be grouped
together for window management convenience.

Active and inactive views When multiple views are opened, the currently selected view is referred to as the
active view and all other views are inactive.

The appearance of the active view differentiates it from the other views. The
active view is outlined in white and the title text changes to white. The options
buttons such as zoom, view options and configuration appear in the title bar.

The title bar of the inactive view will show only options to minimize or close
view. The text is gray and so is the view outline. 
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Figure 32: Active and inactive windows

See also. Time Domain View

Plot View

Arrange views You can easily rearrange the views using the views title bar. To rearrange the
views, follow the steps: 
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1. Click and hold the title bar of the display screen (in the image below, Eye
Diagram - TIE(Ref2)) to move to a new position.
 

 

The frame of the Eye Diagram - TIE(Ref2) display is highlighted to clearly
identify the view that is being moved.
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2. As the moving view comes into significant areas (based on the mouse
location) a blue docking hint is displayed.
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3. Release the mouse when the blue docking hint correctly shows where you
want to move the Eye Diagram window to, and the view is docked at the new
position.
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Resize window. A view can be resized by selecting and dragging a border. To
select a border, hover the border until the cursor changes to the double arrow.
Click and hold while dragging horizontally when adjusting a vertical border or
vertically when adjusting a horizontal border.

1.  

 
2.  
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3.  

 
4.  
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5.  

 

See also. Time domain view

Plot view

Grouped views Multiple views can be placed into a group that essentially becomes a mini
workspace. For example, it could be used to group views based on your
measurement needs. The displays in a grouped view can be viewed in either
Tabbed mode or Grid mode. The default is tabbed mode.

1. To create a Group view, simply drag a view until the docking hint fills the
destination window.
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2. Release the moving view to the group. Each view in the group appears in its
own tab.
 

 

Follow the same steps to add additional windows to the group.

Grouped view title bar

The group view title bar has a default group identifier, Group <n>, the standard
view, title bar buttons as well as switch between Tabbed view and Grid view. If
the group is in Grid view, then the title bar for the active display shows options
for that window only, instead of the group options. Group view options are
shown in the Group title bar.

Table 8: Title bar options

Icon Description
Tabbed view Switch the display to tabbed view.

Grid view Switch the display to Grid view.

Waveform cursors on/
off

When turned on, the cursor lines are displayed
on the screen. You can set the cursor points and
take measurements. Both cursor icons may not
be available for every view.

Screen Cursors on/off

Zoom Drag Mode When clicked, you can drag the waveform in the
display screen.

Zoom Dragbox Mode When clicked, you can perform vertical zoom on
the waveform. Left click and drag to mark the
region on the waveform to zoom.
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Icon Description
Zoom Horizontal
Dragbox Mode

When clicked, you can perform horizontal zoom
on the waveform. Left click and drag to mark the
region on the waveform to zoom.

Display/Hide Zoom
Settings

When clicked, zoomed values are displayed.

Plot Configure Options When clicked, the context menu for plot
configuration gets opened. The configuration
options available in the plot configuration context
menu varies based on the type of plot.

Window Options When clicked, the window options context menu
is displayed. The context menu will have the
time domain view options or the plot view
options for the time domain view or the plot view
respectively in a Group view.

Minimize When clicked, minimizes the Group view. It can
be maximized from Minimized containers
displayed at the top right of the application.

Maximize The Maximize button will only be available if the
grouped view is undocked from the Display
Area.

Close Closes the view and removes the plot from the
plot table.

Tabbed view

Tabs are a way of setting up a group that uses tabs to switch between views. The
interaction also works in the inverse. The tabs can be reordered by dragging the
tabs. A view can be dragged onto another and tab them together.

Figure 33: Tabbed view
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Grid view

Selecting Grid view allows multiple views to be displayed in a single view but
they can all be seen at the same time in the container. They may be stacked
horizontally or vertically. By default the stack is vertical.

Figure 34: Grid view
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Arranging the windows in the grid view of a Group

1. Click and hold the title bar of the display screen to move to a new position.
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2. Drag the display screen inside the group to see the docking hint.
 

 

3. Release the display screen on the dock-hint to position the screen.
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Undocking/Docking
display screen

You can undock the active display to a secondary monitor. To undock a display,
follow the steps:

1. Click and hold the title bar of the display you want to move (in the following
images, the Eye Diagram - TIE(Ref2) window).
 

 

The frame of the display is highlighted to show that the view is being moved.
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2. Drag the window outside the application and release the mouse to undock it
from the TekScope Anywhere window.
 

 

You can dock the display screen back to the application using the following
steps:

1. Click and hold the title bar of the undocked view.
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2. As the undocked display moves onto the application area (based on the
mouse location), a blue docking hint is displayed.
 

 

3. Release the mouse and the view is docked at the new position that was
indicated by the blue docking hint.
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UI keypad
Double-click the input text box to use the virtual keypad to enter alphanumeric
values. 

Mouse scroll wheel
The mouse scroll wheel can be used to roll values, to select the items from the
list, or to navigate between panels or tabs.

■ When a numerical input box is selected, rolling the scroll wheel increases or
decreases the numerical value.

■ When a drop-down list is selected, rolling the scroll wheel navigates the list
to select.

■ When a panel or tab is selected, rolling the scroll wheel switches between the
open panels or tabs.
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GSRB badge context menu

Add / Remove waveforms
The Add / Remove Waveforms button is used to create Reference (Ref), Math,
and Analog waveforms. Clicking the Add / Remove Waveforms button displays a
context menu.

Waveforms On/Off: Toggle switch to turn On or Off the display of the
waveforms that are opened in the application. A new switch is added to the menu
when a new waveform is created. In the following image, there are three Math
waveforms being displayed and one reference waveform. All the waveform
switches are on.

Create New Waveform: You can add Math and Ref waveforms using the Math
and Reference buttons respectively.

Figure 35: Add/Remove Waveforms context menu
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Ref badge context menu
The waveform files acquired on an oscilloscope can be opened in TekScope
Anywhere as reference waveform for offline analysis. The Ref waveform badge
is displayed in the GSRB field. Double clicking a badge selects the waveform
and opens the configuration context menu. Right-clicking a badge displays a
context menu for configuring or deleting the associated waveform. 

If the reference waveform is a time domain waveform, the context menu has
these options.

Figure 36: Ref badge context menu - Time domain waveform

Table 9: Ref badge context menu - Time domain waveform

Item Description
Ref <no> On/Off toggle switch
Vertical Scale Text entry field to set vertical scale
Label Text entry field for the Ref waveform
Position Numeric entry field that only affects the display of data
Set to 0 Button to set the position to 0 for Ref waveform
Reference File Displays the path and filename of the waveform

Clicking the field displays the drop-down list of recently opened waveform
file names

Browse Clicking this opens the context menu to navigate to the directory, select
and open the waveform file

Sample Rate The sample rate of the waveform (display only)
Record Length The record length of the waveform (display only)
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Item Description
Deskew Text entry field to set the deskew
Set to 0 Button to set the deskew to 0 

If the Ref <no> is a non-time domain waveform source, the context menu allows
you to select the waveform file.

Figure 37: Ref badge context menu (not a time domain waveform)

See also Opening a reference waveform

Math settings
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Math badge context menu
Math waveforms are the vectors obtained by performing mathematical operations
between any two waveforms or on a single waveform. When the Add Math
button is clicked, the Math waveform badge is displayed in the GSRB field.
Double clicking a badge selects the waveform and opens the configuration
context menu. Right-clicking pops up a context menu for configuring or deleting
the associated waveform. 

If the Math vector is a time domain waveform, the context menu has the
following configuration options.

Figure 38: Math badge context menu - Time domain waveform

Table 10: Math badge context menu

Item Description
Math <No> On/Off toggle switch.
Vertical Scale Numeric input field for vertical scale parameters. The vertical scale can

be changed directly in the field or with the up and down buttons.
Label Text entry field used to place a label on the Math waveform.
Position Numeric input field used to change the vertical position of the waveform.
Set to 0 Button to set the waveform position to 0.
Math Type: Basic
Function The Drop-down list that displays the predefined math functions. The

default is Subtraction.
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Item Description
Source 1 Select the waveform to be used as source 1 from the drop-down list. The

list has all the available waveform sources except the math waveform
being configured.

Source 2 Select the waveform to be used as source 2 from the drop-down list. The
list has all the available waveform sources except the math waveform
being configured.

Math Type: Advanced
Clear Clears the expression from the Math<n> combo box.
Math <n> Combo box for entering a math expression. It also displays a drop down

list showing the last 20 math expressions.
Cancel Discards and closes the context menu.
Apply Parses the expression. If the expression is valid, the expression is

evaluated and the waveform is updated.
If the expression is invalid, then:

■ The incorrect expression remains in the expression box.
■ An error message is shown that indicates the location of the error

(line#:char#) and provides detail about the error when known.

OK Parses, evaluates, and closes the context menu. If the Math expression
is invalid, the math is not displayed.

Math Type: FFT
Source Select the source from the drop-down list. The list has all the waveform

sources except the current math.

If the resultant math waveform is not a Time domain waveform, then the Math
badge context menu does not have Vertical Scale and Position settings for
waveform.

See also Math settings - Advanced

Math settings - FFT
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Trend (Time trend) badge context menu
When you select Time Trend from the Plots panel of the Measurement Library,
the Trend badge is displayed in the GSRB field. Double clicking a badge selects
the plot and opens the configuration context menu. Right-clicking pops up a
context menu for configuring or deleting the plot. 

Figure 39: Trend (Time trend) badge context menu

Table 11: Trend (Time trend) badge context menu

Configuration Description
Trend <no> On/Off toggle switch
Vertical Scale Numeric input field to set vertical scale
Label Text entry field for the Time trend plot
Position Numeric entry field that only affects the display of data
Set to 0 Button to set the position to 0 for reference waveform
Save Plot Data Opens Save Plot Data context menu

NOTE. If the Time trend plot measurement includes a time component, then it will
be displayed in Time domain view.
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Date and Time Settings context menu
Double-clicking the date and time in the lower right part of the GSRB field opens
the configuration context menu. If the timestamp badge is not visible, right-click
the lower-left corner of the application window and turn On the Display Date and
Time toggle switch.

Figure 40: Date and Time Settings context menu

Table 12: Context menu options

Item Description
Display Date and Time When this toggle switch is turned on, Date and Time is displayed. If

turned off, the Date and Time field is removed from the GSRB field. To
turn it back on, right-click (or double-click) in the lower-left corner of the
application window and turn the date and time display on using the toggle
switch in the menu.

Time Format Select 12 hour or 24 hour time format.
Time Zone Select the time zone (region).

See also Waveform badges
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Math
Math waveforms are the vectors obtained by performing mathematical operations
on waveforms. With TekScope Anywhere, you can perform three types of Math
operations:

1. Basic Math where you can select predefined math functions from the drop-
down list.

2. Advanced Math where you can define math expressions by entering math
equations into the combo box.

3. Fast Fourier Transform (FFT) Math where you can create a FFT magnitude
waveform.

Basic Math
Basic Math allows you to perform basic mathematical operations on the source
waveform by selecting from among a list of predefined functions. 

■ Addition (+)
■ Subtraction (-)
■ Multiplication (*)
■ Common Mode (Source 1 + Source 2) / 2 
■ Integral
■ Derivative
■ SDLA
■ ArbFlt

See also Math settings - Advanced

Math settings - FFT

SDLA The Tektronix SDLA Visualizer software (opt. SDLA64) running on a Tektronix
oscilloscope can create filter files that can then be used in TekScope Anywhere.
These filters can be used to de-embed or embed channel effects or to apply CTLE
equalization.

Save these files in the same location that sample filters are installed: C:\Users
\Public\Tektronix\TekScope Anywhere\UserData\Math Arbitrary Filters, and
then apply them in TekScope Anywhere.

Choosing SDLA allows you to apply a filter for the waveform or waveforms for
the selected input mode. 

See SDLA use cases.
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Figure 41: SDLA settings

Item Description
Function - SDLA
Type ■ Single Input

■ Dual Input Differential
■ Dual Input Common
■ Dual Input Single Ended

Source 1 Select the waveform to be used as the source 1 waveform from
the drop-down list. The list has all the available waveform
sources except the Math waveform being configured.

Source 2 Select the waveform to be used as the source 2 waveform form
the drop-down list. The list has all the available waveform
sources except the Math waveform being configured.

Filter File 1 Browse and select the filter file for source1
Filter File 2 Browse and select the filter file for source2
Clear Removes the selected filter file

See also. SDLA use cases
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ArbFlt The Arbitrary filter (ArbFlt) function performs a mathematical operation like
Addition, Subtraction, Common mode, or None, and applies a filter to
waveforms. 

Figure 42: ArbFlt settings

Item Description
Function - ArbFlt
Operation ■ Addition

■ Subtraction
■ Common Mode
■ None

Source 1 Select waveform to be used as the source 1 waveform from the
drop-down list. The list has all the available waveform sources
except the Math waveform being configured.

Source 2 Select waveform to be used as the source 2 waveform from the
drop-down list. The list has all the available waveform sources
except the Math waveform being configured.

Filter File Browse and select the filter file
Clear Removes the selected filter file
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This section describes the library of FIR filters that are available to use with the
ArbFilt <x> function in the TekScope Anywhere. The characteristics of these
filters are shown in the following graphs. These are all linear phase filters.

You can use the Math Equation Editor to set up a waveform filter.

Low-pass filters

The following graphs show the available set of low-pass filters. Their normalized
frequency response is shown from 0 to ½ the sample rate. These filters will
operate at any sample rate with cutoff frequency scaled as shown in these graphs.

The filters have normalized cutoff frequencies:

■ 0.05 

■ 0.1 

■ 0.15 

■ 0.20 

■ 0.25 

■ 0.3 

■ 0.40 

■ 0.45 

Stop band rejection is typically between -50 and -60 dB.
 

 

Frequency response of the available low pass filters
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The following table lists the available low pass filters:

File name Normalized cutoff frequency
lowpass_0.05bw.fl 0.05 
lowpass_0.10bw.flt 0.10 
lowpass_0.15bw.flt 0.15 
lowpass_0.20bw.flt 0.20 
lowpass_0.25bw.flt 0.25 
lowpass_0.30bw.flt 0.30 
lowpass_0.35bw.flt 0.35 
lowpass_0.40bw.flt 0.40 
lowpass_0.45bw.flt 0.45 

High-pass filters

The following graphs show the available set of high-pass filters. Their
normalized frequency response is shown from 0 to ½ the sample rate. These
filters will operate at any sample rate with cutoff frequency scaled as shown
below on the graphs.

The filters have normalized cutoff frequencies:

■ 0.05 

■ 0.1 

■ 0.15 

■ 0.20 

■ 0.25 

■ 0.3 

■ 0.35 

■ 0.40 

■ 0.45 

Stop band rejection is typically between -50 and -60 dB.
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Frequency response of the available high-pass filters

The following table lists the available high-pass filters:

File name Normalized cutoff frequency
highpass_0.05bw.flt 0.05 
highpass_0.10bw.flt 0.10 
highpass_0.15bw.flt 0.15 
highpass_0.20bw.flt 0.20 
highpass_0.25bw.flt 0.25 
highpass_0.30bw.flt 0.30 
highpass_0.35bw.flt 0.35 
highpass_0.40bw.flt 0.40 
highpass_0.45bw.flt 0.45 

Band-pass filters
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Each filter has a bandwidth of 0.05 times the sample rate. They will operate at
any sample rate. The available center frequencies are:

■ 0.05 

■ 0.10 

■ 0.15 

■ 0.20 

■ 0.25 

■ 0.30 

■ 0.35 

■ 0.40 

■ 0.45 

Stop band attenuation is approximately -60 dB and pass band ripple is around
1dB.
 

 

The following table lists the available normalized band-pass filters:

File name Normalized
bandwidth

Normalized center
frequency

bandpass_0.05bw_0.05center.flt 0.05 0.05 
bandpass_0.05bw_0.10center.flt 0.05 0.10 
bandpass_0.05bw_0.15center.flt 0.05 0.15 
bandpass_0.05bw_0.20center.flt 0.05 0.20 
bandpass_0.05bw_0.25center.flt 0.05 0.25 
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File name Normalized
bandwidth

Normalized center
frequency

bandpass_0.05bw_0.30center.flt 0.05 0.30 
bandpass_0.05bw_0.35center.flt 0.05 0.35 
bandpass_0.05bw_0.40center.flt 0.05 0.40 
bandpass_0.05bw_0.45center.flt 0.05 0.45 

Band-stop filters

Each filter has a bandwidth of 0.1 times the sample rate. They will operate at any
sample rate. The available center frequencies are:

■ 0.10 

■ 0.15 

■ 0.20 

■ 0.25 

■ 0.30 

■ 0.35 

■ 0.40 

Stop band attenuation is approximately -110dB, however, the noise floor of the
oscilloscope will not allow for that depth.

With an FFT and long record length, and averaging turned on, one can approach
noise floors in the -110dBm range on an 8-bit oscilloscope. However, the
oscilloscope will have some spurious signals above that floor. This is possible
because the FFT is an average calculation internally and averaging increases the
vertical bits of resolution.
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Frequency response of the available band stop filters

The following table lists the available normalized band stop filters:

File name Normalized bandwidth Normalized center frequency
bandstop_0.1bw_0.10center.flt 0.1 0.10 
bandstop_0.1bw_0.15center.flt 0.1 0.15 
bandstop_0.1bw_0.20center.flt 0.1 0.20 
bandstop_0.1bw_0.25center.flt 0.1 0.25 
bandstop_0.1bw_0.30center.flt 0.1 0.30 
bandstop_0.1bw_0.35center.flt 0.1 0.35 
bandstop_0.1bw_0.40center.flt 0.1 0.40 

Smoothing filters

These are sometimes called box car filters. They simply average adjacent samples
along the time record. The filter coefficients for these filters are all equal to 1/-M
where M is the length of the filter. The file name indicates the length of the
smoothing filter.

Smoothing filters are low-pass filters with a somewhat less than optimal stop
band characteristic. However, they are commonly used to remove high frequency
noise from a displayed trace. Ensure that the pass band of the signal you are
filtering is well within the pass band of the filter you choose. That will ensure
that only noise is removed. Lengths of 3, 5, 10, 20, 50, 100, and 200 are provided
in the library. The red trace is for filter length 3, followed by blue trace at 5,
followed by magenta trace for 10, and so on.

 

 

Frequency response of the available smoothing filters
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The following table lists the available smoothing filters:

File name Length Normalized
bandwidth

Stop band attenuation
dB

smooth3.flt 3 0.1558 -9.4 
smooth5.flt 5 0.0903 -12 
smooth10.flt 10 0.0446 -12.9 
smooth20.flt 20 0.0224 -13.2 
smooth50.flt 50 0.00887 -13.2 
smooth100.flt 100 0.0045 -13.2 
smooth200.flt 200 0.0022 -13.2 

Hilbert transform filter

The ideal Hilbert transform filter has a gain of one at all frequencies and shifts
the phase of all frequencies by 90 degrees. This type of filter is one of the types
that may be specified in the Remez Exchange algorithm. This filter departs from
its desired behavior in the frequency range of 0 to 0.025 times the sample rate
and also in the range of about 0.475 to 0.5 times the sample rate. This type of
filter can be used to create quadrature signals over a wide frequency range. The
filename for this filter is HilbertTransform90PhaseShift.flt.
 

 

Frequency response of the Hilbert transform filter

Differentiator
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The ideal differentiator is a high pass filter that shifts phase by 90 degrees and the
frequency response would be linear from DC to 0.5. Since this is not easily
realized, the filter provided in the library makes a good differentiator for the
frequency range of DC to 0.45.
 

 

Frequency response of the differentiator filter

This section describes the ASCII file format for storing filters. This allows you to
save and use a custom filter, allowing you to specify a different set of coefficients
for each sample rate that the filter operates at,and whether the filter coefficients
are normalized so the same set of filter files can operate at all sample rates. If the
desired sample rate is not in the file list, then the filter will not be applied to the
data.

The ASCII file format is specified as follows:
# Comments are preceded by # symbol
< sampleRate > coef1, coef2, …. coefN
< sampleRate > coef1, coef2, …. coefN
| |
| |
< sampleRate > coef1, coef2, …. coefN

Each set of filter coefficients in a file are specified in one row preceded by the
sample rate value at which that set will operate. you specify the @ symbol for the
sample rate, then the filter will operate at all sample rates. If the @ symbol is
specified, then there should only be one set of filter coefficients in the file.
However, you may have other rows with sample rates specified and they will be
ignored. There will be a separate row for each sample rate the filter is to operate
at. Each row may have a different number of coefficients with a maximum of
1000. The file may contain up to 20 rows.
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An example of file content for a normalized filter is shown below. This example
is the contents of the smooth5.flt file:
@ 0.2, 0.2, 0.2, 0.2, 0.2

An example of a filter that is setup to operate at a specific sample rate is given as
follows. This is the contents of a file named 200MHz_mult_sample_rates.flt that
is included in the library directory on the oscilloscope.
#This is a 4th order Bessel Thompsen low pass filter. 
#200MHz bandwidth, will operate at any of the 
following sample rates: 
# 40 GS/s, 20 GS/s, 10 GS/s, 5 GS/s, 2.5 GS/s, 1 GS/
s, 500 MS/s
5e8; 
1.968e-007,1.008,-0.00978,0.002267,-0.0002208,1.643e-0
05,-1.397e-006,1.434e-007 
1e9; 
9.524e-008,0.3899,0.4877,0.1304,-0.004733,-0.004566,
………………………….
2.5e9; 3.868e-008,0.01885,0.1081,0.1982,0.2284,0.1981,
………………………
5e9; 1.935e008,0.0007332, 0.009428, 0.02874, 0.05408, 
0.07921, ……………………….
1e10; 
9.673e-009,3.445e-006,0.0003666,0.001831,0.004714,0.00
8978,0.01437,0……………….
2e10; 4.837e-009, 1.657e-008, 1.723e-006, 4.274e-005, 
0.00018334-009, ……………….
4e10; 2.418e-009, -3.524e-009, 8.284e-009, 
-1.795e-008,8.613e-007, ……………….
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Advanced Math
Advanced Math allows you to define math expressions by directly typing an
equation into the input box. Advanced Math is used to define an expression or a
combination of expressions defining operations on the waveform. The input box
has a drop-down list associated with it. This list will show the last 20 valid
advanced math expressions (newest on top), making it easy for you to reuse a
previous advanced math expression.

How to define a Math expression

You can define a simple math expression using an operator, or a complex math
expression by using a combination of math operators and expressions. When
there is a real expression used in a vector expression, it can be replaced by any of
the real expressions listed below, but the entire math expression should resolve to
a vector expression, or else a blank screen will be displayed and there won't be
anything visible on the screen. For example, If the math expression is 2+2, then
you would not see anything since this expression defines a single point. If the
math expression is 2+Ref1, then a waveform with each point incremented by 2 is
displayed.

Math expression format

When the settings are static, use this expression format: STATIC [ <settings> ]
<expr>

When the settings are dynamic and global, use this expression format:
[ <settings> ] <expr>

Example

Atan(Ref3*Sqrt(Math2*10%))

Math1 + STATIC [ CoefFileName=”coeffs.flt” ] ArbFlt(Math1+2*ArbFlt(Ch2))
^ (Sqrt(2)*PI)

Math expressions accept waveform source, real numbers, integral numbers,
engineering notation numbers, settings parameters and filter file path. You can
create complex math functions using a combination of math operators and
expressions.

The available operators and valid syntax for defining math expressions are listed
in the following table.
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Table 13: Arithmetic operations

Operators Name Syntax
+ Addition <expr> + <real expr>

<real expr> + <source>
<expr1> + <expr2>
<real expr> + <real expr>

- Subtraction <expr> - <real expr>
<real expr> - <source>
<expr1> - <expr2>
<real expr> - <real expr>

* Multiplication <expr> * < real expr >
<real expr> * <source>
<expr1> * <expr2>
<real expr> * <real expr>

/ Division <expr> / <real expr>
<real expr> / <source>
<expr1> / <expr2>
<real expr> / <real expr>

% Percentage <real expr> %
^ Power <expr> ^ <real expr>

<real expr> ^ <real expr>
- Negation - <expr>

- <real expr>
DEGREE DEGREE <real expr> DEGREE

Table 14: Numerical comparisons

Operators Name Syntax
< Less than <expr1> < <expr2>

<expr> < <real expr>
> Greater than <expr1> > <expr2>

<expr> > <real expr>
<= Less than or equal to <expr1> <= <expr2>

<expr> <= <real expr>
>= Greater than or equal

to
<expr1> >= <expr2>
<expr> >= <real expr>

== Equality <expr1> == <expr2>
<expr> == <real expr>

!= Inequality <expr1> != <expr2>
<expr> != <real expr>

Table 15: Special functions

Functions Name Syntax
GATE GATE GATE { <start time>, <end time> } <expr>
Inv Inverse Inv(<expr>)
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Functions Name Syntax
Log Natural logarithm Log(<expr>)
Ln Base 10 logarithm Ln(<expr>)
Exp Natural exponential

function
Exp(<expr>)

Sqrt Square root Sqrt(<expr>)
Sqrt(<real expr>)

Floor Round up to next
integer

Floor(<expr>)

Ceil Round down to next
integer

Ceil(<expr>)

Fabs Floating point absolute
value

Fabs(<expr>)

Intg Integral Intg(<expr>)
Diff Differential Diff(<expr>)
Min Minimum Min(<expr>)
Max Maximum Max(<expr>)
Avg Average Avg(<expr>)

Average weight, used as "STATIC
[AVGWeight=16] Avg(<expr>)"

Table 16: Trigonometric and hyperbolic functions

Function Syntax
Sin Sin(<expr>)

Sin(<real expr>)
Cos Cos(<expr>)

Cos(<real expr>)
Tan Tan(<expr>)

Tan(<real expr>)
Asin Asin(<expr>)
Acos Acos(<expr>)
Atan Atan(<expr>)
Sinh Sinh(<expr>)
Cosh Cosh(<expr>)
Tanh Tanh(<expr>)

Tanh(<real expr>)

Math operator - ArbFlt

ArbFlt(<expr>)

Coefficient file name, used as "STATIC [ CoefFileName=<file path>]
ArbFlt(<expr>)"
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Table 17: Math operator - FFT

FFT Syntax
FFTMag - Spectral magnitude FFTMag(<expr>)
FFTPhase - Spectral phase FFTPhase(<expr>)
FFT settings:
Termination Default value is 50.0 
WindowType Blackharris, Hamming, Hanning, Rectangle.

Default is Rectangle
FFTMag settings:
Scale Linear or Log, default is Linear
FFTPhase settings
Scale Degrees, Radians, GroupDelay, default is

degrees
PhaseWrap Numeric value that's either >= 180.0 or not

specified
Squelch Numeric value, FFTPhase will ignore all data

points below this value if it's specified.
Example:

■ STATIC [ Termination=50.0, WindowType=Rectangle, Scale=Linear] FFTMag(<expr>)
■ STATIC [ Termination=50.0, WindowType=Rectangle, Scale=Degrees] FFTPhase(<expr>)
■ STATIC [ Termiantion=50.0, WindowType=Rectangle, Scale=Degrees, PhaseWrap=180,

Squelch=0.1] FFTPhase(<expr>)

Math expression arguments

Arguments Description
( ) (<expr>)

(<real expr>)
<expr> It can be either a vector waveform, such as ref<x>, ch<x> or

math<x>, or a math expression listed above. The combinations
are unlimited.

<real expr> It can be replaced with any of the following (again, recursive):

■ <real number>
■ <integral number>
■ <engineering notation number>
■ PI

<Source> Waveform source such as ref<x>, ch<x> or math<x>
<file path> File path
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See also Math settings - Basic

Math settings - FFT

FFT Math
When a FFT Math is defined, the spectrum is displayed in the new view. (If the
resulting FFT Math waveform is a time domain waveform, then it is displayed in
the Time Domain View.)

Click Plot Configure Options from the title bar of FFT Math view to configure
the view.

Figure 43: FFT Math configuration

Table 18: FFT Math configuration

Configuration Description
Source Select the source from the drop-down list. The list displays all the

waveform sources except the Math waveform being configured.
Plot Type
Magnitude Creates an FFT magnitude waveform.
Phase Creates an FFT phase waveform.
Window
Rectangle Best frequency, worst magnitude resolution. This is essentially

the same as no window. Use this window for:

■ Transients or bursts where the signal levels before and after
the event are nearly equal.

■ Equal-amplitude sine waves with frequencies those are very
close.
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Configuration Description
Hamming Better frequency, poorer magnitude accuracy than Rectangular.

Hamming has slightly better frequency resolution than Hanning.
Use this window for:

■ Transients or bursts where the signal levels before and after
the event are significantly different.

■ Sine, periodic, and narrow-band random noise.

Hanning Better frequency, poorer magnitude accuracy than Rectangular.
Hamming has slightly better frequency resolution than Hanning.
Use this window for:

■ Transients or bursts where the signal levels before and after
the event are significantly different.

■ Sine, periodic, and narrow-band random noise.

Blackman Harris Best magnitude, worst frequency resolution. Used predominantly
for single frequency signals to look for higher order harmonics.

Vertical Scale - Magnitude
Log (dBm) Displays magnitude in dBm (log) units.
Linear (V) Displays magnitude using units equal to the source units.
Vertical Scale - Phase
Degrees Sets the phase units to degrees. Phase is displayed using

degrees as the scale, where degrees range from -180° to +180°.
Radians Sets the phase units to radians. Phase is displayed using radians

as the scale, where radians range from -P to +P.
Group Delay Group Delay displays the derivative of the phase with respect to

Frequency.

Phase Wrap Phase wrap is used to produce smoother phase plots. When
Phase wrap is checked, the phase trace is wrapped according to
the value shown in the numeric input box. Phase wrapping
adjusts the phase by adding multiples of +-360 degrees to the
phase value whenever the phase changes by a value greater
than the phase wrap value.
Default is checked; Default value is 180 degrees.

Squelch When checked, the phase trace is blanked when the signal is
below the amplitude specified by the value shown in the numeric
input box.
Default is unchecked; Default value is 1.00 mV.
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See also Math settings - Basic

Math settings - Advanced

FFT process The FFT function converts the time domain signal into its frequency components
and displays them. The highest frequency that can be measured without errors is
one-half of the sample rate. This frequency is called the Nyquist frequency.
 

 

FFT windows The FFT process assumes that the part of the waveform record used for FFT
analysis represents a repeating waveform that starts and ends at or near the same
voltage of a cycle. In other words, it is an integer number of cycles. When a
waveform starts and ends at the same amplitude, there are no artificial
discontinuities in the signal shape, and both the frequency and amplitude
information is accurate.

The waveform start and endpoints will be at different amplitudes if the number of
cycles in the waveform is non-integral. The transitions between the start and end
points cause discontinuities in the waveform that introduce high-frequency
transients. These transients add false frequency information to the frequency
domain record.

Applying a window function to the waveform record changes the waveform so
that the start and stop values are close to each other, reducing the discontinuities.
This results in an FFT measurement that more accurately reflects the actual signal
frequency components. The shape of the window determines how well it resolves
frequency or magnitude information.
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The ability to quickly look at signal frequency components and spectrum shape is
a powerful research and analysis tool. FFT is an excellent troubleshooting aid for
the following:

■ Testing the impulse response of filters and systems

■ Measuring harmonic content and distortion in systems

■ Identifying and locating noise and interference sources

■ Analyzing vibration

■ Analyzing harmonics in 50 and 60 Hz power lines
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Spectral analysis features You can apply an FFT transform on any active waveform (except the Math
waveform being configured).

FFT windows

The instrument allows you to match the optimum window to the signal you are
analyzing.

■ The Rectangular window is best for nonperiodic events such as transients,
pulses.

■ The Hamming, Hanning, and Blackman-Harris windows are better for
periodic signals.

Vertical scales

The FFT vertical graticule can be set to either dB or Linear RMS.

■ A dB scale is useful when the frequency component magnitudes cover a wide
dynamic range, letting you show both lesser and greater magnitude frequency
components on the same display.

■ A Linear scale is useful when the frequency component magnitudes are all
close in value, enabling direct comparison of their magnitudes.

Selecting a spectral
window

A spectral window determines the filter shape of the spectral analyzer in
frequency domain. It may be described by a mathematical function that is
multiplied point-by-point times the input data to the spectral analyzer.

The following spectral windows are available with the application:

■ Rectangular

■ Hamming

■ Hanning

■ Blackman Harris

The windows are listed in the order of their ability to resolve frequencies. You
can easily observe the shape of the window in frequency domain by feeding a
sine wave into the instrument and setting the center frequency of the spectral
analyzer to the same frequency. Then reduce the resolution bandwidth to spread
out the lobe horizontally. You can then select different window functions and
observe their shape.

Window attributes

■ In time domain, windows are typically bell shaped and go to zero at the end
of the record. For cases where you may be doing impulse response testing,
the impulse should be centered at the zero phase reference point (for most
windows, this is the 50% position of the gate and 20% for the Tek
Exponential window).

■ Different window functions affect the resolution bandwidth of the spectral
analyzer.
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■ Various window shapes affect the scallop loss.

■ The shape of the frequency domain lobe is determined by the window
function. Some windows have better resolution bandwidth, but they do so at
the expense of side lobe attenuation and energy leakage into adjacent bins.
For example, a rectangular window typically spills energy into many bins
showing signals that don’t exist; but it has the best frequency resolution.

Rectangular window. This window is equal to unity (see the next figure). This
means the data samples in the gate are not modified before input to the spectral
analyzer.

NOTE. This window has the narrowest resolution bandwidth of any of the
windows, but it also has the most spectral leakage and the highest side lobes.
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Hamming window. This window is unique in that the time domain shape does not
taper all the way to zero at the ends. This makes it a good choice if you wanted to
process the real and imaginary parts of the spectrum off line and inverse
transform it back to the time domain. Because the data does not taper to zero, you
could remove the effect of the window function from the result.
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Hanning and Blackman-Harris windows. These windows have various resolution
bandwidths and scallop losses (see the figures below). Choose the one that best
allows you to view the signal characteristics you are interested in.

NOTE. The Blackman-Harris window has a low amount of energy leakage
compared to the other windows. The Hanning window has the narrowest
resolution bandwidth, but higher side lobes.

Hanning
 

 
 

 

Blackman-Harris
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Spectral analyzer window
types

For most windows, this function tapers to zero at both ends of the gated region.
Before computing the spectral transformation, the window is multiplied, sample
by sample, times the input data in the gated region. The window function affects
the shape of the spectral analyzer response in the frequency domain.

The window functions affect the ability to resolve frequency in the output
spectrum and can affect the accuracy of magnitude and phase measurements. The
previous figure shows how the time domain record is processed.

Accurate magnitude measurements require that the input source waveform be
stationary within the gated region. This means that waveform parameters, such as
frequency and amplitude, should not change significantly as a function of time
within the gated region that is input to the spectral analyzer. Also, the gate width
must be greater than or equal to the period of the start frequency of the span of
the spectral analyzer. That is, there must be at least one cycle of the harmonic
being measured within the gated region.
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There are four different spectral analyzer windows:

■ Rectangular

■ Hamming

■ Blackman-Harris

■ Hanning

Your choice of window function will depend on the input source characteristics
that you want to observe and the characteristics of the window function. The
window characteristics are shown in the following table.

Window 3 dB BW in
bins

Scallop loss Nearest side
lobe

Zero phase
reference

Coefficients

Rectangular 0.89 3.96 dB -13 dB 50% 1.0 
Hamming 1.3 1.78 dB -43 dB 50% 0.543478,

0.456522 
Blackman-
Harris

1.44 1.42 dB -32 dB 50% 0.5, 0.5 

Hanning 1.92 0.81 dB -92 dB 50% 0.35875,
0.48829,
0.14128,
0.01168 

3 dB BW in bins

This is the bandwidth in units of bins, which are the intervals between spectral
output samples when no zero fill is used. The bandwidth is measured between the
points on the lobe that are 3 dB down from the peak of the lobe. The bandwidth
in hertz may be computed by dividing the BW in bins by the gate duration in
seconds. This is also referred to as resolution bandwidth (RBW).

Scallop loss

This is the magnitude error of the spectral analyzer when the frequency of the
observed signal is exactly half way between two frequency samples of the
spectrum when the interpolation ratio due to zero fill of the FFT is one. When
zero fill is in effect, scallop loss is essentially eliminated because of the
interpolation in the frequency domain due to zero fill. If you work with span
settings less than full and you work with larger resolution bandwidth settings,
zero fill is in effect most of the time.
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Nearest side lobe

This is the difference in magnitude between the spectral lobe peak in the
spectrum and the next side lobe that occurs due to energy leakage. Different
windows have different leakage characteristics. The more narrow the resolution
bandwidth of the window the more leakage in the spectrum.

Zero phase reference

This is the position in the time domain gate that is the reference point for phase in
the output spectrum. That is, if a sine wave input has its peak at the zero phase
reference position, then it reads out as zero phase in the spectrum. If the phase is
to be correct when doing impulse response testing, the impulse in the time
domain must be located at this position in the gate interval.

Coefficients

These are used to generate the windows that are constructed from a cosine series.
For the Gaussian window, the value of "a" is given instead of a set of
coefficients. You can find descriptions of cosine series windows in the Handbook
of Digital Signal Processing Engineering Applications by Elliot. ISBN
0-12-237075-9.
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Scallop loss Scallop loss is the difference between the actual magnitude and the computed
magnitude of a signal that is halfway between two frequency bins in the spectral
output data. Scallop loss is only noticeable when the spectral analyzer is not
using zero-fill such as when it is set to full span.

If zero-fill is in use, frequency domain interpolation occurs and there is minimal
scallop loss. Zero-fill cannot be directly controlled; it is affected by changing
settings of resolution bandwidth or gate width. When in use, a minimum of 20%
of the FFT input is always zero, effectively removing scallop loss error by
interpolating in the frequency domain.

NOTE. For most settings, descriptions of amplitude accuracy due to scallop loss
(as discussed in other publications) do not apply to this oscilloscope when used
as a spectral analyzer because of zero-fill. Full span is the most likely setting
where scallop loss might occur.

Leakage

Leakage results when the time domain waveform used to create the FFT function
is periodic but contains a non-integer number of waveform cycles. When the
record contains a fraction of a cycle, there are discontinuities at the ends of the
record.

These discontinuities cause energy from each discrete frequency to leak over on
to adjacent frequencies. This results in amplitude errors when measuring any
given frequency. Different windows have different leakage characteristics.
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Cursor setup
Cursors are vertical/horizontal markers on the display used to show x-axis and y-
axis values where the cursor crosses a waveform or plot. Cursors are also used to
measure values between two points.

Readouts are provided to reflect the cursor position and the delta between
cursors. Cursors can be repositioned individually by dragging either the cursor or
the cursor readout. To move a pair of cursors while maintaining the distance
between them, drag the delta readout. After selecting a readout the mouse scroll
wheel can also be used to move the associated cursor(s) in small steps.

Turning Cursors On/Off
Cursors can be turned On/Off by clicking the cursor icon on the title bar. 

Figure 44: Cursor selection panel

TIP. You can also turn on cursors by right-clicking and selecting Cursors in
display area.
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See also Using cursors on waveform

Using cursors on plot

Cursor types

Understand the cursor lines and symbols

Cursor types
TekScope Anywhere provides two type of cursors: waveform cursors and screen
cursors. 

Waveform cursors

Waveform cursors are placed at a particular horizontal location on the selected
waveform. The cursor readouts display the horizontal and vertical values of the
waveform at the cursor location..

Waveform cursors follow the waveform. Panning the waveform left or right will
cause the cursor to move with the waveform. Waveform cursors can be moved
off the waveformby zooming the view, panning to the end of the waveform, and
dragging the cursor outside the waveform area.

Figure 45: Waveform cursors

Screen cursors Screen cursors are tied to a specific X and Y position in the view.
The cursors readouts display the horizontal and vertical location of the cursor on
the x and y axis.
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Figure 46: Screen cursors

See also Using cursors on waveform

Using cursors on plot

Understand the cursor lines and symbols

Cursor lines and symbols
There are two cursor lines, A and B, available for each display plane (horizontal
and vertical). To reposition a cursor click and hold a cursor line to drag it to a
desired location.
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Number Description
1 A read-out of the horizontal location of cursor A
2 A readout of the delta between cursors
3 A readout of the horizontal location of cursor B
4 Cursor icon (A or B)
5 Cursor source indicator

Symbols and read-out on cursor line

The position of cursors is displayed in readouts. The delta value between the
cursors is displayed in the readout between the two lines. The values are
displayed only when cursors are selected.

The A/B icon and source indicators are displayed at the bottom of horizontal
cursors and at the right side for vertical cursors.
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See also Using cursors on waveform

Using cursors on plot

Cursor types

Cursors context menu
Right click on a cursor to access cursor shortcuts context menu.

Figure 47:

Table 19: Cursors context menu

Item Description
Wfm Cursors Turns waveform cursors on/off.

■ If cursors are off, waveform cursors are turned on.
■ If screen cursors are on, the cursor type is changed to

waveform cursors.
■ If waveform cursors are on, cursors are turned off.

Screen Cursors Turns screen cursors on/off.

■ If cursors are off, screen cursors are turned on.
■ If waveform cursors are on, the cursor type is changed to

screen cursors.
■ If screen cursors are on, cursors are turned off.

Cursor Source Select the source waveform for cursors from the list.
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Measurements

Index of all measurements

Amplitude category
measurements

Definitions of the Amplitude measurements are given in the following table.
Clicking the measurement name hyperlink opens the topic showing the respective
measurement algorithm and details about the calculation of results.

Table 20: Amplitude category measurements

Measurement Description
Amplitude This voltage measurement is the high value minus the low value

measured over the entire waveform or gated region.
Amplitude = High - Low

Max The most positive peak voltage. Max is measured over the entire
waveform or gated region.

Min The most negative peak voltage. Min is measured over the entire
waveform or gated region.

High The value is used as 100% whenever high reference, mid
reference, or low reference values are needed, such as in fall
time or rise time measurements. It is calculated using either the
min/max or histogram method. The min/max method uses the
maximum value found. The histogram method uses the most
common value found above the mid point. This value is
measured over the entire waveform or gated region.

Low The value is used as 0% whenever high reference, mid
reference, or low reference values are needed, such as in fall
time or rise time measurements. It is calculated using either the
min/max or histogram method. The min/max method uses the
minimum value found. The histogram method uses the most
common value found below the mid point. This value is
measured over the entire waveform or gated region.

DC Common Mode Common-mode voltage for the two sources.

AC Common Mode The common mode voltage between two single-ended signals.
AC is defined as all the frequency components above the cutoff
frequency (30 KHz).

Cycle Overshoot Difference between the positive-going peak amplitude and the
reference voltage level, for each waveform event that exceeds
the reference level.
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Measurement Description
Cycle Undershoot Difference between the negative-going peak amplitude and the

reference voltage level (expressed as a positive number), for
each waveform event that exceeds the reference level.

Peak-to-peak The absolute difference between the maximum and minimum
amplitude in the entire waveform or gated region.

RMS This voltage measurement is the true Root Mean Square voltage
over the entire waveform or gated region.

AC RMS The true Root Mean Square voltage over the measurement
region.

Cycle RMS This voltage measurement is the true Root Mean Square voltage
of all the cycle in the waveform or of all the cycle in the gated
region.

+ Overshoot This is measured over the entire waveform or gated region and is
expressed as: Positive Overshoot = ((Maximum - High) /
Amplitude) * 100%.

- Overshoot This is measured over the entire waveform or gated region and is
expressed as: Negative Overshoot = ((Low - Minimum) /
Amplitude) * 100%.

Mean This voltage measurement is the arithmetic mean over the entire
waveform or gated region.

Cycle Mean This voltage measurement is the arithmetic mean of all the cycle
in the waveform or of all the cycle in the gated region.

Cycle Min Defined as the peak negative voltage in each cyle, where cycles
are determined by the mid reference level crossings.

Cycle Max Defined as the peak positive voltage in each cyle, where cycles
are determined by the mid reference level crossings.

V-Diff-Xovr Voltage level at the crossover voltage of a differential signal pair.
Cycle Pk-Pk The absolute difference between the maximum and minimum

amplitude in each cycle. Cycles are determined by the mid
reference level crossings.

T/nT Ratio Ratio of the transition eye voltage to the nearest subsequent
non-transition eye voltage, expressed in decibels.

Bit High Vertical value in the central portion of the unit interval (UI) for
high data bits. The percent of the UI over which the waveform is
evaluated is adjustable, as is the method by which a single value
is derived from this span. The measurement may optionally be
limited to transition or non-transition bits only.

Bit Low Vertical value in the central portion of the unit interval (UI) for low
data bits, with configuration options matching those of the high
measurement.

Bit Amplitude Difference between the mean value of the high measurement
and the mean value of the low measurement.
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Time category
measurements

Definitions of the Time measurements are given in the following table. Clicking
the measurement name hyperlink opens the topic showing the respective
measurement algorithm and details about the calculation of results.

Table 21: Time category measurements

Measurement Description
Period For clock signals, the elapsed time between consecutive

crossings of the mid reference voltage level in the direction
specified; one measurement is recorded per crossing pair. For
data signals, the elapsed time between consecutive crossings of
the mid reference voltage in opposite directions divided by the
estimated number of unit intervals for that pair of crossings; one
measurement is recorded per unit interval so N consecutive bits
of the same polarity result in N identical period measurements.

Frequency The inverse of the period for each cycle or unit interval.
Rise Time Elapsed time between the low reference level crossing and the

high reference level crossing on the rising edge of the waveform.
Fall Time Elapsed time between the high reference level crossing and the

low reference level crossing on the falling edge of the waveform.
Rise Slew Rate Rate of change of voltage between the two chosen reference

level crossings on the rising edges of the waveform.
Fall Slew Rate Rate of change of voltage between the two chosen reference

level crossings on the falling edges of the waveform.
High Time Amount of time the waveform remains above the high reference

voltage level.
Low Time Amount of time the waveform remains below the low reference

voltage level.
+ Width The distance (time) between the mid reference (default 50%)

amplitude points of a positive pulse. The measurement is made
on the first pulse in the waveform or gated region.

- Width The distance (time) between the mid reference (default 50%)
amplitude points of a negative pulse. The measurement is made
on the first pulse in the waveform or gated region.

Setup Elapsed time between the designated edge of a data waveform
and that of a clock waveform, based on the respective mid
reference level crossings.

Hold Elapsed time between the designated edge of a clock waveform
and that of a data waveform, based on the respective mid
reference level crossings.

Skew Time difference between two similar edges on two waveforms
assuming that every edge in one waveform has a corresponding
edge (either the same or opposite polarity) in the other
waveform; edge locations are determined by the mid reference
voltage level.

N-Period The duration of N periods.
+ Duty Cycle The ratio of the positive pulse width to the signal period

expressed as a percentage. The duty cycle is measured on the
first cycle in the waveform or gated region.
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Measurement Description
- Duty Cycle The ratio of the negative pulse width to the signal period

expressed as a percentage. The duty cycle is measured on the
first cycle in the waveform or gated region.

CC - Period The cycle-to-cycle period; the difference in period measurements
from one cycle to the next, that is the first difference of the Period
measurement.

+ CC Duty The difference between two consecutive positive widths.
- CC Duty The difference between two consecutive negative widths.
SSC Profile SSC Profile is not intended to serve as a measurement. It is a

vehicle for showing the SSC modulation profile versus time,
using a time trend plot.

SSC Freq Dev SSC frequency deviation in ppm (parts per million), measured at
each inflection point in the modulation profile.

SSC Freq Dev Min The minimum frequency shift as a function of time.
SSC Freq Dev Max The maximum frequency shift as a function of time.
SSC Mod Rate SSC Mod Rate computes the SSC modulating frequency.
Time Outside Level Time Outside Level Ring Back is defined as the time interval of

overshoot or undershoot.

Jitter category
measurements

By default, the application enables analysis of all jitter components except Non-
Periodic Jitter (NPJ). This is because NPJ, which is a Bounded Uncorrelated
Jitter (BUJ) form, isn’t periodic, is less frequently encountered, and its analysis
typically requires longer waveforms, multiple waveforms, or both. The default
processing mode is called Spectral Only. To enable analysis of NPJ, set the Jitter
Seperation Model to Spectral + BUJ in the preferences window.

Definitions of the Jitter measurements are given in the following table. Clicking
the measurement name hyperlink opens the topic showing the respective
measurement algorithm and details about the calculation of results.

Table 22: Jitter category measurements

Measurement Description
Jitter Summary This is not an individual measurement but a convenience

function. Pressing this button automatically adds a set of eleven
jitter-related measurements with a single action. The
measurements are: TIE, RJ, RJ–δδ, DJ, DJ–δδ, PJ, SRJ, DDJ,
DCD, TJ@BER, and Width@BER.

TIE Time Interval Error is the difference in time between an edge in
the source waveform and the corresponding edge in a reference
clock or explicitly by another source signal. The reference clock
is determined by a clock recovery process.
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Measurement Description
RJ Random Jitter is the statistics for all timing errors not exhibiting

deterministic behavior, based on the assumption that they follow
a Gaussian distribution. If the Jitter Separation Model is set to
Spectral + BUJ, the Gaussian assumption is further validated
and jitter appearing to be non-Gaussian is excluded. Random
Jitter is characterized by its standard deviation.

RJ–δδ Dual-Dirac Random Jitter is Random Jitter as defined above, but
calculated based on a simplified assumption that the histogram
of all deterministic jitter can modeled as a pair of equal-
magnitude Dirac functions (impulses known as delta-functions).

Clock NPJ Non-Periodic Jitter (NPJ) is the dual-dirac magnitude of that
portion of Bounded Uncorrelated Jitter (BUJ) that is not periodic.
Since it is not periodic and is not correlated with the data pattern,
NPJ is frequently difficult to distinguish from (Gaussian) RJ".

TJ@BER Total Jitter at a specified Bit Error Rate (BER). This combines the
Random and Deterministic effects, and predicts a peak-to-peak
jitter that will only be exceeded with a probability equal to the
BER.

DJ Deterministic Jitter is the statistics for all timing errors that follow
deterministic behavior. Deterministic Jitter is characterized by its
peak-to-peak value.

DJ–δδ Dual-Dirac Random Jitter is Random Jitter as defined above, but
calculated on the same simplified model as described under RJ–
δδ.

PJ Periodic Jitter is the statistics for that portion of the deterministic
jitter which is periodic, but for which the period is not correlated
with any data in the waveform.

DDJ Data-Dependent Jitter is the statistics for that portion of the
deterministic jitter directly correlated with the data pattern in the
waveform.

DCD Duty Cycle Distortion is the statistics for that portion of the
deterministic jitter directly correlated with signal polarity, that is
the difference in the mean timing error on positive edges versus
that on negative edges.

J2 Total Jitter at a Bit Error Rate (BER) value of 2.5E-3. This
statistical value predicts a peak-to-peak jitter that will only be
exceeded with a probability equal to the BER.

J9 Total Jitter at a Bit Error Rate (BER) value of 2.5E-10. This
statistical value predicts a peak-to-peak jitter that will only be
exceeded with a probability equal to the BER.

SRJ Sub-Rate jitter is jitter at rates that integrally divide the data rate.
SRJ typically results when a data stream has been created by
multiplexing multiple lower-rate streams. SRJ is a subcomponent
of PJ, and can be further isolated into F/N components.
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Measurement Description
F/N The peak-to-peak amplitude of periodic jitter occurring at a rate

that divides the data rate by an integer. (When a deterministic
jitter component could be interpreted either as F/N or DDJ, it is
treated as DDJ by convention.)

Phase Noise The RMS magnitude for all integrated timing jitter falling between
two specified frequency limits. This measurement is only
applicable for clock signals.

Eye category
measurements

Definitions of the Eye measurements are given in the following table. Clicking
the measurement name hyperlink opens the topic showing the respective
measurement algorithm and details about the calculation of results.

Table 23: Eye category measurements

Measurement Description
Width Measured clear horizontal eye opening at the middle reference

level.
Width = UI(mean) – TIE(max) – TIE(min)

Width@BER The horizontal eye opening projected to correspond to a
specified Bit Error Rate. This number is obtained by measuring
the jitter on the waveform, performing RJ/DJ separation analysis,
creating a bathtub curve, and reporting the bathtub width at the
appropriate error rate. This eye width may not match the
observed eye width because it is a statistical measure. The
measurement requires a sufficient record length so that all
deterministic effects can be observed and the random jitter can
be modeled.
Width(BER) = UI(mean) – TJ(BER)

Height The measured clear vertical eye opening at the center of the unit
interval. Height = High(min) – Low(max)

Height@BER The eye height at a specified Bit Error Rate
Eye High The voltage at a selected horizontal position across the unit

interval, for all High bits in the waveform.
Eye Low The voltage at the selected horizontal position across the unit

interval, for all Low bits in the waveform.
Q-Factor Quality Factor is the ratio of vertical eye opening to rms vertical

noise.
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Source configuration

Source configuration The application takes measurements from the waveform specified as an input or
source. To change the source, left click in the Source(s) cell of the applicable
measurement row in the Measurement Library > Measurement table.

Figure 48: Sources configuration

Table 24: Sources configuration

Item Description
Select Measurement Select the measurement from the list of available measurements.

Default setting - Selected measurement
Edit Source 1 Select the source1 from the drop-down list. The list has all the

available waveform sources.
Default setting - Source of the selected measurement

Edit Source 2 Select the second source from the drop-down list. This option is
present only for two source measurements (for example, Setup).
The list has all the available waveform sources.
Default setting - Second source of the selected measurement

Apply to all one source
measurements

Applies the source configuration to all single source
measurements in the measurement table.

Apply to all two source
measurements

Applies the source configuration to all two source measurements
in the measurement table.

Close Closes the window.

See also. Ref level
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Ref Level Timing measurements are based on state transition times. By definition, edges
occur when a waveform crosses specified reference voltage levels. Reference
voltage levels must be set so that the application can identify state transitions on a
waveform. By default, the application automatically chooses reference voltage
levels. To access the Ref Level configuration, click the cell for the applicable
measurement row in the column "Source(s)"column and select the Ref Level tab
from the resulting context menu.

To configure the reference level, open the source configuration dialog box (click
on the Source(s) column in the Measurement table) and select the Ref Level tab.

Figure 49: Ref Level configuration

The application uses three basic reference levels: High, Mid and Low. In
addition, a hysteresis value defines a voltage band that prevents a noisy
waveform from producing spurious edges. The reference levels and hysteresis are
independently set for each source waveform, and can be specified separately for
rising versus falling transitions (in the Advanced View). Reference levels can be
set as either percentages or as absolute values. The reference levels are calculated
only when required, otherwise TBD is displayed in place of the calculated values.

High, mid and low reference voltage levels

The application uses three reference voltage levels: High, Mid, and Low:
■ For most measurements, the application only uses the Mid reference voltage

level. The Mid reference level defines when the waveform state transition
occurs at a given threshold.

■ For Rise Time and Fall Time measurements, the High and Low reference
voltage levels define when the waveform is fully high or fully low.
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Rising Versus Falling Thresholds

You can specify thresholds for each of the reference voltage levels: High, Mid,
and Low. The application uses the thresholds to determine the following events:

■ A Low/Mid/High rising event occurs when the waveform passes through the
corresponding Rise threshold in the positive direction.

■ A Low/Mid/High falling event occurs when the waveform passes through the
corresponding Fall threshold in the negative direction.

For a given logical reference level (such as Low, Mid, or High), rising and falling
events alternate as time progresses.

NOTE. In many cases, the rising and falling thresholds for a given reference
voltage level are set to the same value. In those cases, a hysteresis value helps
prevent spurious edges produced by small amounts of noise in a waveform.

Using the hysteresis option

The hysteresis option can prevent small amounts of noise in a waveform from
producing multiple threshold crossings.

The reference voltage level ± the hysteresis value defines a voltage range that
must be fully crossed by the waveform for an edge event to occur. If the decision
threshold is crossed more than once before the waveform exits the hysteresis
band, the mean value of the first and last crossing are used as the edge event time.

For example, if the waveform rises through the Threshold - Hysteresis, then rises
through the Threshold, then falls through the Threshold, then rises through both
the Threshold and the Threshold + Hysteresis, a single edge event occurs at the
mean value of the two rising crossings.
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Example of hysteresis on a noisy waveform
 

 

Manually adjusting the reference voltage levels

Table 25: Ref levels configuration

Item Description
Absolute Reference levels are input as absolute voltages.
Percentage Reference levels are set as a percentage of the source

waveform.
20% - 80% Set the low threshold level to 20%, the mid threshold level to

50%, and the high threshold level to 80%.
10% - 90% Set the low threshold level to 10%, the mid threshold level to

50%, and the high threshold level to 90%.
Advanced View Set the Rise and Fall reference levels independently.
Ref Levels Setup (one level per source) 1

Rise High Set the high threshold level for the rising edge of the source. The
Rise High can be set from 1 to 99% or –40 kV to 40 kV.
Default setting - 90% and 1V

Rise Mid Set the middle threshold level for the rising edge of the source.
The Rise Mid can be set from 1 to 99% or –40 kV to 40 kV.
Default setting - 50% and 0V

Rise Low Set the low threshold level for the rising edge of the source. The
Rise Low can be set from 1 to 99% or –40 kV to 40 kV.
Default setting - 10% and -1V

1 Default settings are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).
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Item Description
Fall High Set the high threshold level for the falling edge of the source. The

Fall High can be set from 1 to 99% or –40 kV to 40 kV.
Default setting - 90% and 1V

Fall Mid Set the middle threshold level for the falling edge of the source.
The Fall Mid can be set from 1 to 99% or –40 kV to 40 kV
absolute value.
Default setting - 50% and 0V

Fall Low Set the low threshold level for the falling edge of the source. The
Fall Low can be set from 1 to 99% or –40 kV to 40 kV.
Default setting - 10% and 0V

Hysteresis Set the threshold margin to the reference level which the voltage
must cross to be recognized as changing; the margin is the
relative reference level plus or minus half the hysteresis; use to
filter out spurious events. The Hysteresis can be set from 0 to
50% or 0 V to 10 V.
Default setting - 3% and 0V

Base top method ■ Auto - Automatically determines suitable Base and Top
values in most cases. This method initially uses the
Histogram Mode method, but if the high or low histogram
appears unstable, the method reverts to MinMax.

■ MinMax - Uses the minimum and maximum values in the
waveform to determine the base and top amplitude. Useful
on a waveform with low noise and free from excessive
overshoot.

■ Histogram Mean- Creates one amplitude histogram for the
lower half of the waveform and another for the upper half,
and determines the Base and Top values as the mean
values of the respective histograms.

■ Histogram Mode- Creates one amplitude histogram for the
lower half of the waveform and another for the upper half,
and determines the Base and Top values as the mode
(most populous bin) of the respective histograms. Less
sensitive to overshoot and noise.

■ Histogram Eye Center - Uses a histogram approach to
determine the base top amplitude. Creates a histogram of
the amplitudes in the center of each bit (unit interval) while
ignoring the waveform during bit transitions. The histogram
should have a peak at the nominal high level and another
peak at the nominal low level.

Close Closes the window.

See also. Source configuration
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Base top method. The Base top method in the Ref Level Setup display allows you
to select a method for calculating Top and Base of the waveform. 

There are five methods used to calculate the Base and Top of the waveform. You
define which you will use using the Base top method drop-down box.

Table 26: Base top method configuration

Item Description
Auto Automatically determines suitable Base and Top values in most cases.

This method initially uses the Histogram Mode method, but if the high or
low histogram appears unstable, the method reverts to MinMax.

MinMax Uses the minimum and maximum values in the waveform to determine
the base and top amplitude. Useful on a waveform with low noise and
free from excessive overshoot.

Histogram Mean Creates one amplitude histogram for the lower half of the waveform and
another for the upper half, and determines the Base and Top values as
the mean values of the respective histograms.

Histogram Mode Creates one amplitude histogram for the lower half of the waveform and
another for the upper half, and determines the Base and Top values as
the mode (most populous bin) of the respective histograms. Less
sensitive to overshoot and noise.

Histogram Eye Center Uses a histogram approach to determine the base top amplitude. Creates
a histogram of the amplitudes in the center of each bit (unit interval) while
ignoring the waveform during bit transitions. The histogram should have a
peak at the nominal high level and another peak at the nominal low level.

MinMax. The figure shows a typical data waveform with a vertical histogram
turned on. If base-top method MinMax is selected, the voltages indicated by the
red lines is used for the base and top since these are the absolute min and max
points in the entire waveform. If there isn't too much overshoot in a waveform
this is a good base top method.
 

 

Histogram Eye Center. If base-top method Histogram Eye Center is selected, the
waveform is assumed to be a serial data signal and TekScope Anywhere performs
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clock recovery on the waveform. Then, the point at the center of each unit
interval is taken. These samples are sorted into low bits and high bits. One
histogram is formed on the low samples, and another on the high samples. The
Base and Top are the modes of these histograms.

Preferences setup
The application provides a Preferences dialog box for setting options that apply
to the entire measurement system. These options remain unchanged until you
reset them. The dialog box can be accessed by clicking the options button on the
measurement library title bar and choosing the Measurement Preferences button.

Figure 50: Preferences setup

TIP. You can also access preferences setup by right-clicking and selecting
Measurement Preferences in the measurement table. Right-click is enabled when
measurements are listed in the table.
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Table 27: Preferences options

Item Description
Display Units Selects the display units for time measurements, between

seconds or Unit Intervals.
Default setting - Seconds

Dual Dirac Model Determines which parameter-extraction method is used when
RJ-DJ separation is done under the Dual-Dirac model. This
affects results for the RJ–δδ and DJ–δδ measurements only.
When Fibre Channel is selected, RJ and DJ parameters are
extracted according to guidelines given in ANSI/INCITS
Technical Report TR-35-2004 “Methodologies for Jitter and
Signal Quality Specification”. RJ and DJ values are selected that
cause an exact match between the bathtub curves from the dual-
dirac and the full analytical models at two prescribed BER levels.
When PCI/FB-DIMM is selected, RJ and DJ parameters are
determined using the methodology defined in the PCI Express
Gen 2 and Fully-Buffered DIMM specifications. In this technique,
the bathtub curves are plotted on a Q-scale that linearises the
tails of the bathtub, and the RJ and DJ values are derived from
where the asymptotes to the curves intersect the BER=0 line.
Default setting - PCI/FB-DIMM

Jitter Separation Model Selects the type of jitter separation, Spectral Only or Spectral +
BUJ. Spectral Only identifies almost all categories of jitter,
including Bounded Uncorrelated Jitter (BUJ) that is periodic (PJ).
However, it cannot separate bounded random jitter from
Gaussian random jitter. Spectral+ BUJ includes additional
processing to identify bounded random jitter (also called Non-
Periodic Jitter or NPJ). NPJ is typically caused by crosstalk from
a signal on a different clock domain, and generally requires a
higher population of measurements for proper detection.
Default setting - Spectral Only

Minimum # of UI for BUJ
Analysis

Determines the number of unit intervals (UI) that must be
processed before jitter separation is performed. This item is only
used for Spectral + BUJ processing, and is not shown if the Jitter
Separation Model is Spectral Only. A higher number of UI will
allow the separation algorithm to detect lower levels of NPJ, but
will typically require longer record length, more acquisitions, or
both. A lower number of UI will allow processing to occur on
smaller populations of UI, but may only identify stronger forms of
NPJ. Also, note that the number of UI processed for BUJ
analysis is only 17% to 33% of the total UI acquired in each
waveform. The BUJ analysis can be set from 10k to 9M.
Default setting - 1M

Close Closes the window.
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Measurement configuration

General The General configure tab is available for every measurement type. It provides an
input box for customizing the measurement name. For dual source measurement
(i.e. setup, hold, skew)

Measurement Range Limits is set to ON and controls are provided for setting the
measurement qualification range

Figure 51: General config

Table 28: General configure options

Item Description
Custom Measurement
Name

Use this text box to customize the measurement name.
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Global Configure Gating - Global. The Global configuration tab contains a toggle button
for setting the Gating mode. Gating allows you to put the focus of the analysis on
a specific area of the waveform bounded by a gated region, which is a way to
filter unnecessary information. Screen and Between Cursors allows you to focus
the measurement on a specific area of the waveform.

Figure 52: Configure Gating - Global

Table 29: Configure Gating - Global

Item Description
Gating ■ Off (Full Record) - No gating occurs; application takes

measurements over the entire waveform.
■ Screen - When zoom is on, the region of the source waveform

where measurements are taken is limited to the zoom area.
■ Between Cursors - Gates the waveform with Vertical cursors. The

region of the waveform between the cursors is analyzed.

Default setting - Off (Full Record)
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Filters About filters. The Filters tab allows you to modify the measurement data by
applying a high pass filter to block low frequency band components or a low pass
filter to block high frequency band components. For example, selecting a 1 MHz
high pass filter can reduce the effect of SSC on results.

For measurements that support filter configuration, the measurements versus time
waveform (time trend) that is derived from the original oscilloscope waveform
can be filtered before the statistics and plotting of the waveform.

Band pass filtering. You can create a band pass filter by enabling both high pass
and low pass filters. The cut-off frequency for the low pass filter must be greater
than or equal to the cut-off frequency for the high pass filter.

NOTE. Setting the cut-off frequencies close to each other may effectively filter out
all of the measurement data, or all but a small amount of timing noise.

This diagram shows the spectrum of the measurement data passed to the statistics
and plotting subsystems when you use both the high pass and the low pass filters.

High pass filters attenuate low frequencies, and filter out DC values entirely.
When a high pass filter is added to a period or frequency measurement, the mean
value of the filtered measurement goes to zero. This can be seen by creating a
Time Trend plot of a high-pass-filtered period or frequency measurement.
Although this is the correct theoretical behavior for the filtered measurement, it is
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not very useful if the results panel reports that the mean period or frequency is
zero. For this reason, the mean values that appear in the results panels for Period
and Frequency measurements are the values before the filter.

The following configuration panel shows the filter configuration of supported
measurements except AC Common mode.

Figure 53: Filter config measurement

Table 30: Filter config options

Item Description
High Pass (F1) Filter
Spec

When enabled, only passes high-frequency waveform but reduces the
amplitude of signals with frequencies lower than the cutoff frequency.

■ No Filter

■ 1st Order

■ 2nd Order

■ 3rd Order

Default setting - No Filter
Freq (F1)  1 High Pass filter cut-off frequency at which the filter magnitude falls by

3 dB. The High Pass filter can be set from 10 Hz to 1 THz.
Default setting - 1 kHz

Low Pass (F2) Filter
Spec

When enabled, only passes low-frequency waveform but reduces the
amplitude of signals with frequencies higher than the cutoff frequency.

■ No Filter

■ 1st Order

■ 2nd Order

■ 3rd Order

Default setting - No Filter
Freq (F2)2 Low Pass filter cut-off frequency at which the filter magnitude falls by

3 dB. The Low Pass filter can be set from 10 Hz to 1 THz.
Default setting - 1 kHz

Advanced Displays the Advanced filter configuration dialog box.
Apply to All Settings are applied to all the selected measurements with filter

configuration.

1 Includes a 3 dB cut-off frequency.
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The following configuration panel shows the filter configuration for the AC
Common Mode measurement. When the High Pass Frequency is On, it is set to
30 KHz. It is Off by default.
 

 

Table 31: AC common mode filter options

Item Description
High Pass Frequency
Off / On A toggle switch that controls the High Pass Frequency for this AC

Common Mode measurement
The default value is Off.

See also. Configurations available per measurement
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Advanced filter configuration. The measurement filters are implemented using
infinite impulse response (IIR) designs. As with any causal filter, a transient may
occur at the filter’s output in response to the arrival of the input signal. It is
usually desirable to exclude this transient from the measurement results.
 

 

In the TekScope Anywhere application, the filter transient is managed in two
ways. First, the input to the filter is gently “ramped up” from zero to its full value
over some duration tr (Ramp Time). Second, the output of the ramp is “blanked”
over some duration tb (Blanking Time), so that the remaining effects of any
transient are omitted from measurement results, statistics and plots. The sequence
of operations is depicted here:
 

 

The ramp function has a raised-cosine profile and is defined in the time domain
as:
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You can adjust the ramp time tr using the Advanced control panel. To turn off the
ramp function, set the ramp time to 0.

Similarly, you can adjust the blanking duration tb using the Advanced control
panel. Setting the blanking duration to 0 will allow you to see the entire filtered
measurement, including any transients.

Both, the ramp time tr and the blanking time tb, are set relative to the reciprocal of
the lowest filter frequency Fc. By default, ramp time is set to 2/Fc and blanking
time is 4/F. Since they are normalized to the filter frequency, they will
automatically adjust if you change the filter cut-off frequency.

The complete set of signal processing options, together with representative
waveforms that suggest how the options affect the measurement vector, are
shown here:
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Table 32: Advanced filter configuration options

Item Description
Filter Frequency Filter frequency is an input box with a value range from 10 Hz to

1 THz.
Default setting - 9.95 MHz

Ramp Time Ramp time is an input box with a value from 0 to 10.
Default setting - 2 

Blanking Time Blanking time is an input box with a value range from 0 to 10.
Default setting - 4 
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Bit config Bit config for eye height measurements. For Height measurements the Bit Cong
tab provides a toggle button for configuring the Bit Type. The Bit type can be set
so analysis is limited to either the transition bits, the non-transitions bit, or both.
 

 

Table 33: Bit config for eye height

Item Description
Bit Type ■ All Bits - Eye analysis includes both transition and non-transition

bits.
■ Transition - Eye analysis only on transition bits.
■ Non-Transition - Eye analysis only on non-transition bits.

Default setting - All Bits
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Bit config for bit amplitude, bit high and bit low measurements. In addition to the
Bit Type toggle button, these measurement have controls for configuring the
percent of unit interval where the measurement is taken, and the method to use
for the measurement.

 

 

Table 34: Bit config for bit amplitude, bit high and bit low measurements

Item Description
Bit Type ■ All Bits - Eye analysis includes both transition and non-transition

bits.
■ Transition - Eye analysis only on transition bits.
■ Non-Transition - Eye analysis only on non-transition bits.

Default setting - All Bits
Measure the Center X
% of the Bit

Determines what percentage (1 to 100) of a unit interval, centered in the
middle of the bit, shall be included in each measurement. The waveform
points selected by the percentage form a distribution (vertical histogram)
from which a single value is extracted, based on the method control. The
Unit Interval can be set from 1 to 100%.
Default setting - 1%

Method Determines whether the Mean value or the Median of the selected
distribution is used for the measurement value for each unit interval.
Default setting - Mean
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Bit config for eye high/low and Q-Factor measurements. In addition to the Bit
Type, these measurements also provide an input box for configuring the percent
of unit interval where the measurement is taken.
 

 

Table 35: Bit config for eye high/low and Q-Factor

Item Description
Bit Type ■ All Bits - Eye analysis includes both transition and non-transition

bits.
■ Transition - Eye analysis only on transition bits.
■ Non-Transition - Eye analysis only on non-transition bits.

Default setting - All Bits
Measure at X% of the
Unit Interval

Sets the X% where the measurement is taken. The Unit Interval can be
set from 1 to 100%.
Default setting - 1%
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Bit config for Height@BER measurement. In addition to the Bit Types this
measurement also provides controls for configuring the measurement range.
 

 

Table 36: Bit Config for Height@BER

Item Description
Bit Type ■ All Bits - Eye analysis includes both transition and non-transition

bits.
■ Transition - Eye analysis only on transition bits.
■ Non-Transition - Eye analysis only on non-transition bits.

Default setting - All Bits
Measurement Range
(UI%) ■ Start - Defines the starting point of the analysis.

■ End - Defines the ending point of the analysis.
■ # of Bins - Defines the number of bits to be considered within the

specified interval.

Default setting - 50%, 50%, 1 
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Clock recovery About clock recovery. Clock recovery refers to the process of establishing a
reference clock, the edges of which can be used as a basis for timing
comparisons. The Clock Recovery configuration tab allows you to select clock
recovery methods. The default is Constant Clock - Mean.

Other clock recovery attributes become available depending on the type of
Method selected, so the controls for each method will be discuss in its own
section.

Phase locked loop (PLL) - Standard BandWidth (BW)

PLL - Custom BandWidth

Constant Clock - Mean

Constant Clock - Median

Constant Clock - Fixed

Explicit Clock - Edge

Explicit Clock - PLL

The first five methods derive the reference clock from the same channel upon
which the measurement is defined. This is the conventional method of clock
recovery for serial data communications, where no separate clock is available.

In PPL clock recovery the application simulates the behavior of the hardware
PPL clock recovery circuit. With constant clock the clock is assumed to follow a
stand formula.

The last two methods (Explicit Clock) derive the reference clock from a channel
other than the one upon which the measurement is defined.
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Constant clock recovery. In Constant clock recovery, the clock is assumed to be
of the form A*sin (2Π ft +Φ), where the frequency (f) and phase (Φ) are treated
as unknown constants. Once a source waveform has been acquired and the edges
extracted, one or both of these constants are determined using linear regression,
so that the recovered clock minimizes the mean squared sum of the Time Interval
Error (TIE) for that waveform. 

If Constant Clock - Mean is selected as the clock recovery method, both the
frequency and the phase are chosen to minimize the mean squared error.

If Constant Clock - Median is selected as the clock recovery method, the phase
is chosen so that the median error between the recovered and measured edges is
zero.

If Constant Clock - Fixed is selected as the clock recovery method, no attempt
is made to derive information about the actual data rate from the signal under
test. Instead, the precise frequency that you specify will be used. However, the
clock phase is chosen so that the median error between the recovered and
measured edges is zero.

Measurements  

146  TekScope Anywhere™ Help



Constant clock - Mean. This method applies the clock recovery mean option to the
measurement.
 

 

Table 37: Constant clock - Mean options

Item Description
Apply to All - Apply Applies the current clock recovery configuration to all selected

measurement(s).
Advanced Displays the Clock Recovery Advanced Setup. For more details,

refer to the Clock recovery advanced setup.

Constant clock - Median. This method applies the clock recovery median option to
the measurement.
 

 

Table 38: Constant clock - Median options

Item Description
Apply to All - Apply Applies the current clock recovery configuration to all selected

measurement(s).
Advanced Displays the Clock Recovery Advanced Setup. For more details,

refer to the Clock recovery advanced setup.
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Constant clock - Fixed. This method provides a single option that controls how the
clock recovery is performed. With Fixed constant clock recovery, no attempt is
made to derive information about the actual data rate from the signal under test.
Instead, the frequency that you specify will be used. (However, the clock phase
will be chosen so that the median difference between the recovered and measured
edges is zero.)
 

 

Table 39: Constant clock - Fixed options

Item Description
Clock Frequency This exact clock frequency will be used. The clock phase will be

determined by best-fit.
Default setting - 2.5 GHz

Apply to All - Apply Applies the current clock recovery configuration to all selected
measurement(s).

Explicit clock recovery. When Explicit Clock Recovery is used, the reference
clock is not derived from the measurement’s target source at all. Instead, the
reference clock is taken from a separately-identified source.

Since the source used for the measurement now differs from the source used to
derive the reference clock, selecting this type of clock recovery converts the
measurement from a single-source measurement to a dual-source measurement.

The reference clock source is always shown on the right when the two sources
appear in a measurement table. Changing the clock-recovery method back to a
non-explicit clock method will change the measurement back to a single-source
measurement. 

Measurements  

148  TekScope Anywhere™ Help



Explicit clock - Edge. Select the Explicit Clock-Edge method to use the edges
found in the selected clock source (possibly multiplied up by an integral number).
If the Clock Multiplier is set to 1 (the default), only these edges will be used. If
the Clock Multiplier is set to a number N other than 1, linear interpolation will be
used between each pair of actual edges to create N-1 additional reference edges.
The interpolated edge times, combined with the actual edges, give a total of N
reference edge times per actual edge.
 

 

Table 40: Explicit clock - edge options

Item Description
Clock Source Select Ch1 to Ch4, Ref1 to Ref4, or Math1 to Math4 as reference source

for clock recovery.
Chart Type Specify whether the rising, falling or both edges of selected source

should be considered.
Default setting - Both

Clock Multiplier Specify the number of edges to be used.
Default setting - 1 

Apply to All - Apply Applies the current clock recovery configuration to all selected
measurement(s), PLL-Standard clock recovery options that have Clock
Recovery as configuration tab.

Advanced Displays the Advanced explicit clock-Edge dialog wherein you can adjust
the timing relation between reference clock source and data source.
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Explicit clock - Edge advanced setup. To compare the reference clock times to the
edge times from the data source, some assumptions must be made about how they
align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be
optimum, for example if the probes for the reference clock and data signal have
different cable lengths.

When the mode is Auto the clock data skew is calculated and shifts the reference
clock edges before the application associates each data edge with the closest
clock edge.

To change the way the reference clock edges and data edges are associated, set
the mode to Manual so Nominal Clock Offset Relative to Data can be configured.

 

 

Table 41: Advanced explicit clock - edge options

Item Description
Nominal clock offset relative to data
Auto / Manual A toggle button for setting the calculation of the clock offset.
Nominal Clock Offset
Relative to Data

When Auto is selected, automatically calculates the clock data skew and
shifts the reference clock edges before the application associates each
data edge with the closest clock edge.
When Manual is selected, specify a time delay (positive or negative) to
shift the reference clock edge before the application associates each data
edge with the closet data edge.

See also. Effect of nominal clock offset on eye diagrams
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Explicit clock - PLL. Select Explicit Clock-PLL as the clock recovery method to
feed the edges from the selected clock source through a PLL rather than using
them directly. The actual edges from the clock source will be used to drive a
software PLL model, and the edge times coming out of the PLL will be used as
the reference edges for the target measurement. If the Clock Multiplier is set to a
number N other than 1, the output of the PLL will have N edges per actual edge.
 

 

Table 42: Explicit clock - PLL options

Item Description
Clock Source Select the source for the selected measurement. The list displays the

waveform sources.
Default setting - Selected waveform source

Chart Type Specify whether the rising, falling or both edges of selected source
should be considered.
Default setting - Both

Clock Multiplier Specify the number of edges to be used.
Default setting - 1 

Apply to All - Apply Applies the current clock recovery configuration to all selected
measurement(s).

Advanced Displays the Advanced explicit clock-Edge dialog where you can adjust
the timing relation between reference clock source and data source.
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Advanced explicit clock - PLL. The Explicit Clock- PLL advanced dialog box
allows you to configure the PLL model, bandwidth, damping factor and nominal
clock offset relative to data. Damping numeric input is enabled only for Type II
phase-locked loop.

The PLL Model list can be set to either a Type I or Type II loop. A Type I loop
has a transfer function that approaches zero frequency with a slope of 1/s .AType
IIloop approaches zero frequency with a1/ s 2 slope. (In much of the PLL
literature, these terms are used interchangeably with First-Order and Second-
Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

When the PPL Model is Type II, a toggle button allows selection between
directly controlling the Loop BW (low-pass function) or the JTF BW (high-pass
function).

Nominal clock offset relative to data. To compare the reference clock times to the
edge times from the data source, some assumptions must be made about how they
align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be
optimum, for example if the probes for the reference clock and data signal have
different cable lengths. 

When the mode is Auto the clock data skew is calculated and shifts the reference
clock edges before the application associates each data edge with the closest
clock edge.

To change the way the reference clock edges and data edges are associated, you
can control the Nominal clock offset relative to data.
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Table 43: Advanced Explicit-Clock PLL options

Item Description
PLL Settings for Explicit Clock
PLL Model Selects between Type I or Type II phase-locked loop.
Damping Use the keypad to specify the damping ratio of the PLL. It is enabled only

for Type II phase-locked loop.
Default setting - 700m

Loop BW / JTF BW A toggle button for selecting the bandwidth function. Allows you to
configure the corresponding bandwidth value.

Loop BW Sets the Loop bandwidth of the clock recovery PLL. Select the Loop BW
radio button to set the value for Type II PLL model.
When Loop BW is selected, an input box is provided for setting the value.
Otherwise the current value is displayed in a readout.
Default setting - 1 MHz

JTF BW When JTF BW is selected an input box allows you to set the value,
otherwise the current value is displayed in a readout.
Default setting - 483.895 kHz

Auto / Manual A toggle button for setting the calculation of the clock offset.
Nominal Clock Offset
Relative to Data

When Auto is selected, automatically calculates the clock data skew and
shifts the reference clock edges before the application associates each
data edge with the closest clock edge.
When Manual is selected, specify a time delay (positive or negative) to
shift the reference clock edge before the application associates each data
edge with the closet data edge.

Related Topics. Effect of nominal clock offset on eye diagrams

Effect of nominal clock offset on eye diagrams. Nominal Clock Offset does not
affect the eye diagrams directly. Data and clock timing relationship is maintained
ignoring the clock offset value. The clock offset still affects the eye diagram
shape indirectly through edge labeling and TIE measurement but not with
alignment.

When Explicit Clock Recovery is used, the Nominal Clock Offset does not affect
eye diagram alignment. The relative alignment between data and clock is
maintained as acquired. To ensure proper alignment between data and clock it is
important to properly deskew oscilloscope channels.
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About PLL clock recovery setup. When Phase Locked Loop (PLL) based clock
recovery is selected, the application simulates the behavior of the hardware PLL
clock recovery circuit. This is a feedback loop in which the Voltage-Controlled
Oscillator (VCO) is used to track or follow slow variations in the bit rate of the
input waveform. Such loops are frequently used to recover the clock in
communication links that do not transmit the clock as a separate signal. The PLL
parameters in the application may be adjusted to simulate with the behavior of a
receiver in such a link, within certain guidelines.

NOTE. The effective transfer function of a PLL loop is not equal to the PLL Loop
BW setting. The transfer function depends on the factors such as damping,
transition density and type.

NOTE. PLL response is not instantaneous. This causes some signals to have a
ramped trend at the beginning of a waveform as the PLL locks to the applied
signal. To avoid a PLL start-up transient, part of the output is blanked out. This
is applicable only when you select PLL Custom BW, PLL Standard BW or
Explicit Clock-PLL as the clock recovery method. PLL blanking is used by
measurements such as TIE, RJ, RJ-δδ, DJ, DJ-δδ, PJ, TJ@BER, High Voltage,
Low Voltage, High-Low, T n/t Ratio, Eye Width, Eye Height, Width@BER,
Height@BER, Rise Time and Fall Time.
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PLL standard BW. To set the loop bandwidth automatically, based on a serial
standard, select PLL - Standard BW as the clock recovery method. From the
Standard list, select the standard that matches the data link. For example, choose
"PCI-E: 2.5" to test a 2.5 Gbit/second PCI Express link. In this case, the PLL
bandwidth will be set to 1.5 MHz, which is 1/1667 of the baud rate as specified in
PCI Express standard.

The PLL Model can be set to either a Type I and Type II loop. A Type I loop has
a transfer function that approaches zero frequency with a slope of 1/s.A Type II
loop approaches zero frequency with a 1/ s2 slope (In much of the PLL literature,
these terms are used interchangeably with First-Order and Second-Order loops.
For a thorough discussion of loop type versus order, see Frequency Synthesis by
Phase Lock, by William Egan).

When the loop bandwidth and the loop order are specified, if a Type II PLL
model is chosen, the damping factor can also be configured.

NOTE. Although it is possible to configure a Type II PLL with a bandwidth up to
1/10 of the baud rate, such a loop will have poor dynamic performance. This is
because Type II loops have less phase margin than Type I loops. A preferred
alternative to using a Type II PLL with a bandwidth close to its baud rate is to
use a second order high-pass measurement filter to emulate the effects of the
PLL.

Table 44: PLL-Standard clock recovery options

Item Description
PLL Model Selects between a Type I or Type II phase-locked loop.

Default setting - Type I
Damping An input box for specifying the damping ratio of the PLL. It is enabled

only for Type II phase-locked loop.
Default setting - 700 m
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Item Description
Standard Implicitly sets the loop bandwidth of the clock recovery PLL, based on

selection of the industry standard and data rate in bits/second.
100BaseT: 125M
1394b S400b: 491.5M, 1394b S800b: 983.0M, 1394b S1600b: 1.966G
FBD1: 3.2G, FBD2: 4.0G, FBD3: 4.8G
FC133: 132.8M, FC266: 265.6M, FC531: 531.2M, FC1063: 1.063G,
FC2125:2.125G, FC4250:4.25G, FC8500:8.5G
GB Ethernet: 1.25G
IBA2500: 2.5G, IBA_GEN2: 5.0G
OC1: 51.8M, OC3:155M, OC12:622M, OC48:2.488G
PCI-E: 2.5G, PCI_E_GEN2: 5.0G, PCI_E_GEN3 : 8.0G
RIO125: 1.25G, RIO250: 2.5G, RIO3125: 3.125G
SAS15: 1.5G (no SSC), SAS3: 3.0G (no SSC), SAS6: 6.0G (no SSC),
SAS12: 12.0G (no SSC)
SAS15: 1.5G (SSC), SAS3: 3.0G (SSC), SAS6: 6.0G (SSC), SAS12:
12.0G (SSC)
SerATAG1: 1.5G, SerATAG2:3.0, SerATAG3:6.0G
USB 3.0: 5.0G
XAUI: 3.125G, XAUI_GEN2: 6.25G
Default setting - PCI-E: 2.5G

Loop BW Displays the Closed Loop bandwidth that has been configured based on
the current standard.

NOTE. When Type II is selected for PLL Model, displays the Jitter
Transfer Function bandwidth (JTF BW) that has been configured based
on the current standard.

Apply to All - Apply Applies the current clock recovery configuration to all selected
measurements that have user-configurable clock recovery.

Advanced Displays the Clock Recovery Advanced Setup. For more details, refer to
the Clock recovery advanced setup.

Related Topics. About PLL loop BW versus JTF BW
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PLL - Custom BW. The PLL configuration area provides control over the phase-
locked loop used for clock recovery. Choose the loop bandwidth and the loop
order, and if a Type II loop is chosen, the damping factor can also be configured.

You can use the PLL Model list box to choose between a Type I and Type II
loop. A Type I loop has a transfer function that approaches zero frequency with a
slope of 1/s and a Type II loop approaches zero frequency with a 1s2 slope. (In
much of the PLL literature, these terms are used interchangeably with First-Order
and Second-Order loops. For a thorough discussion of loop type versus order, see
Frequency Synthesis by Phase Lock, by William Egan).

The PLL Model list can be set to either a Type I and Type II loop. A Type I loop
has a transfer function that approaches zero frequency with a slope of 1/s . A
Type II loop approaches zero frequency with a 1/s2 slope. (In much of the PLL
literature, these terms are used interchangeably with First-Order and Second-
Order loops. For a thorough discussion of loop type versus order, see

When the PPL Model is Type II, a toggle button is provided to allow section
between \directly controlling the Loop BW (low-pass function) or the JTF BW
(high-pass function).

NOTE. Although it is possible to configure a Type II PLL with a bandwidth up to
1/10 of the baud rate, such a loop will have poor dynamic performance. This is
because Type II loops have less phase margin than Type I loops. A preferred
alternative to using a Type II PLL with a high bandwidth is to use a 2 order high-
pass measurement filter to emulate the effects of the PLL.

 

 

Table 45: PLL-Custom clock recovery options

Item Description
PLL Model Selects between Type I or Type II phase-locked loop.
Damping Use the keypad to specify the damping ratio of the PLL. It is enabled only

for Type II phase-locked loop.
Loop BW / JTF BW A toggle button for selecting the bandwidth function. Allows configuration

of the corresponding bandwidth value.
Loop BW When Loop BW is selected an input box is provided for setting the value,

otherwise the current value is displayed in a readout.
Default setting - 1 MHz
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Item Description
JTF BW When JTF BW is selected an input box is provided for setting thevalue,

otherwise the current value is displayed in a readout.
Default setting - 483.895 KHz

Apply to All - Apply Applies the current clock recovery configuration to all selected
measurement(s), PLL-Standard clock recovery options that have Clock
Recovery as configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more details, refer to
the Clock recovery advanced setup.

See also. About PLL loop BW versus JTF BW

PLL loop BW versus JTF BW. Phase locked loops are characterized according to
their bandwidth (BW), and several different bandwidths are commonly used. The
terminology used for these bandwidths is described here, since it varies
somewhat across different industries.

■ Loop BW (or Closed Loop BW) is the frequency at which the closed-loop
gain has fallen to -3 dB (half power) relative to unity-gain. The closed-loop
gain function has the character of a low-pass filter.

■ JTF BW (Jitter Transfer Function BW or Error Function BW) is the
frequency below which input jitter to a tracking loop is removed. The JTF
BW has a high-pass filter characteristic.

For Type I loops, the Loop BW and the JTF BW are always equal so only Loop
BW is configurable. For Type II loops, these two bandwidths are different, and
their ratio depends on the PLL damping factor. When either bandwidth is
specified, a readout of the other is displayed for reference.
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Clock recovery advanced setup. The Advanced clock recovery methods can be
used when unusually high noise or ambiguous data patterns defeats normal clock
recovery methods. Under most normal operating conditions, these methods are
not required nor recommended.

Nominal Data Rate and Known Data Pattern are the two advanced clock recovery
methods.

In Nominal Data Rate, the nominal data rate is provided to the clock recovery
algorithm. Normally, the application analyzes the data and determines the data
rate automatically. Setting this parameter to Manual allows configuration of a
starting point or hint to the clock recovery algorithm. This is useful when the data
pattern makes data rate detection ambiguous. For example, a
1 1 0 0 1 1 0 0 pattern at 8 Gb/s would otherwise be detected as a 1 0 1 0 pattern
at 4 Gb/s. Setting the bit rate to 8 Gb/s will cause the proper unit interval and
pattern length to be identified.

When Known Data Pattern is on, the pattern is specified by using an ASCII text
file containing the characters 1 and 0. The file may contain other characters,
spaces and tabs for formatting purposes, but they will be ignored. Several files
for commonly used patterns are included with the application. These files can be
use these as examples for creating custom pattern files. Click Browse to modify
the default location for pattern files.

NOTE. The last line of the pattern file must end with a CR/LF. Without the CR/LF,
a "too many bits" error message is reported.
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Table 46: Advanced clock recovery options

Item Description
Nominal Data Rate ■ Auto - Enables automatic detection of the data rate on the

acquisition.
■ Manual - Allows you to manually specify the nominal data

rate. This is useful when the data pattern makes data rate
detection ambiguous. As an example, a “1 1 0 0 1 1 0 0”
pattern at 8 Gb/s would otherwise be detected as a “1 0 1 0”
pattern at 4 Gb/s.

Default setting - Auto
Bit Rate An input box for configuring the approximate data rate in bits per

second (b/s) in Manual mode, otherwise a readout displays the
detected data rate.
Default setting - 2.5 Gb/s

Know Data Pattern ■ Off - Disables advanced clock recovery through a known
data pattern.

■ On - Enables advanced clock recovery through a known
data pattern.

Default setting - Off
Data Pattern Selects a file to use for the data pattern.
Close Closes the menu.
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Edges Configure edges for measurements. This configuration tab allows you to select
which waveform edge or clock edge the application will use to take each
measurement. Depending on the particular measurement, the tab will offer access
to other options and constraints that help guide the analysis. The application is
able to automatically detect whether a signal type is Auto, Clock or Data.

The following configuration options apply to most measurements. See the
subsequent sections for Edge tabs corresponding to specific measurements.
 

 

Item Description
Signal Type ■ Clock - Forces the signal type to be interpreted as a Clock.

Measurements will take place on the edges specified by the Clock
Edge control.

■ Data - Forces the signal to be interpreted as a Data. Both rising and
falling edges are used.

■ Auto - Allows the application to automatically detect whether the
signal is clock or data. If the signal is a clock, the Clock Edge control
will determine which edges are used; otherwise the Clock Edge
control will have no effect.

Default setting - Auto
Clock Edge ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting - Rise
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DCD configuration. For the DCD measurement, only Signal type can be
configured. 
 

 

Item Description
Signal type ■ Clock - Forces the signal type to be interpreted as a Clock.

Measurements will take place on the edges specified by the Clock
Edge control.

■ Data - Forces the signal to be interpreted as a Data. Both rising and
falling edges are used.

■ Auto - Allows the application to automatically detect whether the
signal is clock or data. If the signal is a clock, the Clock Edge control
will determine which edges are used; otherwise the Clock Edge
control will have no effect.

Default setting - Auto
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Configure edges for fall slew rate. When the measurement is Fall Slew Rate, the
slew rate technique can be set to either the nominal method or the DDR method.
 

 

Item Description
From Level ■ High - Uses the source configuration high reference voltage level for

the Fall slew rate.
■ Mid - Uses the source configuration mid reference voltage level for

the Fall slew rate.

Default setting - High
To Level ■ Mid - Uses the source configuration mid reference voltage level for

the Fall slew rate.
■ Low - Uses the source configuration low reference voltage level for

the Fall slew rate.

Default setting - Low
Slew Rate Technique ■ Nominal Method - Defines the slew rate. When Nominal Method is

selected From Level can't be Low and To Level can't be High.
■ DDR Method - Determines the slew rate between high to low

reference level. If the actual signal is earlier than the nominal slew
rate line, then the slew rate is calculated using the tangent to the
sample.

Default setting - Nominal Method

See also. High mid and low reference voltage levels
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Rise slew rate configuration. When the measurement is Rise Slew Rate, the slew
rate technique can be set to either the nominal method or the DDR method.
 

 

Item Description
From Level ■ High - Uses the source configuration high reference voltage level for

the Rise slew rate.
■ Mid - Uses the source configuration mid reference voltage level for

the Rise slew rate.

Default setting - High
To Level ■ Mid - Uses the source configuration mid reference voltage level for

the Rise slew rate.
■ Low - Uses the source configuration low reference voltage level for

the Rise slew rate.

Default setting - Low
Slew Rate Technique ■ Nominal Method - Defines the slew rate. When Nominal Method is

selected "From Level" can't be Low and "To Level" can't be High.
■ DDR Method - Determines the slew rate between high to low

reference level. If the actual signal is earlier than the nominal slew
rate line, then the slew rate is calculated using the tangent to the
sample.

Default setting - Nominal Method

See also. High mid and low reference voltage levels
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F/N configuration. When the measurement type is F/N configuration options
include signal type and clock edge as well as substrate divisior.
 

 

Item Description
Signal type ■ Clock - Forces the signal type to be interpreted as a Clock.

Measurements will take place on the edges specified by the Clock
Edge control.

■ Data - Forces the signal to be interpreted as a Data. Both rising and
falling edges are used.

■ Auto - Allows the application to automatically detect whether the
signal is clock or data. If the signal is a clock, the Clock Edge control
will determine which edges are used; otherwise the Clock Edge
control will have no effect.

Default setting: Auto
Clock edge ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting: Rise
Substrate Divisor (N =) Substrate divisor is a drop-down with values 2, 4, 6, 8. Default value is 2 

Default setting: 2 
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Setup & Hold configuration. For the Setup and Hold measurements there is a clock
source and a data source. Both edges can be configured.
 

 

Item Description
Clock Edge (Source 1) ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting - Rise
Date Edge (Source 2) ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting - Both
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CC-Period and + Duty cycle and - Duty cycle configuration. These three
measurements are only defined for clock signals, and each measurement value is
evaluated over one full clock cycle. The clock edge is configurable.
 

 

Item Description
Clock Edge ■ Rise - Measurements are only initiated on the Rising edges of the

clock signal.
■ Fall - Measurements are only initiated on the Falling edges of the

clock signal.
■ Both - Measurements are initiated on both the Rising and falling

edges of the clock signal.

Default setting - Rise
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N-Period configuration. For N-Period measurements, not only are signal type and
clock edge configurable, but N and Edge Increment can be modified as well. N
specifies the number of cycles or unit intervals in each N-period group. Edge
increment specifies the temporal displacement in edges between consecutive
measurements.
 

 

Item Description
Signal Type ■ Clock - Forces the signal type to be interpreted as a Clock.

Measurements will take place on the edges specified by the Clock
Edge control.

■ Data - Forces the signal to be interpreted as a Data. Both rising and
falling edges are used.

■ Auto - Allows the application to automatically detect whether the
signal is clock or data. If the signal is a clock, the Clock Edge control
will determine which edges are used; otherwise the Clock Edge
control will have no effect.

Default setting: Auto
Clock Edge ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting: Rise

N= An input box with an input range of 1 to 1 M.
Default setting: 6 

Edge Increment An input box with an input range of 1 to 10 K.
Default setting: 1 
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Cycle overshoot and cycle undershoot configuration. Cycle overshoot and cycle
undershoot measurements provide configuration of the Ref Voltage level. The
algorithm calculates the maximum peak amplitude above/below the specified
edge configuration Reference level voltage.

An Overshoot event is defined by a rising crossing followed by a falling crossing
of the reference level. Undershoot is defined by a falling crossing followed by a
rising crossing of the reference level.

The difference between the peak amplitude and the reference level voltage is
shown in the measurement results, expressed as a positive value in all cases. The
results are stored zero for the cycles which do not have Overshoot / Undershoot.
 

 

 Measurements

TekScope Anywhere™ Help 169



Skew configuration. When the measurement type is Skew, both the from edge and
to edge can be configured. The to edge is configured relative to the from edge
setting.
 

 

Item Description
From Edge ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting - Both
To Edge ■ Same as From - Each measurement is defined by a pair of like

edges (Rise to Rise or Fall to Fall).
■ Opposite as From - Each measurement is defined by a pair of

opposing edges (Rise to Fall or Fall to Rise).

Default setting - Same as From
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Time outside level configuration. This configuration tab is displayed for the Time
Outside Level measurement:
 

 

Item Description
Level ■ High - Time Outside Level measurement is computed only in

overshoot using High Ref Level.
■ Low - Time Outside Level measurement is computed only in

undershoot using Low Ref Level.
■ Both - Time Outside Level measurement is computed in both

overshoot and undershoot using High and Low Ref Levels.

Default setting - High
High Ref Voltage Displays or allows you to define the high reference voltage level.

Default setting - 0V

See also. High mid and low reference voltage levels
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Configure edges for VDiff-Xovr. When the measurement is V-Diff-Xover, the main
edge is configurable.
 

 

Item Description
Main Edge ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting - Rise

See also. High mid and low reference voltage levels
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Phase noise configuration. The Phase Noise measurement is undefined for data
signals, so the signal is assumed to be a clock. The active edge and noise
integration limits are configurable.

The Noise Integration Limits settings determine the portion of the phase noise
spectrum that is integrated to produce a single measurement per waveform.
 

 

Item Description
Active Edge ■ Rise - Uses only the rising edges of the signal.

■ Fall - Uses only the falling edges of the signal.
■ Both - Uses both the rising and falling edges of the signal.

Default setting - Rise
Noise Integration Limits
Upper Frequency Sets the upper end of the noise integration frequency range. The upper

frequency can be set from 0 Hz to 1 THz.
Default setting - 1 MHz

Lower Frequency Sets the lower end of the noise integration frequency range. The lower
frequency can be set from 0 Hz to 1 THz.
Default setting - 0 Hz
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RJDJ About RJDJ. The RJDJ configuration tab allows you to select an appropriate
decomposition method for jitter analysis. RJ-DJ decomposition analysis divides
the timing jitter into various categories and uses the results to predict the total
jitter at a selected bit error rate (BER).

TekScope Anywhere performs two methods of RJDJ analysis: 

■ A method based on spectral analysis that is appropriate for cyclically
repeating data patterns.

■ A method that works for arbitrary data sequences.

This configuration tab allows you to select the decomposition method based on
the data pattern. By default, the decomposition method is selected automatically
based on the detected bit pattern. This is the recommended configuration.
 

 

NOTE. Target BER configuration is available only for TJ@BER, Width@BER
and Height@BER measurements.

Table 47: RJDJ analysis of repeating options

Item Description
Pattern Detection/
Control ■ Auto [Preferred] - Causes the data pattern to be detected

automatically on the waveform. Based on this detection, the Pattern
Type and associated controls are then configured optimally for the
given record length.

■ Manual - Allows (and requires) that the Pattern Type and associated
controls be set manually.

Default setting:Auto
Pattern Type ■ Repeating - If the data signal is repeating pattern of N bits, then

Repeating pattern type should be selected.  1

■ Arbitrary - If the data signal is non-repeating pattern, or is unknown
then Arbitrary pattern type should be selected.

Default setting: Auto

1 A minimum of 50 repeats of the pattern must be present.
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Item Description
Pattern Length When Pattern Detection is Auto, this field shows the detected pattern

length. When Pattern Detection is Manual and the Pattern Type is
Repeating, this control must be set to match the actual pattern length. If
the manually-set pattern length is inconsistent with the detected pattern
length, processing will continue but a warning will be logged.
Default setting: 2 UI

Window Length (Only present when the Pattern Type is Arbitrary. Determines the number
of unit intervals over which pattern correlation effects are analyzed. The
window should be set to a large enough value that the impulse response
of the serial data transmitter and channel have settled.
Default setting: 10 UI

Jitter Target BER
BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the statistical level at

which Total Jitter, Total Noise and Eye Opening are reported. The BER
values can be set from 2 to18 in whole numbers.
Default setting: 12 

Apply To All Applies all settings on this configuration tab to all other measurements
that have an RJ-DJ.

Related Topics.
RJ-DJ analysis of repeating patterns

RJ-DJ analysis of arbitrary pattern

RJ-DJ analysis of repeating patterns. This method of RJ-DJ analysis uses a
Fourier transform of the time-interval error signal to identify and separate jitter
components. It is described in the Fibre Channel - Methodologies for Jitter and
Signal Quality Specification (MJSQ) and has wide industry acceptance.

This method requires that the data signal be composed of a pattern of N bits that
are repeated over and over. A minimum of 50 repeats of the pattern must be
present.

When Manual configuration is selected, pattern length (N) must be specified,
although it is not necessary to know the specific bits that make up the pattern.

When using the default Auto configuration, this method will be selected if
possible and configured based on the detected bit pattern.
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RJ-DJ analysis of arbitrary pattern. When the data pattern is not repeating, or is
unknown, then an arbitrary pattern of RJ-DJ analysis may be used. (It may also
be used if the pattern is repeating and correlates well with the Spectral method.)
This method assumes that the Inter Symbol Interference (ISI) from a given edge
affects only a relatively small number of subsequent bits. For example, in a band-
limited link where a string of ones follows a string of zeros, the signal may
require three or four bit periods to fully settle to the high state.

In this method, an analysis window with a width of K+1 bits is slid along the
waveform. For each position of the window, the time interval error of the
rightmost bit in the window is stored, along with the K-bit pattern that preceded
it. After the window has been slid across all positions, it is possible to calculate
the component of the jitter that is correlated with each observed K-bit pattern, by
averaging together all the observed errors associated with that specific pattern.

In the configuration menu for the arbitrary-pattern method, the Window Length
field allows you to select how many bits are included in the sliding window. The
window should include enough bits to allow the impulse response of the system
under test to settle, usually 5 to 10 bits. The disadvantage of increasing the
window length is that it uses more memory and requires additional processing
time and greater measurement population to form an answer.

The arbitrary pattern approach for measuring jitter may not be appropriate if there
are very-long-duration memory effects in the data link. An example would be if
there are impedance mismatch reflections that arrive long enough after the initial
edge to fall outside the analysis window.
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Bit error rate (BER) This configuration tab is displayed only for Height@BER measurements. The
BER configuration numeric input box has a range from 2 to 18. The default value
is 12.
 

 

Spread spectrum clocking
(SSC)

This configuration tab allows you to configure the nominal frequency of the
Spread Spectrum Clocking (SSC). The SSC configuration tab is displayed for
SSC Freq, SSC Freq Dev Min and, SSC Freq Dev Max measurements.
 

 

Table 48: Spread spectrum clock

Item Description
Nominal frequency ■ Auto - When Auto is selected, Nominal frequency is a readout of the

calculated value. By default, Nominal frequency is set to Auto.
■ Manual - When Manual is selected, Nominal frequency is an input

box that ranges from 0Hz to 50GHz. The default value is 2.5GHz.
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Configuration parameters
for measurements

Table 49: Amplitude measurements

UI Name Edges Bit Config Clock
Recovery

RJDJ Filters General Global

Amplitude
Max
Min
High
Low
DC
Common
Mode
AC
Common
Mode
Cycle
Overshoot
Cycle
Undershoo
t
Peak to
Peak
RMS
AC RMS
Cycle RMS
+
Overshoot
–
Overshoot
Mean
Cycle
Mean
Cycle Min
Cycle Max
V-Diff-Xovr
Cycle Pk-
Pk
T/nT Ratio
Bit High
Bit Low
Bit
Amplitude
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Table 50: Time measurements

UI Name Edges Bit Config Clock
Recovery

RJDJ Filters General Global

Period
Frequency
Rise Time
Fall Time
Rise Slew
Rate
Fall Slew
Rate
High Time
Low Time
+ Width
– Width
Setup
Hold
Skew
N-Period
+ Duty
Cycle
– Duty
Cycle
CC-Period
+ CC –
Duty Cycle
– CC Duty
Cycle
SSC
Profile
SSC Freq
Dev
SSC Freq
Dev Min
SSC Freq
Dev Max
SSC Mod
Rate
Time
Outside
Level
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Table 51: Jitter measurements

UI Name Edges Bit Config Clock
Recovery

RJDJ Filters General Global

TIE
RJ
RJ-dd
Phase
Noise
TJ@BER
DJ
DJ-dd
PJ
DDJ
DCD
J2
J9
SRJ
F/N
Phase
Noise

Table 52: Eye measurements

Measure
ments

Edges Bit
Config

Clock
Recover
y

BER RJDJ Filters General Global

Width
Width@B
ER
Height
Height@
BER
Eye High
Eye Low
Q-Factor
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View statistical results
The application displays measurements results in tabular format on the Results
tab of the Measurement Library.

Results begin calculating as soon measurements are created. Whenever a
measurement configuration is changed, the new results are updated immediately.

If there are measurement errors icons are displayed in the table adjacent to
measurement name. Selecting the icon will give the details of the error. The
values displayed in the table are rounded-off decimal values. In order to see the
full calculated value hover the mouse pointer over the value.

When something causes a measurement to be recalculated a Measurement Update
Indicator (circle icon) is displayed on the right side of the measurement column.
To see the last updated time of the result hover over the icon. To clear one or all
of the indicators, right-click the icon. The context menu has the clearing options.

The measurement update indicator (circle icon in the measurement column) is
displayed for a measurement, when the result is updated after changing the
configuration. To see the last time the result was updated, let your mouse pointer
move over the icon.
 

 

Table 53: Results table headers

Item Description
Meas Displays the measurement number.
Measure Displays the measurement name.
Source(s) Displays the source for the measurement.
Mean Displays the statistical mean value for the measurement data.
Std Dev Displays the statistical standard deviation value for the measurement

data.
Max Displays the statistical maximum value for the measurement data.
Min Displays the statistical minimum value for the measurement data.
p-p Displays the statistical peak-to-peak value for the measurement data.
Population Displays the total number of measurement data points used for displaying

the statistics.
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TIP. You can drag and drop row and column headers to change the order of the
measurements or the order of the columns.

Save results The statistical results of the measurements can be saved. To save results, select
the options icon from the Measurement Library title bar. In the Options context
menu select Save Results

Figure 54: Save results

TIP. You can also access save results by right-clicking and selecting Save Results
in the measurement table. The context menu is available only when at least one
measurement has been created.

Table 54: Save results options

Field name Configuration
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
The default save location is:
C:/Users/UserName/Tektronix/TekScope Anywhere/UserData
The drop-down lists 20 recently used locations

File Name The name of the file can be entered directly, selected from a
drop-down list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS (In 24 Hour
format). It is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on each successful save.

Count Numeric input that appears only when Auto Increment is on.
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Field name Configuration
Save as Type Measurement CSV Files (.csv) - readout
Format ■ Scientific format (e.g. 5. 100e-12)

■ Engineering format (e.g. 5.1ps)
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Plots

Plot usage
TekScope Anywhere allows you to create plots on measurements. The Plots tab
of the Measurement Library provides buttons for creating the types of plots that
apply to the selected measurement.

Once a plot has been created it can be configured by either selecting the
configure button in the plots title bar, or by right-clicking on the plot itself and
selecting the Configure Plot button from the context menu.

This section provides a description of the following plots:

■ Histogram plot

■ Time Trend plot

■ Spectrum plot

■ Eye Diagram plot

■ Bathtub plot

Histogram The Histogram plot displays the results such that the horizontal axis represents
the measurement values and the vertical axis represents the number of times that
each value occurred. Unlike most other plots, a histogram plot can accumulate
measurements over multiple acquisitions, up to a total of 2.1 billion values.

Histograms are particularly useful in analyzing jitter. A histogram of the Time
Interval Error (TIE) represents the basis of jitter analysis using a histogram
approach. In a histogram, Deterministic Jitter (DJ) is bounded so that the
horizontal span of the plot will remain relatively constant. Random Jitter (RJ) is
unbounded and amplitude (horizontal span) will continue to grow as more
population is acquired. The TIE histogram provides a good way to quickly and
informally assess jitter.

See Histogram plot configuration on page 188
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Time trend The Time Trend plot is a waveform trace of a measurement versus time. Each
measurement value is placed precisely at the time at which the measurement took
place. Measurements that involve two timing points are placed at the midpoint
between those two time. For example, a Risetime measurement is placed halfway
between the low threshold crossing and the high threshold crossing.

The Time Trend plot is useful, for example, in determining if the embedded clock
in a serial bit stream is modulated outside the capabilities of your receiver to
recover the clock. If the TIE time trend plot starts to take an unexpected periodic
shape, then this could indicate that you have uncorrelated periodic jitter from
crosstalk or from power supply coupling.

See Time trend plot configuration on page 189

Spectrum The Spectrum plot is obtained from the Fourier Transform of measurement data
from a Time Trend. This plot is useful in identifying periodic frequency
components that contribute to timing errors, such as phase modulation.

When the signal has a repetitive data pattern, an analysis of the TIE Spectrum of
the signal can be used to separate Random Jitter (RJ) from Deterministic Jitter
(DJ) as well as to separate subcomponents such as Periodic Jitter (PJ), ISI and
DCD. Spectral components (spikes ) that do not correlate with the frequencies
contained in the data pattern can be a clue that external deterministic noise
sources are coupling into a system.

See Spectrum plot configuration on page 190

Eye diagram An eye diagram is a plot of the voltage versus time for a serial bit stream, with
the time axis “wrapped” so that all unit intervals are superimposed on top of each
other in a time-aligned fashion. Because the resulting plot has many waveforms
overlaid, color grading is used to separate areas with many coincident waveforms
from areas that are only rarely crossed.

If there is an area free of waveforms in the center of the diagram, the eye is said
to be “open”, and a comparator circuit repetitively sampling the waveform at this
point in the unit interval could unambiguously separate the two logic states. For
experienced signal integrity engineers, the eye diagram allows many common
problems to be recognized instantly.

See Eye diagram plot configuration on page 191
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Bathtub The Bathtub curve is the industry standard way of viewing the statistical Jitter
Eye Opening. A Bathtub curve represents eye opening as a function of the BER
(Bit Error Ratio). Most serial standards call for Total Jitter to be measured at a
BER of 10-12. The eye opening represented by the Bathtub Curve is what is left
of the unit interval after the total jitter measurement is subtracted.

The Jitter Eye opening and the Total Jitter have the following relationship:

Total Jitter + Jitter Eye Opening = 1 Unit Interval

The Bathtub Curve plot shows the eye opening and total jitter values as functions
of the BER level. The plot is obtained from jitter analysis that performs RJ/DJ
separation.
 

 

See Bathtub plot configuration on page 192
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Configuring plots

Histogram plot
configuration

To configure a Histogram plot, click Plot Configure Options in the title bar of
the histogram plot view. You can also right-click the plot view and select
Configure Plot. 

Attributes of both the horizontal and vertical scales can be configured. The
vertical axis can be displayed in either linear (default) or logarithmic scale.

For horizontal scale can be configured manually, or automatically based on the
accumulated data points. When Auto Scale is on the horizontal center and total
horizontal range of the histogram are displayed as readouts. When Auto Scale is
off these values are configurable.

If subsequently acquired data falls outside the current horizontal scale, histogram
bins are consolidated so that the number of bins is preserved and the horizontal
scale allows all data to be plotted.

Figure 55: Histogram plot configuration
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Table 55: Histogram plot configuration

Configuration Description
Vertical Scale ■ Linear - Selects linear scaling for the vertical axis

■ Log - Selects Logarithmic scaling for the vertical axis

Default setting: Linear
Auto Scale Causes the horizontal scale of the histogram to be adjusted

automatically based on the accumulated data points. If
subsequently acquired data falls outside the current horizontal
scale, histogram bins are consolidated so that the number of bins
is preserved and the horizontal scale allows all data to be plotted.
When checked, disables the “Center” and “Span” numerical
inputs.
Default setting: Set

Center Manually set the value for the horizontal center of the Histogram,
for subsequent plot updates. You can set values up to 1 as (atto
second) using your keyboard.
Default setting: 100ns

Span Manually set the value for the total horizontal range of the
Histogram, for subsequent plot updates. You can set values up
to 1 as (atto second) using your keyboard.
Default setting: 4ns

Number of Bins Resolution Drop-down list defining the number of bins into which Span is
divided.
Default setting: 250 

Time trend plot
configuration

Right-click the Trend badge and select Configure for time trend plot
configuration options. Double-clicking the badge also opens the configure
context menu. The time trend plot badge is displayed in GSRB field. 

Figure 56: Time trend plot configuration
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Table 56: Time trend plot configuration

Configuration Description
Trend <n> On/Off toggle switch controlling the display for the Time trend waveform.
Vertical Scale Numeric input field to configure vertical scale with direct entry, the

number pad, or using the up/down arrow buttons.
Label Text entry field for placing a custom name on the Time trend plot.
Position Numeric input field for the vertical position of the waveform.
Set to 0 Button to set the position to 0.

NOTE. If the Time trend plot has measurement calculated in time, then it will be
displayed in Time domain view else it is displayed in a plot view.

Spectrum plot
configuration

To configure a Spectrum plot, click Plot Configure Options in the title bar of
the spectrum plot view. You can also right-click the plot view and select
Configure Plot. 

In addition to the horizontal and vertical scale settings, for a spectrum plot the
Source and Base are also configurable. Source is a drop-down list of the created
measurements that are applicable to a spectrum plot. When the vertical scale is
logarithmic, base configures the lower axis limit (expressed as a
base-10 exponent).

Figure 57: Spectrum plot configuration
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Table 57: Spectrum plot configuration

Item Description
Vertical Scale ■ Log - Selects logarithmic scaling for the vertical axis

■ Linear - Selects linear scaling for the vertical axis

Default setting: Log
Base The Base value can be set from –20 to 15.

Default setting: –15 
Horizontal Scale ■ Log - Selects logarithmic scaling for the horizontal axis

■ Linear - Selects linear scaling for the horizontal axis

Default setting: Linear

Eye diagram plot
configuration

To configure a Eye diagram plot, click Plot Configure Options in the title bar of
the eye diagram plot view. You can also right-click the plot view and select
Configure Plot. 

The Eye Diagram can be given a custom name using the Label input box. In
addition to the custom name being used in the Plot Type column of the plot table,
it is also displayed the plot title bar.

The clock recovery method can also be changed from this context menu. When
the method is changed, additional controls come and go providing the same
control configurations that are described under each individual clock recovery
section.

The Advanced button is also visible for methods that have additional
configuration options. The advanced dialogs are described under the method
sections.
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Figure 58: Eye diagram plot configuration

Item Description
Label Type the customized name for the plot.
Method Select the clock recovery method. The Clock recovery

configuration and Advanced configuration will change based on
the Method selected.

Advanced Displays the dialog box for advanced configurations when
applicable.

Bathtub plot configuration To configure a Bathtub plot, click Plot Configure Options in the title bar of the
bathtub plot view. You can also right-click the plot view and select Configure
Plot. 

When the vertical scale is logarithmic the lower axis limit is also configurable
(expressed as the negative of a base-10 exponent).

Figure 59: Bathtub plot configuration
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Table 58: Bathtub plot configuration

Item Description
Vertical Scale ■ Log - Logarithmic scaling

■ Linear - Linear scaling

Default setting: Log
Lower Axis Limit BER=1E Set the lower axis limit for logarithmic plot (expressed as the

negative of a base-10 exponent).
Default setting: 14 

Saving plot data

Save plot data Click Windows Options in the plot window title bar menu and select Save Plot
Data to save plot data image. You can also right-click the Plot view and select the
Save Plot Data button from the menu.

Figure 60: Save data image context menu
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Table 59: Save data image context menu

Configuration Description
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
Default: C:/Users/UserName/Tektronix/TekScope Anywhere/
UserData

File Name The name of the file can be typed in directly, selected from a
dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS_label (in 24 hour
format), appended with
<PlotName_MeasurementName(SourceName)> (in the previous
image, PlotName is Histogram and MeasurementName is
Amplitude). The time stamp is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on every successful save.

Count Numeric input that appears only when Auto Increment is on.
Save as Type Comma Separated Variables (.csv)
Save Saves the image.

Save plot images You can save plot images in .bmp, .jpg and .png formats. Click Windows Options
in the plot window title bar and select Save Image to save a plot image. 

Figure 61: Save plot image context menu
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Table 60: Save plot image context menu

Configuration Description
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
The default file location is: C:/Users/UserName/Tektronix/
TekScope Anywhere/UserData

File Name The name of the file can be typed in directly, selected from a
dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS_label (in 24 hour
format), appended with
<PlotName_MeasurementName(SourceName)> (in the previous
image, PlotName is Histogram and MeasurementName is
Amplitude). The time stamp is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on every successful save.

Count Numeric input that appears only when Auto Increment is on.
Save as Type ■ PNG

■ JPEG - default
■ BMP

Color Full Color - default
Save Saves the image.
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Plots available for each measurement

Table 61: Amplitude measurements

UI Name Histogram Time Trend Spectrum Eye Diagram Bathtub
Amplitude
Max
Min
High
Low
Bit High
Bit Low
DC Common
Mode
AC Common
Mode
+Overshoot
-Overshoot
Peak to Peak
T/nT Ratio
RMS
AC RMS
Cycle RMS
Cycle
Overshoot
Cycle
Undershoot
Mean
Cycle Mean
Cycle Min
Cycle Max
Bit Amplitude

Table 62: Time measurements

UI Name Histogram Time Trend Spectrum Eye Diagram Bathtub
Period
Frequency
Rise Time
Fall Time
Rise Slew Rate
Fall Slew Rate
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UI Name Histogram Time Trend Spectrum Eye Diagram Bathtub
High Time
Low Time
Plus Width
Minus Width
Setup
Hold
Skew
N-Period
Plus Duty
Cycle
Minus Duty
Cycle
CC-Period
Plus CC Minus
Duty
Minus CC Duty
SSC Profile
SSC Freq Dev
SSC Freq Dev
Min
SSC Freq Dev
Max
SSC Mod Rate
Time Outside
Level

Table 63: Jitter measurements

UI Name Histogram Time Trend Spectrum Eye Diagram Bathtub
TIE
RJ
RJ-dd
Phase Noise
TJ@BER
DJ
DJ-dd
PJ
DDJ
Jitter Summary
DCD
J2
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UI Name Histogram Time Trend Spectrum Eye Diagram Bathtub
J9
SRJ
F/N

Table 64: Eye measurements

UI Name Histogram Time Trend Spectrum Eye Diagram Bathtub
Width
Width@BER
Height
Height@BER
Eye High
Eye Low
Q-Factor
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Save

Save a screen capture
The Screen Capture tab allows you to save an image of the TekScope Anywhere
application as it is displayed on your screen. 

Figure 62: Save a screen capture

Table 65: Screen capture save options

Field name Configuration
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
Default: C:/Users/UserName/Tektronix/TekScope Anywhere/
UserData

File Name The name of the file can be typed in directly, selected from a
dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS (in 24 hour format).
It is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on every successful save.

Count Numeric input that appears only when Auto Increment is on.
Save as Type ■ PNG - default

■ JPEG
■ BMP (24 bit bitmap)

TekScope Anywhere™ Help 199



Field name Configuration
Color Full Color
Save Saves the screen capture.

See also Save the Waveform

Save the Setup

Save a Session

Save the Report

Save a waveform
The Waveform tab saves a waveform file that can be recalled on TekScope
Anywhere. The save applies to the whichever currently display waveform is
selected from the Source dropdown. 

NOTE. Plots are not included in the waveform save.

Figure 63: Save the waveform
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Table 66: Waveform save options

Field name Configuration
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
Default: C:/Users/UserName/Tektronix/TekScope Anywhere/
UserData

File Name The name of the file can be typed in directly, selected from a
dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS (in 24 hour format).
It is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on every successful save.

Count Numeric input that appears only when Auto Increment is on.
Save as Type ■ Tektronix Waveform Data (.wfm) - default

■ Comma Separated Values (.csv)
■ Hierarchical Data Format (.h5)

Source Select the source form the drop-down list.
Save Saves the waveform.

See also Save a screen capture

Save the Setup

Save a Session

Save the Report
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Save the setup
Use the Setup tab to save setup files. The setup file captures all the application
settings and user configured analysis, enabling you to restore the current setup on
the application at a later time. 

Figure 64: Save the setup

Table 67: Setup save options

File name Configuration
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
Default: C:/Users/UserName/Tektronix/TekScope Anywhere/
UserData

File Name The name of the file can be typed in directly, selected from a
dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS (in 24 hour format).
It is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on every successful save.

Count Numeric input that appears only when Auto Increment is on.
Save as Type Tektronix Setup File (.set)
Include All Defined Ref
Waveforms

If Include All Defined Ref Waveforms is checked.

Save Saves the setup.
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See also Save a screen capture

Save the Waveform

Save a Session

Save the Report

Save the report
A Report is document containing specific information organized in a narrative,
graphic, and tabular form. There are several was to customize the way a report is
saved.

Figure 65: Save a report

Table 68: Report save options

Field name Configuration
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
Default: C:/Users/UserName/Tektronix/TekScope Anywhere/
UserData - default

File Name The name of the file can be typed in directly, selected from a
dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS (in 24 hour format).
The time stamp is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on every successful save.

Count Numeric input that appears only when Auto Increment is on.
Append Report When selected the results of this report to a previously saved

report. The File Name changes from the date default to a list of
previously saved reports.

 Save
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Field name Configuration
Save as Type ■ Single File Web Pages (.mht)

■ Adobe Portable Document Format (.pdf) - default

View report after generating Opens the report once generated. By Default selected.
Report Options
Include Images and
Annotations

When selected, the report generated will have theTime domain
view, all the plot views, and annotations. The images are all
saved in full color. By default it is selected.

Include Setup Configuration When selected, the generated report will have the setup
configuration details. By default it is selected.

Include Error-Warnings Log When selected, the report will have errors and warnings listed at
the bottom. By default it is unselected.

Comments A text box which allows additional information to be entered that
will be included into the report.

Save Saves the report.

See also Save a screen capture

Save the Waveform

Save the Setup

Save a Session

Save  

204  TekScope Anywhere™ Help



Save a session
A session is a zipped file (.tss) that includes the screen capture, waveform, and
setup of TekScope Anywhere. 

Figure 66: Save a session

Table 69: Session save options

Field name Configuration
Save Location The file destination can be typed in directly, selected from the

drop-down list of the twenty recently used locations, or by
invoking the file browser by pressing the button on the right.
Default: C:/Users/UserName/Tektronix/TekScope Anywhere/
UserData

File Name The name of the file can be typed in directly, selected from a
dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS (in 24 hour format).
It is the time when save is invoked.

Auto Increment File Name When Auto Increment File Name is selected, the file name is
suffixed with the current Count (filename_count). The count can
be edited, and increments on every successful save.

Count Numeric input that only appears when Auto Increment is on.
Save as Type Tektronix Session Setup (.tss)
Save Save the session.

 Save
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See also Save a screen capture

Save the Waveform

Save the Setup

Save the Report

File name extensions
The following table shows the file extensions used by the TekScope Anywhere
application.

Table 70: File name extensions

File Extension Description
.csv An ascii file containing Comma Separated

Values. This file format may be read by any ascii
text editor (such as Notepad) and may be
imported into spreadsheets such as Excel.

.mht An HTML archive file, compatible with common
Windows applications.

.wfm A binary file containing an oscilloscope
waveform record in a recallable, proprietary
format.

.isf The Tektronix waveform file format for
oscilloscopes

.h5 Tektronix Hierarchical Data Format

.bin Agilent waveform files

.trc Lecroy waveform files

.set Tektronix Setup files

.tss Tektronix Session files. A zipped file containing
measurements, waveforms and settings.

Save  
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Report
A report is a summary document that has details about the measurements,
configurations, results, and the screenshots of the application. You can use these
files to view later or to share with others. Reports can be generated in MHT or
PDF format.

Report format
The report includes a Tektronix logo and the title as Test Report in the header. 

Test Information includes a time stamp showing when the report was generated
and comments.

Instrument Configuration includes configuration details of the application. This
field will be present only if the Include Setup Configuration option was selected
when the report was generated.
 

 

Measurement Result Details

This section has details about all the measurements included in the report and
their statistical results in tabular format.

Views contain a screenshot of Time Domain View display. The report will have
images only if Include Images and Annotations option was selected when the
report was generated.

Plots contain screenshots of all the plots selected for the measurement. The Plot
type - Measurement name (Measurement source) details about the plot is
displayed above the image. The report will have images only if the Include
Images and Annotations option was selected when the report was generated.
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Measurement Configuration Details includes configuration details for the
measurements represented in a table.

Appendix

This section includes the error warnings log and is located at the bottom of the
report. This field will be present only if the Include Error-Warnings Log was
selected when the report was generated.

See also
Save the Report

Report  
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Export a session from an oscilloscope

The session export utility on your Tektronix DPO/MSO5000, DPO7000C, or
DPO/MSO70000C/D/DX Series oscilloscope creates a single file (.tss) with all
necessary information to recreate the setup for analysis using TekScope
Anywhere. Sharing the data acquired on an oscilloscope for offline analysis is
easily supported with the TekScope session export utility and TekScope
Anywhere offline analysis software. When you share data for remote debug
session or for archiving for future use, it is often necessary to save the entire
oscilloscope configuration including measurement configurations and waveform
data. 

Click Analyze > ExportSession to export a session from DPOJET.

Figure 67: Export Session utility enables to save the instrument state from a Tektronix DPO/
MSO5000, DPO7000C, or DPO/MSO70000C/D/DX oscilloscope for use on TekScope
Anywhere
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Field name Configuration
Save in C:\Users\<UserName>\Tektronix\TekScope\Setups - default
Name The name of the file can be typed in directly, selected from a

dropdown list of recently used files or left as the default.
The default file name is YYMMDD_HHMMSS (in 24 hour format).
It is the time when save is invoked.

Save as type Tektronix proprietary instrument state (*.tss)
Auto-increment file name When checked it displays a Count field. The number series starts

at 000. The count does not increment to the next sequential
number until a successful save has occurred. The next
incremented number will be reflected in the count field.

Figure 68: Oscilloscope setup recalled on TekScope Anywhere

Export a session from an oscilloscope  

210  TekScope Anywhere™ Help



See also Opening a session

 Export a session from an oscilloscope
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How to...
See the Help for the Tektronix Serial Data Link Analysis (SDLA) software for
more detailed information on using that application.

How to map the created filter file using SDLA signal input function to the
TekScope Anywhere

Use this option when the filter files in SDLA Visualizer are created using single
input mode in the SDLA application software. In the single input mode, the
signal is viewed at the selected test points. One filter file is created for each test
point, for example Math1 = Filter (REF1). Once the filters have been created in
SDLA Visualizer, they can be saved for use in TekScope Anywhere.

NOTE. SDLA Visualizer is application software that runs on 64-bit 70K Series
Oscilloscopes.

Inputs:

■ Input source

■ One filter file

Set these parameters in the Math settings context menu.

1. Click Main > Open, navigate to C:\Users\Public\Tektronix\TekScope
Anywhere\UserData, select 8GPRBS7_70mV_500K_SSC_Ch1.wfm , and
then click Open.

2. Click Add / Remove Waveforms > Add Math.

3. Select Math Type as Basic, Function as SDLA, and Type as Single Input.
The Type field is displayed after you select SDLA function as the function.

4. Select the Source 1 waveform source from the drop-down list.

5. Browse and select the SDLA filter file.
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How to map the created filter file using SDLA Visualizer dual input function to
the TekScope Anywhere

Use this option when the filter files in SDLA Visualizer are created using dual
input mode. In this mode, SDLA allows you to view the individual inputs,
differential or common mode. Dual input mode takes two waveforms from two
channels and processes them through the 4-port system to obtain test point
waveforms. Below are the test modes available:

■ A: Waveform on the upper line of the test point

■ B: Waveform on the lower line

■ A-B: Differential line

■ (A+B)/2: Common mode waveform

In this mode, SDLA creates 8 filter files as shown in the following image. Use
the appropriate filters based on Dual input Differential, Dual input Single ended,
and Dual Inputs Common.
 

 

 How to...
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Dual input differential - To
look at differential signal

This is used for getting Differential signal (A-B). For example, when you select
Tp1DIFFSrc1.flt and Tp1DIFFSrc2.flt files, the following equation is used.

Math1 = Tp1DIFFSrc1 (REF1) + Tp1DIFFSrc2 (REF2)

Set these parameters in the Math settings context menu.
■ Click Main > Open, navigate to C:\Users\Public\Tektronix\TekScope

Anywhere\UserData, select
8GPRBS7_SSC_70MVPERDIV_200K_Ch1.wfm and
8GPRBS7_SSC_70MVPERDIV_200K_Ch3.wfm file and click Open.

■ Click Add / Remove Waveforms > Add Math.
■ Select Math Type as Basic, Function as SDLA, and Type as Dual Input

Differential. Type field is displayed when you select SDLA function.
■ Select the Source 1 and Source 2 waveform source from the drop-down list.
■ Browse and select the filter file1 (sdlaTpXDIFFSrc1.flt) and filter file

2 (sdlaTpXDIFFSrc2.flt).
 

How to...  
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Dual input single ended -
To look at A leg

This is used for getting A and B results. For example, when you select
Tp1ASrc1.flt and TP1ASrc2.flt files, the following equation is used.

Math1 = Tp1ASrc1(REF1) + TP1ASrc2(REF2)

Set these parameters in the Math settings context menu.

■ Click Main > Open, navigate to C:\Users\Public\Tektronix\TekScope
Anywhere\UserData, select
8GPRBS7_SSC_70MVPERDIV_200K_Ch1.wfm and
8GPRBS7_SSC_70MVPERDIV_200K_Ch3.wfm file and click Open.

■ Click Add / Remove Waveforms > Add Math.

■ Select Math Type as Basic, Function as SDLA, and Type as Dual Input
Single Ended. Type field is displayed when you select SDLA function.

■ Select the Source 1 and Source 2 waveform source from the drop-down list.

■ Browse and select the filter file1 (sdlaTpXASrc1.flt) and filter file
2 (sdlaTpXASrc2.flt).

 

 How to...
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Dual input single ended -
To look at B leg

This is used for getting A and B results. For example, when you select
Tp1BSrc1.flt and TP1BSrc2.flt files, the following equation is used.

Math1 = Tp1BSrc1(REF1) + TP1BSrc2(REF2) 

Set these parameters in the Math settings context menu.

■ Click Main > Open, navigate to C:\Users\Public\Tektronix\TekScope
Anywhere\UserData, select
8GPRBS7_SSC_70MVPERDIV_200K_Ch1.wfm and
8GPRBS7_SSC_70MVPERDIV_200K_Ch3.wfm file and click Open.

■ Click Add / Remove Waveforms > Add Math.

■ Select Math Type as Basic, Function as SDLA, and Type as Dual Input
Single Ended. Type field is displayed when you select SDLA function.

How to...  
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■ Select the Source 1 and Source 2 waveform source from the drop-down list.

■ Browse and select the filter file1 (sdlaTpXBSrc1.flt) and filter file
2 (sdlaTpXBSrc2.flt).

 

 

 How to...
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Dual input common - To
look at common mode

signal

This is used for getting common mode signal ((A+B)/2.0)). For example, when
you select Tp1CMSrc1.flt and Tp1CMSrc2.flt files, the following equation is
used.

Math1 = Tp1CMSrc1 (REF1) + Tp1CMSrc2 (REF2) 

Set these parameters in the Math settings context menu.
■ Click Main > Open, navigate to C:\Users\Public\Tektronix\TekScope

Anywhere\UserData, select
8GPRBS7_SSC_70MVPERDIV_200K_Ch1.wfm and
8GPRBS7_SSC_70MVPERDIV_200K_Ch3.wfm file and click Open.

■ Click Add / Remove Waveforms > Add Math.
■ Select Math Type as Basic, Function as SDLA, and Type as Dual Input

Single Ended. Type field is displayed when you select SDLA function.
■ Select the Source 1 and Source 2 waveform source from the drop-down list.
■ Browse and select the filter file1 (sdlaTpXCMSrc1.flt) and filter file

2 (sdlaTpXCMSrc2.flt).
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How to validate the sample rate of a filter
The filter file contains multiple lines. Comments are preceded by the hash sign
(#). Other lines include sample rate, followed by a semi-colon (;) followed by the
filter coefficiencts that are separated by commas. 

Identify the sample rate of a filter by opening the filter file and read the sample
rate, which precedes the “;” and compare this with the input waveform sample
rate. If the sample rates match, the filter can be used.

Alternately, you can apply the filter using the MATH and if the MATH is
enabled (and it is not blank) then the filter sample rate and waveform sample rate
match.

What if the sample rate of filter does not match the waveform
If the sample rate of the waveform does not match the filter sample rate, then the
MATH waveform will be blank and it will have zero points (you cannot perform
the measurement on this waveform).

How to create a filter using Math equation?
Generally in high speed serial standards, a single-ended waveform is acquired.

1. Click Main > Open, navigate to C:\Users\Public\Tektronix\TekScope
Anywhere\UserData, select:

 How to...
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8GPRBS7_SSC_70MVPERDIV_200K_Ch1.wfm and
8GPRBS7_SSC_70MVPERDIV_200K_Ch3.wfm file and click Open.

2. Create a differential waveform (MATH1).

a. Click Main > Add Math. By default, the basic Math is defined.

Math1 = Ref1 - Ref2

■ Ref1 = 8GPRBS7....wfm

■ Ref2 = 8GPRBS7....wfm
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3. Apply Cable emulator on MATH2.

a. Click Add / Remove Waveforms > Add Math.

b. Select Math Type as Basic, Function as SDLA, and Type as Single Input.
Type field is displayed when you select SDLA function.

c. Select the Source 1 waveform source from the drop-down list.

d. Browse and select the filter file.

 

 

 How to...
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4. Apply Cable equalizer on MATH3.

a. Click Add / Remove Waveforms > Add Math.

b. Select Math Type as Basic, Function as SDLA, and Type as Single Input.
Type field is displayed when you select SDLA function.

c. Select the Source 1 waveform source from the drop-down list.

d. Browse and select the filter file.

 

 

NOTE. The X in sdlaTpXASrc1.flt represent the corresponding test point. For
example, for TP1 replace X with 1.

NOTE. For more details about SDLA, refer to the SDLA application Help.

How to...  
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Reference

Units of measurement
The following table lists the engineering multipliers that the TekScope Anywhere
application uses.

Table 71: Measurement units

Abbreviation Unit Multiplier
y yocto or septillionths 1E-24 
z zepto or sextillionths 1E-21 
a atto or quintillionths 1E-18 
f femto or quadrillionths 1E-15 
p pico or trillionths 1E-12 
n nano or billionths 1E-09 
u micro or millionths 1E-06 
m milli or thousandths 1E-03 

one 1E+00 
k kilo or thousands 1E+03 
M mega or millions 1E+06 
G giga or billions 1E+09 
T tera or trillions 1E+12 
P peta or quadrillions 1E+15 
E exa or quintillions 1E+18 
Z zetta or sextillions 1E+21 
Y yotta or septillions 1E+24 

TekScope Anywhere™ Help 225



Reference  

226  TekScope Anywhere™ Help



Measurement algorithms

About algorithms
The TekScope Anywhere application can take measurements from one or two
waveforms. The number of waveforms used depends on the type of measurement
selected.

Topics in this section describe measurement algorithms as implemented in the
TekScope Anywhere application.

Amplitude measurements

Amplitude The amplitude measurement is calculated by the following formula:

Amplitude = High - Low

Max The Maximum amplitude. It is typically the most positive peak voltage in the
measurement region (either entire waveform or gated region).

Min The Minimum amplitude. It is typically the most negative peak voltage in the
measurement region (either entire waveform or gated region).

High The High Amplitude measurement calculates the mean or mode of a selected
portion of each unit interval corresponding to a “1” bit.

The application calculates this measurement using the following equation:
 

 

Where:

VHI is the high amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of
the unit interval, ranging from 1% to 100%.
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n is the index of a high bit, a high transition bit, or a high non-transition bit.

Low The Low Amplitude measurement calculates the mean or mode of a selected
portion of each unit interval corresponding to a “0” bit.

The application calculates this measurement using the following equation:
 

 

Where:

VLOW is the low amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of
the unit interval, ranging from 1% to 100%.

n is the index of a low bit, a low transition bit, or a low non-transition bit.

DC common mode The Common Mode Voltage measurement (also called DC Common Mode)
calculates the mean of the Common Mode voltage waveform.

The application calculates this measurement using the following equation:
 

 

Where:

VCM is the common mode voltage measurement.

 is the common mode voltage waveform.

i is the sample index of common mode waveform values.

Measurement algorithms  
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AC common mode The AC Common Mode Voltage measurement is the common mode voltage
between two single-ended signals. AC is defined as all the frequency components
above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based
on two single-ended sources from the DUT):

CM_Voltage = (Source1 + Source2) ÷ 2

AC_CMMp-p= Peak-to-Peak(High Pass filter (CM_Voltage))

Where:

AV_CMVp-p is the peak-to-peak common mode voltage.

Positive Overshoot Amplitude (voltage) measurement.
 

 

NOTE. Positive overshoot value should never be negative.

Negative overshoot Amplitude (voltage) measurement.
 

 

NOTE. Negative overshoot value should never be negative (unless High or Low
are set out-of-range).

 Measurement algorithms
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Peak-to-peak Amplitude measurement. The absolute difference between the maximum and
minimum amplitude.

Peak-to-Peak = Max - Min

RMS The Root Mean Square voltage (RMS) measurement is calculated by the
following formula:

If Start = End then RMS = the (interpolated) value at waveform[Start].

Otherwise,
 

 

For details of the integration algorithm, see below.
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Integration algorithm
 

 

 Measurement algorithms

TekScope Anywhere™ Help 231



AC RMS The True root mean square voltage over the measurement region (either entire
waveform or gated region).

Cycle RMS The true Root Mean Square voltage over one cycle.

If StartCycle = EndCycle then CycleRMS = Waveform[Start].

Otherwise,
 

 

For details of the integration algorithm Click here

Cycle overshoot Overshoot is the maximum peak amplitude above the reference voltage level
(VREF). Non-differential signals (Single Ended) are required for this
measurement such as DQS (SE) and CK(SE). For DQS signals, Search and Mark
should be enabled.
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Cycle undershoot Undershoot is the maximum peak amplitude below the reference voltage level
(VREF). Non-differential signals (Single Ended) are required for this
measurement such as DQS(SE) and CK(SE). For DQS signals, Search and Mark
should be enabled.
 

 

Mean Amplitude (voltage) measurement. The mean over one waveform cycle. For non-
cyclical data, you might prefer to use the Mean measurement.

If Start = End then return the (interpolated) value at Start.

Otherwise,
 

 

For details of the integration algorithm Click here

Cycle mean The arithmetic mean for one waveform. Remember that one waveform is not
necessarily equal to one cycle. For cyclical data you may prefer to use the cycle
mean rather than the arithmetic mean.

If Start = End then return the (interpolated) value at Start.

Otherwise,
 

 Measurement algorithms
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For details of the integration algorithm Click here

Cycle min Cycle Min is a voltage measurement which measures negative peak voltage for
all cycles. It is the minimum voltage for each cycle from the mid level of Fall to
the Rise slope.

The application calculates this measurement using the following equation:

VCycleMin= Min(f(FallIndex(i) to RiseIndex(i+1))

Where:

I =1 to the valid edge of the last cycle.

f is the function, which finds the minimum sample point in the defined region.

Cycle max Cycle Max is a voltage measurement which measures positive peak voltage for
all cycles. It is the maximum voltage for each cycle from the mid level of rise to
the fall slope.

The application calculates this measurement using the following equation:

VCycleMax= Max(f(RiseIndex(i) to FallIndex(i+1))

Where:

I =1 to the valid edge of the last cycle.

f is the function, which finds the maximum sample point in the defined region.

V-Diff-Xovr The Differential Crossover Voltage measurement (V–Diff–Xovr) calculates the
voltage level at the crossover voltage of a differential signal pair. If there is
timing jitter on one of the pair of signal lines relative to the other, the crossover
point will be modulated by the jitter. The measurement is calculated using the
following equation:
 

 

Where:

VCrossover is the crossing voltage.

VSource1 is the voltage of the first source waveform.

TCrossover is the crossover time, when the Source1 and Source2 waveforms are
equal in voltage.

Measurement algorithms  
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Cycle Pk-Pk Cycle Pk-Pk is a voltage measurement which measures the absolute difference
between the maximum and minimum amplitude for every cycle of the waveform.
It calculates the peak-to-peak value for all cycles of the waveform. The peak
value is measured from Fall slope to the next rise if the valid slope is a Fall. The
next peak would be from Rise to next fall slope. The peak-to-peak value is
calculated on all the pairs of minimum and maximum values available.

The application calculates the Cycle Pk-Pk using the following equation:

 

 

for consecutive cycles

Where:

VMax(n) is the maximum peak amplitude.

VMin(n) is the minimum peak amplitude.

n is the number of cycles from 1 to the last valid edge.

T-nT ratio The T/nT Ratio measurement reports the amplitude ratio between transition and
non-transition bits.

The measurement calculates the ratios of all non-transition eye voltages (2nd and
subsequent eye voltages after one edge but before the next) to their nearest
preceding transition eye voltage (1st eye voltage succeeding an edge). In the
accompanying diagram, it is the ratio of the Black voltages to the Blue voltages.
The results are given in dB.

 

 

The application calculates the T/nT Ratio using the following equations:

 Measurement algorithms
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following a rising edge.
 

 

following a falling edge.

Where:

vEYE–HI–TRAN is the High voltage at the interpolated midpoint of the first unit
interval following a positive transition.

vEYE–LO–TRAN is the Low voltage at the interpolated midpoint of the first unit
interval following a negative transition.

vEYE–HI–NTRAN is the High voltage at the interpolated midpoint of all unit
intervals except the first following a positive transition.

vEYE–LO–NTRAN is the Low voltage at the interpolated midpoint of all unit
intervals except the first following a negative transition.

m is the index for all non-transition UIs.

n is the index for the nearest transition UI preceding the UI specified by m.

In a time trend plot of the measurement results, there is one measurement for
each non-transition bit in the waveform (that is the black arrows in the diagram).

Measurement algorithms  
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Bit high The High Amplitude measurement calculates the mean or mode of a selected
portion of each unit interval corresponding to a “1” bit.

The application calculates this measurement using the following equation:
 

 

Where:

VHI is the high amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of
the unit interval, ranging from 1% to 100%.

n is the index of a high bit, a high transition bit, or a high non-transition bit.

Bit low The Low Amplitude measurement calculates the mean or mode of a selected
portion of each unit interval corresponding to a “0” bit.

The application calculates this measurement using the following equation:
 

 

Where:

VLOW is the low amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of
the unit interval, ranging from 1% to 100%.

n is the index of a low bit, a low transition bit, or a low non-transition bit.

 Measurement algorithms
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Bit amplitude The High–Low measurement calculates the change in voltage level across a
transition in the waveform.

The application calculates High–Low using the following equation:
 

 

Where:

VHIGH-LOW is the high-low amplitude measurement result.

n is the index of a selected transition.

i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location following the transition.

VLEVEL= OP[vPERCENT(i)] is the state level of the unit interval (bit period).

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of
the unit interval, ranging from 1% to 100%.

NOTE. If there are no waveform samples that fall within the identified percentage
of the unit interval, the single nearest waveform sample preceding the center
point of the unit interval will be used.

Measurement algorithms  
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Timing measurements

Period If the Signal Type is Clock. The Period measurement calculates the duration of a
cycle as defined by a start and a stop edge. Edges are defined by polarity,
threshold, and hysteresis. The application calculates clock period measurement
using the following equation:
 

 

Where:

PClock is the clock period.

T is the VRefMid crossing time for the selected polarity.

If the Signal Type is Data. The Period measurement calculates the duration of a
Unit Interval. The application calculates this measurement using the following
equation:
 

 

Where:

PData is the data period.

TData is the VRefMid crossing time in either direction.

Kn =Cn–Cn-1 is the estimated number of unit intervals between two successive
edges. Cn is the calculated data bit index of Tn

Data.

Each measurement result Pn
Data is repeated Kn times in the measurement result

vector, so that the measurement population is equal to the number of unit
intervals in the qualified waveform, rather than the number of edge pairs.

 Measurement algorithms
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Frequency Frequency measurement calculates the inverse of the data period for each cycle.

If the Signal Type is Clock. The application calculates clock frequency
measurement using the following equation:
 

 

Where:

FClock is the clock frequency.

PClock is the clock period measurement.

If the Signal Type is Data. The application calculates data frequency measurement
using the following equation:
 

 

Where:

FData is the data frequency.

PData is the data period measurement.

Rise time The Rise Time measurement is the time difference between when the VRefHi
reference level is crossed and the VRefLo reference level is crossed on the rising
edge of the waveform. The Rise Time algorithm uses the VRef values as the
reference voltage level. Each edge is defined by the slope, voltage reference level
(threshold), and hysteresis.

The application calculates this measurement using the following equation:
 

 

Where:

T Rise is the Rise Time.

T Hi+ is the VRefHi crossing on the rising edge.

T Lo+ is the VRefLo crossing on the rising edge.
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Fall time The Fall Time measurement is the time difference between when the VRefLo
reference level is crossed and the VRefHi reference level is crossed on the falling
edge of the waveform. The Fall Time algorithm uses the VRef values as the
reference voltage level. Each edge is defined by the slope, voltage reference level
(threshold), and hysteresis.

The application calculates this measurement using the following equation:
 

 

Where:

T Fall is the Fall Time.

T Lo- is the VRefLo crossing on the falling edge.

T Hi- is the VRefHi crossing on the falling edge.

Rise slew rate The Rise Slew Rate is defined as the rate of change of the voltage between the
crossings of the specified VREFHI and VREFLO reference voltage levels. The
voltage difference is measured between the VREFHI reference level crossing and
the VREFLO reference level crossing on the rising edge of the waveform. The time
difference is measured as the difference between the low time, and the low time
at which VREFLO and VREFHI are crossed. The Rise Slew Rate algorithm uses the
high and low rise reference voltage levels to configure the values. Each edge is
defined by the slope, voltage reference level (threshold), and the hysteresis.
 

 

The application calculates this measurement using the following equation:
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See also. High Mid and Low Reference Voltage Levels

Fall slew rate The Fall Slew Rate is defined as the rate of change of the voltage at the specified
VREFLO and VREFHI reference voltage levels. The voltage difference is measured
between the VREFLO reference level crossing and the VREFHI reference level
crossing on the falling edge of the waveform. The time difference is measured as
the difference between the high time and low time at which VREFHI and VREFLO
are crossed. The Fall Slew Rate algorithm uses the low time and high fall
reference voltage levels to configure the values. Each edge is defined by the
slope, voltage reference level (threshold), and the hysteresis.
 

 

The application calculates this measurement using the following equation:
 

 

See also. High Mid and Low Reference Voltage Levels
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High time The High Time Measurement is the amount of time that a waveform cycle is
above the VRefHi voltage reference level.

The application calculates the measurement using the following equation:

 

 

Where:

T High is the high time.

T Hi- is the VRefHi crossing on the falling edge.

T Hi+ is the VRefHi crossing on the rising edge.

Low time The Low Time measurement is the amount of time that a waveform cycle is
below the VRefLo voltage reference level.

The application calculates this measurement using the following equation:

 

 

Where:

T Low is the low time.

T Lo+ is the VRefLo crossing on the rising edge.

T Lo- is the VRefLo crossing on the falling edge.

Positive and negative
width

Amount of time the waveform remains above/below the mid reference voltage
level.

The application calculates these measurements using the following equations:

 

 

Where:

W+ is the positive pulse width.

W— is the negative pulse width.
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T— is the VRefMid crossing on the falling edge.

T+ is the VRefMid crossing on the rising edge.

Setup The Setup Time measurement is the elapsed time between the designated edge of
a data waveform and when the clock waveform crosses its own voltage reference
level. The closest data edge to the clock edge that falls within the range limits is
used.

The application calculates this measurement using the following equation:

 

 

Where:

T Setup is the setup time.

T Main is the Main input (clock) VRefMidMain crossing time in the specified
direction.

T 2nd is the 2nd input (data) VRefMid2nd crossing time in the specified
direction.

NOTE. The order of the input sources for Setup and Hold measurements (Source1
= Clock, Source2 = Data) differs from the order of input sources on the Setup/
Hold Trigger menu in the oscilloscope.

Hold The Hold Time measurement is the elapsed time between when the clock
waveform crosses its own voltage reference level and the designated edge of a
data waveform. The closest data edge to the clock edge that falls within the range
limits is used.

The application calculates this measurement using the following equation:

 

 

Where:

THold is the hold time.

TMain is the Main input (clock) VRefMidMain crossing time in the specified
direction.

T2nd is the 2nd input (data) VRefMid2nd crossing time in the specified direction.
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NOTE. The order of the input sources for Setup and Hold measurements (Source1
= Clock, Source2 = Data) differs from the order of input sources on the Setup/
Hold Trigger menu in the oscilloscope.

Skew The Skew measurement calculates the difference in time between the designated
edge on a principle waveform to the designated edge on another waveform. The
closest data edge to the clock edge that falls within the range limits is used.

The application calculates this measurement using the following equation:
 

 

Where:

T Skew is the timing skew.

T Main is the Main input VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input VRefMid2nd crossing time in the specified direction.

N-Period If the Signal Type is Clock. The N–Period measurement calculates the elapsed time
for N consecutive crossings of the mid reference voltage level in the direction
specified.

The application calculates this measurement using the following equation:
 

 

Where:

NPClock is the accumulated period for N clock cycles.

TClock is the VRefMid crossing time for the selected edge polarity.
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If the Signal Type is Data. The N–Period measurement calculates the elapsed time
for N consecutive unit intervals.

The application calculates this measurement using the following equation:
 

 

Where:

NPData is the duration for N unit intervals.

TData is the VRefMid crossing time in either direction.

If Tn+NData does not exist for a given n, no measurement is recorded for that
position.

Positive and negative duty
cycle

The +Duty Cycle and –Duty Cycle measurements calculate the ratio of the
positive (or negative) portion of the cycle relative to the period.

The application calculates these measurements using the following equations:
 

 

Where:

D+ is the positive duty cycle.

D— is the negative duty cycle.

W+ is the positive pulse width.

W— is the negative pulse width.

PClock is the period.

See also.  
Period

Positive and Negative Width
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CC-Period The CC-Period measurement calculates the difference in period measurements
from one cycle to the next.

The application calculates CC-Period measurement using the following equation:
 

 

Where:

ΔP is the difference between adjacent periods.

PClock is the clock period measurement.

Positive and negative CC
duty

The + CC-Duty and – CC-Duty measurements calculate the difference in positive
(or negative) pulse widths from one cycle to the next.

The application calculates these measurements using the following equations:
 

 

Where:

ΔW+ is the difference between positive pulse widths of adjacent clock cycles.

ΔW- is the difference between negative pulse widths of adjacent clock cycles.

W+ is the positive pulse width measurement.

W- is the negative pulse width measurement.

SSC PROFILE SSC Profile shows the modulation profile of the Spread Spectrum Clocking
(SSC). It is the time trend plot of the SSC profile. All SSC measurements use the
Period measurement with a second order low pass filter. Using the profile you
can analyze the SSC modulation rate by using the horizontal cursors. You can
also analyze the peak-to-peak frequency deviation by using the vertical cursors.

The following are the default configurations that are required:

■ Constant Clock Recovery (CCR) Mean as the Clock Recovery method.

■ Low pass filter with 1.98 MHz set as the cut off frequency set by default.
This is the standard FiberChannel cut off frequency.

■ Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

 Measurement algorithms

TekScope Anywhere™ Help 247



SSC FREQ DEV SSC FREQ DEV is defined as the SSC frequency deviation in ppm (parts per
million). 

■ The low pass filter is turned on by default with 1.98 MHz set as the cut off
frequency. This is the standard FiberChannel cut off frequency.

■ Time Trend, Data Array, Histogram, and Spectrum plots are allowed for this
measurement.

The application calculates the measurement using the equation:

FREQ DEVIATION = HIGH–LOW

See also.  
High

Low

SSC FREQ DEV MIN The SSC FREQ DEV MIN is defined as the minimum frequency shift as a
function of time. It represents the frequency deviation in terms of ppm (parts per
million).

■ Find the 50% edges on the SSC profile.

■ Calculate the LOW value between the n and n+1 edge.

■ Find the Minimum frequency deviation as LOW.

The application calculates the measurement using the equation:

Freq Dev Min(ppm)= ((Minimum Freq–Nominal Data Rate)/Nominal Data
Rate)* 1e6

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

SSC FREQ DEV MAX SSC FREQ DEV MAX is defined as the maximum frequency shift as a function
of time. It represents the frequency deviation in terms of ppm (parts-per-million).

■ Find the 50% edges on the SSC profile

■ Calculate the HIGH value between the n and n+1 edge

■ Find the Maximum frequency deviation as HIGH

The application calculates the measurement using the equation:

Freq Dev Max(ppm)= ((Maximum Freq – Nominal Data Rate)/Nominal Data
Rate)* 1e6

The difference between the SSC FREQ DEV MAX and SSC FREQ DEV MIN
measurements are that they compute the maximum frequency deviation and
minimum frequency deviation separately. By doing this the limits can be applied
separately.

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.
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SSC MOD rate SSC Mod Rate measurement computes the SSC modulating frequency.

The following are the default configurations that are required:

■ Constant Clock Recovery (CCR) Mean set as the Clock Recovery method.

■ Low pass filter with 1.98 MHz cut off frequency set by default. This is the
standard FiberChannel cut off frequency.

■ Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

Time outside level Time Outside Level is defined as the time interval of overshoot or undershoot.
The measurement is taken on both the rising and falling slopes.
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Jitter measurements

TIE TIE (Time Interval Error) is the difference in time between an edge in the source
waveform and the corresponding edge in a reference clock. The reference clock is
usually determined by a clock recovery process performed on the source
waveform. For Explicit-Clock clock recovery, the process is performed on an
explicitly identified source.

If the Signal Type is Clock. The application calculates Clock TIE measurement
using the following equation:
 

 

Where:

TIEClock is the clock time interval error.

TClock is the VRefMid crossing time for the specified clock edge.

T'Clock is the corresponding edge time for the specified reference clock.

If the Signal Type is Data. The application calculates Data TIE measurement using
the following equation:
 

 

Where:

TIEData is the data time interval error.

TData is the VRefMid crossing time in either direction.

T'Data is the corresponding edge time for the specified reference clock.

The subscript k is used to indicate that there is one measurement per Unit
Interval, rather than one measurement per actual edge.
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RJ Random Jitter (RJ) is the rms magnitude of all timing errors not exhibiting
deterministic behavior. A single RJ value is determined for each acquisition by
means of RJ/DJ separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation

Dual dirac random jitter Dual Dirac Random Jitter (RJ–δδ) is the rms magnitude of all timing errors not
exhibiting deterministic behavior, calculated based on a simplifying assumption
that the histogram of all deterministic jitter can modeled as a pair of equal-
magnitude dirac functions (impulses). A single RJ–δδ value is determined for
each acquisition by means of RJ/DJ separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation

Jitter Estimation Using Dual-Dirac Models

Clock NPJ Bounded Uncorrelated Jitter (BUJ) refers to all bounded jitter that is not
correlated to the data pattern on the waveform. Thus, it excludes DDJ, DCD and
RJ. It can be further subdivided into PJ (which is deterministic, and easily
recognized using a spectral approach) and Non-Period Jitter (NPJ).

Depending on the precise nature, NPJ is often difficult to distinguish from RJ. It
typically cannot be isolated using frequency domain techniques, so a different
domain is used. The important difference between RJ and NPJ is that RJ has a
Gaussian distribution (with unbounded tails) whereas NPJ is bounded by
definition. This fact is used as a basis for separation.
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The jitter separation algorithms are modified as follows when the Spectral + BUJ
method is selected:

1. Data-Dependent jitter (DDJ) and Duty-Cycle jitter (DCD) are first removed
using either a spectral approach for repeating patterns or a correlation
approach for arbitrary data patterns.

2. PJ is identified and removed using a spectral approach.

3. The remaining jitter is assumed to contain (Gaussian) RJ and possibly NPJ.
(In the Spectral Only method of jitter analysis, no further processing is done
and this jitter is reported as RJ).

4. When Spectral + BUJ processing is selected, the RJ + NPJ jitter is collected
into a histogram that is typically accumulated over multiple waveform
acquisitions. When the (user-configurable) minimum histogram population
has been acquired, the histogram is converted to an estimate of the
Cumulative Density Function (CDF) and plotted using the Q-scale for the
vertical axis. The Q-scale plot has the property that a true Gaussian
distribution appears as a straight line, with a slope equal to 1/σ (where σ is
the standard deviation of the Gaussian distribution). If the distribution is a
mixture of a true Gaussian plus some bounded distribution, the plotted curve
has left and right extremes that asymptotically approach straight lines with a
slope of 1/σ. The horizontal offset between the two asymptotes represents the
dual-dirac magnitude of the NPJ.

TJ@BER Total Jitter at a specified Bit Error Rate (BER). This extrapolated value predicts a
peak-to-peak jitter that will only be exceeded with a probability equal to the
BER. It is generally not equal to the total jitter actually observed in any given
acquisition. A single TJ@BER value is determined for each acquisition, by
means of RJ/DJ separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation

Estimation of TJBER and Eye WidthBER

DJ Deterministic Jitter (DJ) is the peak-to-peak amplitude for all timing errors that
follow deterministic behavior. A single DJ value is determined for each
acquisition, by means of RJ/DJ separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation
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Dual dirac deterministic
jitter

Dual Dirac Deterministic Jitter (DJ–δδ) the peak-to-peak magnitude for all timing
errors exhibiting deterministic behavior, calculated based on a simplifying
assumption that the histogram of all deterministic jitter can modeled as a pair of
equal magnitude dirac functions (impulses). A single DJ–δδ value is determined
for each acquisition, by means of RJ/DJseparation analysis.

See also.  
Jitter Analysis Through RJDJ Separation

Jitter Estimation Using Dual-Dirac Models

PJ Periodic Jitter (PJ) is the peak-to-peak amplitude for that portion of the
deterministic jitter which is periodic, but for which the period is not correlated
with any data pattern in the waveform. A single PJ value is determined for each
acquisition, by means of RJ/DJ separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation

DDJ Data-Dependent Jitter (DDJ) is the peak-to-peak amplitude for that portion of the
deterministic jitter directly correlated with the data pattern in the waveform. A
single DDJ value is determined for each acquisition, by means of RJ/DJ
separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation

Jitter summary The Jitter Summary is not a single measurement. The Jitter Summary button on
the graphical user interface simply creates one each of all the primary jitter
measurements, as a convenience. 

DCD Duty Cycle Distortion (DCD) is the peak-to-peak amplitude for that portion of
the deterministic jitter directly correlated with signal polarity, that is the
difference between the mean positive edge displacement versus that on negative
edges. A single DCD value is determined for each acquisition, by means of RJ/
DJ separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation
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J2 J2 is Total Jitter at a Bit Error Rate (BER) value of 2.5E-3. This statistical value
predicts a peak-to-peak jitter that will only be exceeded with a probability equal
to the BER.

See also.  
Jitter Analysis Through RJDJ Separation

J9 J9 is Total Jitter at a Bit Error Rate (BER) value of 2.5E-10. This statistical value
predicts a peak-to-peak jitter that will only be exceeded with a probability equal
to the BER.

See also.  
Jitter Analysis Through RJDJ Separation

SRJ Sub-Rate Jitter is periodic jitter at a rate that integrally divides the data rate. For
example, if the data rate is F bits/second, sub-rate jitter components could occur
at F/2 or F/4. It typically occurs when a serial data stream is formed by
multiplexing (interleaving) an integral number of lower-rate bit streams together,
although there can be other causes. Sub-rate jitter is a sub-component of PJ.

The SRJ measurement is the peak-to-peak amplitude for the sum of all F/N jitter
components that are tracked by TekScope Anywhere. Since different F/N
components are correlated with each other, the peak-to-peak SRJ depends on
relative phases and is not simply the sum of the individual F/N components.

The SRJ measurement always tracks and accounts for N = 2, 4 and 8 regardless
of whether the corresponding F/N measurements have been selected.

See also.  
F/N

Jitter Analysis Through RJDJ Separation

F-N Conceptually, F/N jitter is the peak-to-peak amplitude of periodic jitter occurring
at a rate that divides the data rate (F) by the integer N. However, it excludes jitter
occurring at harmonics of F/N. For example, F/4 jitter occurs at one fourth the
data rate (but the measurement excludes jitter attributable to F/2 before
determining the peak-to-peak amplitude).

For a repeating data pattern, some deterministic jitter can be interpreted either as
DDJ or as F/N jitter. This condition occurs when the pattern length, P, is an
integer multiple of N. By convention, such jitter is reported as DDJ, and the
corresponding F/N is reported as zero. For example, a signal with a pattern length
of 10 would report F/2 = 0 since jitter at half the bit rate can be interpreted as
DDJ. But F/4 and F/8 may be non-zero since they cannot be DDJ for this pattern
length.

The measurement uses a divisor (N) of 2 by default but a divisor of 2, 4 or 8 can
be selected.
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For a given N, the value of F/N is computed as follows:

For a data stream of I bits, the mean jitter for each of the phases n ∈{1, 2, … N}
is calculated as:
 

 

The jitter-per-phase is collected into a jitter trend or array:
 

 

From this trend, the trends attributable to higher harmonics are removed (for
example, the T2 and T4 trends are subtracted from the T8 trend):
 

 

The peak-to-peak jitter is then:
 

 

From this trend, the trends attributable to higher harmonics are removed (for
example, the T2 and T4 trends are subtracted from the T8 trend):

For a repeating data pattern with repeat length N, some deterministic jitter falls in
an ambiguous category where it could be interpreted either as DDJ or as F/N
jitter. By convention, such jitter is reported as DDJ, and the corresponding F/N is
reported as zero.

See also.  
SRJ

Jitter Analysis Through RJDJ Separation
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Phase noise The Phase Noise measurement performs a jitter measurement, converts the result
into the frequency domain, and reports the rms jitter integrated between two
specific frequencies selected by the user.

The phase noise measurement is defined only for clock signals. If the source
waveform appears to be a data signal, a warning message will be produced but
the measurement will proceed.

A Phase Noise measurement is required in order to enable the Phase Noise plot.

Eye measurements

Eye width The Eye Width measurement is the measured minimum horizontal eye opening at
the zero reference level.

The application calculates this measurement using the following equation:
 

 

Where:

UIAVG is the average UI.

TIE pk-pk is the Peak-Peak TIE.

Width@BER Width@BER is the Eye Width at a specified Bit Error Rate (BER). This
extrapolated value predicts a horizontal eye opening that will be violated with a
probability equal to the BER. It is generally not equal to the eye width actually
observed in any given acquisition. A single Width@BER value is determined for
each acquisition, by means of RJ/DJ separation analysis.

See also.  
Jitter Analysis Through RJDJ Separation

Estimation of TJ@BER and Eye Width@BER
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Eye height The Eye Height measurement is the measured minimum vertical eye opening at
the UI center as shown in the plot of the eye diagram. There are three types of
Eye Height values.

The application calculates this measurement using the following equation:
 

 

Where:

VEYE-HI-MIN is the minimum of the High voltage at mid UI (Unit interval).

TIEEYE-LO-MAX is the maximum of the Low voltage at mid UI.

Eye Height-Transition. The application calculates this measurement using the
following equation:
 

 

Where:

VEYE-HI-TRAN-MIN is the minimum of the High transition bit eye voltage at
mid UI.

TIEEYE-LO-TRAN-MAX is the maximum of the Low transition bit eye voltage at
mid UI.

Eye Height-Non-Transition. The application calculates this measurement using the
following equation:
 

 

Where:

VEYE-HI-NTRAN-MIN is the minimum of the High non- transition bit eye
voltage at mid UI.

TIEEYE-LO-NTRAN-MAX is the maximum of the Low non-transition bit eye
voltage at mid UI.
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Height@BER Height@BER is the Eye Height at a specified Bit Error Rate (BER). This
extrapolated value predicts a vertical eye opening that will be violated with a
probability equal to the BER. It is generally not equal to the eye height actually
observed in any given acquisition. A single Height@BER value, in the given
interval, is determined for each acquisition by means of Q-scale extrapolation.

Eye high Eye High calculates the voltage at a selected horizontal position across the unit
interval, for all High bits in the waveform. You specify the offset at which the
measurement takes place from 0% to 100% of the unit interval. Configure the
measurement to include all bits, only transition bits, or only non-transition bits.
(Note that some of the waveform can be omitted from the measurement due to
initialization of clock recovery or filtering.) A histogram of the Eye High
measurement corresponds to a vertical slice through the upper half of a three-
dimensional eye diagram.
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Eye low Eye Low calculates the voltage at the selected horizontal position across the unit
interval, for all Low bits in the waveform. A histogram of the Eye Low
measurement corresponds to a vertical slice through the lower half of a three-
dimensional eye diagram.
 

 

Q-factor Quality Factor is the ratio of eye size to noise. Eye and Q factor measurements
can be run together and displayed onto a single window.

The final measurement value would be computed according to the equation
below:

Q-factor = [mean(EyeHigh) - mean(EyeLow)] / [stddev(EyeHigh) +
stddev(EyeLow)]

Where:

Eye High: the sample values of positive UI at x%.

Eye Low: the sample values of negative UI at x%.

For more details refer Eye Height
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Jitter separation

Jitter analysis through RJ-
DJ separation

Many of the jitter measurements are based on the concept of RJ/DJ separation.
The application begins with the measured jitter-versus-time (as represented by
the TIE measurement array) and analytically determines the random and
deterministic components of the jitter. The deterministic part is further separated
into independent subcomponents with specific characteristics.

The random jitter (RJ) is assumed to be zero-mean Gaussian, and is assumed to
have a flat spectrum when viewed in the frequency domain. The measured RJ is
fitted to a Gaussian mathematical model, which is parameterized by its standard
deviation. Using the mathematical model for RJ, statistically probable jitter
extremes may be predicted for much greater populations than actually measured.

The deterministic jitter (DJ) is predictable and can be generated consistently
given known circumstances. The various DJ measurements each report the peak-
to-peak value of the corresponding DJ subcomponent.

Once all the jitter components have been identified and the random jitter has been
converted to a mathematical model, the components can be reassembled such that
performance may be extrapolated to extremely low bit error rates. The
probabilistic Total Jitter (TJ@BER) and probabilistic Eye Width (Width@BER)
are examples of such measurements. The reported values are predictions that
correspond to a user-specified Bit Error Rate, rather than observed values.

Two approaches are supported for performing jitter separation. The first method
is based on spectrum analysis. It is only possible when the data pattern is
repetitive. A clock waveform is always repetitive. Other repetitive testing data
patterns are used, such as the K28.5 data pattern. Patterns may have rather long
repetition lengths; for example, the CJTPAT pattern is 2640 bits. When using this
method, you must specify the pattern length, and you will receive a warning if the
pattern length appears to differ from that specified.

The second RJ/DJ separation method, known as arbitrary pattern analysis, may
be used when the data pattern is not necessarily repetitive. This method works by
correlating deterministic jitter observed over many repetitions with the bit pattern
within a time-domain window surrounding each observation.
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RJ-DJ separation via
spectrum analysis

When the source waveform represents a repeating data pattern, Deterministic
Jitter (DJ) has a frequency spectrum of impulses. The impulses due to the data
pattern are equally spaced and occur at predictable frequencies related to the
pattern length and bit rate. Specifically, the pattern-related jitter impulse must
occur at multiples of fo/N, where fo is the data bit rate and N is the data pattern
length. Other spectral impulses may occur due to periodic jitter not correlated
with the data pattern.

To obtain measurements of DJ and RJ, all the components of the jitter spectrum
that exceed the noise floor by a chosen margin are attributed to deterministic
jitter. Those components that fall at the frequency increment corresponding to the
pattern length are identified as data-dependent jitter, and those occurring at other
frequencies are attributed to uncorrelated periodic jitter. The remaining spectral
noise floor (appropriately normalized to account for the removed deterministic
jitter) is integrated to predict the standard deviation of the underlying Gaussian
random noise process.

Once the spectral components corresponding to each deterministic jitter type
have been identified, each component is inverse-transformed back to the time
domain. From these waveforms, the peak-to-peak jitter for each component is
determined. For the random jitter, the RMS deviation is directly computable from
the standard deviation of the Gaussian model.

RJ-DJ separation for
arbitrary patterns

When the data pattern borne by the source waveform is not cyclically repeating,
any periodic jitter still has a frequency spectrum consisting of impulses but this is
not true of the data-dependent jitter.

In this case, analysis of the data-dependent jitter may proceed based on the
assumption that any given bit is affected by a finite (and relatively small) number
of preceding bits. By averaging all events for which a given bit is preceded by a
particular bit sequence, the data-dependent jitter attributable to that bit sequence
is obtained. This is because PJ and RJ are not correlated to a particular data
sequence and thus are averaged out.

If each bit is assumed to be affected by N preceding bits, there are a total of 2N
possible data sequences. The sequence length N is a configurable parameter. To
get statistically sound average values for the data-dependent jitter, a minimum
population of observations is required for each individual pattern that occurs at
least once. This population limit is also configurable by the user.

By the above means, the data-dependent jitter is characterized. Once
characterized, the data-dependent jitter, on a bit-by-bit basis, may be removed
from the original jitter versus time record. The remaining jitter is composed of
periodic and random jitter. This jitter is transformed into the frequency domain,
and the spectral analysis approach is used to separate the impulsive periodic jitter
from the broad noise floor of random jitter.
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Separation of Non-
Periodic jitter (NPJ)

Bounded Uncorrelated Jitter (BUJ) refers to all bounded jitter that is not
correlated to the data pattern on the waveform. Thus, it excludes DDJ, DCD and
RJ. It can be further subdivided into PJ (which is deterministic, and easily
recognized using a spectral approach) and Non-Period Jitter (NPJ).

Depending on its precise nature, NPJ is often difficult to distinguish from RJ. It
typically cannnot be isolated using frequency domain techniques, so a different
domain is used. The important difference between RJ and NPJ is that RJ has a
Gaussian distribution (with unbounded tails) whereas NPJ is bounded by
definition. This fact is used as a basis for separation.

The jitter separation algorithms are modified as follows when the Spectral + BUJ
method is selected:

1. Data-Dependent Jitter (DDJ) and Duty-Cycle jitter (DCD) are first removed
using either a spectral approach for repeating patterns or a correlation
approach for arbitrary data patterns.

2. PJ is identified and removed using a spectral approach.

3. The remaining jitter is assumed to contain (Gaussian) RJ and possibly NPJ.
(In the Spectral Only method of jitter analysis, no further processing is done
and this jitter is reported as RJ.)

4. When Spectral + BUJ processing is selected, the RJ + NPJ jitter is collected
into a histogram that is typically accumulated over multiple waveform
acquisitions. When the (user-configurable) minimum histogram population
has been acquired, the histogram is converted to an estimate of the
Cumulative Density Function (CDF) and plotted using the Q-scale for the
vertical axis. The Q-scale plot has the property that a true Gaussian
distribution appears as a straight line, with a slope equal to 1/σ (where σ is
the standard deviation of the Gaussian distribution). If the distribution is a
mixture of a true Gaussian plus some bounded distribution, the plotted curve
has left and right extremes that asymptotically approach straight lines with a
slope of 1/σ. The horizontal offset between the two asymptotes represents the
dual-dirac magnitude of the NPJ.

Estimation of TJ@BER
and eye Width@BER

One of the outcomes of the RJ/DJ separation was a mathematical model for
random jitter’s probability density function (PDF) and measured values for the
PDFs of the deterministic jitter components. Since all of these components are
assumed to be statistically independent, the PDF of the total jitter can be
calculated by convolution.

Integration of the PDF yields the cumulative distribution function (CDF), which
can then be used to create the bit error rate curve (bathtub curve). Based on the
bathtub curve, the eye opening (Width@BER) and eye closure (TJ@BER) can be
estimated for a given bit error rate.

The application calculates the eye opening at the specified BER using the
following equation:

Eye opening = 1–TJ@BER when TJ@BER is less than one Unit Interval
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Jitter estimation using
Dual-Dirac models

Jitter estimation based on RJ/DJ separation depends in part on the specific jitter
components modeled. For the purposes of analyzing jitter and identifying root
cause, it is very useful to identify components as specifically as possible. But for
the purposes of determining compliance, it has been found that a simplified jitter
model yields results that are more consistent across different measurement
instruments and different vendors.

A simplified model that has found acceptance in several industry standards is
known as the Dual-Dirac model. This is because the probability density function
(PDF) of all the deterministic jitter is replaced with a PDF consisting of two
Dirac functions such that the total jitter and eye opening at very low bit error
rates is unchanged. The Random Jitter and Deterministic Jitter values derived
from this model are identified as RJ–δδ and DJ–δδ, respectively.

Two slightly different Dual-Dirac models have been defined. Both models begin
with a jitter versus BER (bathtub) curve, either created from a full jitter analysis
based on RJ/DJ separation, or from direct measurement of error rate versus
sample point offset. The two models differ in how the RJ–δδ and DJ–δδ values
are extracted from the curve.

For the Fibre-Channel standard, values for RJ–δδ and DJ–δδ are chosen such that
the Dual-Dirac bathtub curve exactly matches the measured curve at the BER =
10-5 and BER=10-9 points.

For the PCI Express and FB-DIMM standards, the bathtub curve is re-plotted
using a different y-axis. Instead of directly plotting against the log of the BER,
the y-axis is converted to the Q-scale. The BER to Q-scale transformation was
designed such that Gaussian distributions are converted to straight lines, with a
slope that is directly related to the standard deviation of the Gaussian.

When using the Dual-Dirac jitter measurements, it is critical that you select the
model that matches the applicable standard. This may be configured in the
TekScope Anywhere preferences, which are found under MEASUREMENT
LIBRARY - WINDOW OPTIONS > Measurement Preferences from the
measurement library title bar.
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Results
The application calculates them statistics for all selected measurements, and
displays them in the Results menu:

■ Mean

■ Std Dev (Standard Deviation)

■ Max (Maximum Value)

■ Min (Minimum Value)

■ p-p (Peak-to-Peak)

■ Population

■ Max-cc (Maximum positive cycle-to-cycle variation)

■ Min-cc (Maximum negative cycle-to-cycle variation)

Mean The application calculates the mean value using the following equation:
 

 

Standard Deviation The application calculates the standard deviation using the following equation:
 

 

It may seem odd that the equation for the estimate of the Standard Deviation
contains a 1/(N-1) scaling factor. If you knew the true mean of X and used it in
place of the estimated mean X then you would, in fact, scale by 1/N. But, X is an
estimate and is likely to be in error (or bias), causing the estimate of the Standard
Deviation to be too small if scaled by 1/N. This is the reason for the scaling
shown in the equation. (Refer to Chapter 9.2 in A. Papoulis, Probability, Random
Variables, and Stochastic Processes, McGraw Hill, 1991.)

NOTE. RMS value can be calculated using the relation (rms)= (mean value)+
(stddev).
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Maximum Value The application calculates maximum value using the following equation:

Max(X) = Most Positive Value of X

Minimum Value The application calculates minimum value using the following equation:

Min(X) = Most Negative Value of X

p-p The application calculates peak-to-peak using the following equation:

p-p(X) = Max(X )– Min(X)

Population Population is the total number of events or observations over which the other
statistics were calculated.

Population (X) = N

Max-cc The application calculates Max-cc using the following equation:

Max-cc(X) = Max(XCC)

Where:

XCC is the first difference of X.
 

 

Min-cc The application calculates Min-cc using the following equation:

Min-cc(X) = Min(XCC)

Where:

XCC is the first difference of X.
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manual, 174
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Save plot image, 194
SDLA, 85
SDLA use cases
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dual input differential - To look at differential
signal, 216

dual input single ended - To look at A leg, 217
dual input single ended - To look at B leg, 218
how to create a filter using math equation?, 221
how to map the created filter file using SDLA

dual input function to the TekScope
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how to map the created filter file using SDLA
signal input function to the TekScope
Anywhere, 213

how to validate the sample rate of a filter, 221
what if the sample rate of filter does not match the

waveform, 221
Select a measurement, 29
Separation on non-periodic jitter, 262
Setup, 244
Skew, 245
software version number, 50
Source configuration, 125, 126
Spectrum plot configuration, 190
Spectrum plot usage, 186
Spread spectrum clocking (SSC)
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TIE, 250
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Time trend plot usage, 186
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